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~=a T VOANFERHE, T7=hvFR—F, oMo HARERIZONT, KO URL T,
A EFEND [What's New in Cisco Product Documentation] %M1 T ZEW, Y Aad
HHB L OUETIROEf~=a2 7V O—& RmENTWHET,

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
[What's New in Cisco Product Documentation)] 1%, > 22 OFHEL L OUETROEM i ~=27 1D

—EH "L, RSS 7 A —F L ClEmTEET, T, V—HF—T7FVr—rarzfFHL T
VTV ERTAI Ny TICEETAZELTEET, RSS 7 4 —NIFEROY—E X T,
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CHAPTER 1

Cisco ASA D E

JY—Z:204F7A 24 H
EH:201459R816 8

Cisco ASA (X, BERAT— TNV 77 AT U 4—/LE VPN ar & ML —XDHELZ 1 5D
TNAAZEHN LT, ET AL 2 TE, IPS R EDH—E R D 2— L BHAEIN
TWET, ASAITZEOEEREBEZHZ CHET, =& xE, vV F BXx2VT7 0 a7
X2 (B 7 7 AT U —VIZEE), 77 AZ VT (BEO7 7 AT x—VEREL
T1ODT7 7 AT T4 —MIZT5B), hTLAXTL s (LAV2) Z7A4T7 U x—VEIT
IL—F R (LA¥3) T7AT7 T+ —)VEHWE, BHERAL AT g2 =P IPsec
VPN, SSLVPN, 7547 L ZASSLVPN OH¥R—FrEnHY 9,

ASDM T, 28D ASANN—V a2 R—hLTWVWET, ASDM D~v==2T7 LB LA~
T Ay ~LTITIE, ASA THR—F SN TV AEFHEENT_TEENLTWET, v —
CarvDASA YT NI =T EETLTWAEES, ZHEHAONRN—3 0 THER—M STV
VERER Z D=2 T VICEENTWAEHEERH Y £7, R, WA Y — N—T g F
T~ AT = R_"=Da DA TF oA V) =R THEENBIMENTZBE. Z OBEGEIL.
DBEOTXTDOASA VY —ATHEHATERNWEAETH, ASDM O~ =a 7 /VIZEHEEN TV E
T, BEOWERBET —7 V2B L T, MENSVOBMENTZ0Z2HRL TLEEV, ASA
DHEN—T g THR—FENTWS ASDM D/ I— g 2 2W T, [Cisco ASA
Compatibility] %#ZMRL T2V, DBEHEREOR 2L T — — 2] (P1-19) HZHL
TLIEE W,

e [ASDM O | (P.1-2)

o IN—RD=7 &Y 7 bu=TOHEMME] (P1-7)

e [VPN O HH#E] (P.1-7)

o [Hrkkne) (P.1-7)

o [(ZAvFIZHEITHASA P —E R EY 2—/L OFEIE] (P.1-12)
o [ T7 A7 U+ —/VESREOHEL] (P.1-13)

o [VPN HEBEDHEZE] (P.1-18)

o (X2 UT 4 arTHAMOME] (P.1-19)

o TASA 772KV 7 O%E] (P.1-19)

o [IEHEREDORFER/2 L T — H—E 2] (P1-19)
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W aAsomoOEH

ASDM D E

e TASDM VI ATV "DARL —T 47 VAT AET T OEMAE] (P.1-2)

o lJava BIOT T oW HHaMk )

(P.1-3)

ASDM U SA T RDARL—T AT DRTLETSOTDEHK

F1-1121E. ASDM IZHS L THER S ND 7V 94T v F X —F 4 F VAT A& Java D
UARNPRERINLTOHET,

#1-1 ARL—F 120 SRTFLETSOVDEH

TS50

Internet JavaSE 75
ARV—TF 42T VRTF LA Explorer Firefox Safari Chrome g4y
Microsoft Windows (¥GE& L OH 6.0 LLKE 1.5 DAR% FAR—h722L [18.0 LI 6.0 LLK
AFE)
e 8
o 7
e Vista
e 2008 ¥—3
o XP
Apple OS X 10.4 DL PR—=F7L 1.5 L& 2.0 LR 18.0 LLR% 6.0 LLRE
Red Hat Enterprise Linux 5 (GNOME |#% Y72 L 1.5 LIk PR YP 18.0 LARE 6.0 LARE

¥ 721X KDE) :
e Desktop

e Desktop with Workstation
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Java B & U T SV DEME

#1212, Java, ASDM, BL Q7 7 0¥ E#MEICET 2252~ £,

£12 ASDM DEEEIZET S EES
Java
Version g3 EE

7 Update 51 ASDM 7 F ¥ TIEEETES |7y F v OMHEMET 2121E, ROWTNZFEITL £7,
R ER AR S o ASA ICHEHID CA 76 ST BB EE A2 A b —1T 5,
o HOEBAGFHELZ AL AR—/LL., Java IZEERT 5

(http://www.cisco.com/go/asdm-certificate % £ ),
e Java % 7 Update 45 LA X 7 7 L —FR$ 5,
e FE7ziX. Java Web Start ZfEH T %,

(GX) ASDM 7.1(5) LAETIZ. Java 7 Update 51 TIIHHR—F &N T
WEHA, TTIZJavax 7 v 7 7L —KLTHY, ASDM
FREIL TARA=Va 127 v 7L —R$52 R TE
BRWEATH, CLIZHHLCTASDM 27 v /7L —R ¢
57y, ASDM THEHI 25 ASA Z L2 Java 2> h m—)L X
FNTEX 2T 4B EZBEBNT L ERTEET, KD
Web ~X—® [Workaround] DIEZZHL T 72 &0,

http://java.com/en/download/help/java_blocked.xml

YHR U T4 HISEBILES, [HA—Y 3D ASDM %
EEIL T, 727y 7L —FLET,

Java Web Start #fEH L TWAH [, T4 ~VTrEHLIZEXIIC, 770V v 0K
B, FNCF T A TR R — R EToThbary T Y NRERINT, 77 Ui —
o—R XN EBHD (Bt RAlHE] DRRINDZENDH Y 7,
[E5EESR -
e ASDM 7> F ¥ &#fEHL £7,

E =

e Java T FZ AL INTA—=HD
-Djava.net.preferIPv6Addresses=true /X7 A — %% 7 U7 L £7,

a. Javaar hu—)L XL EEEBL ET,
b. Javal #7 %27 Vv 7 L %7,
c. [View] =27 U v 7 LFET,

d. -Djava.net.preferIPv6Addresses=true /X7 A —&% % 7 U7
[/ \i —j_‘o

e. [OK]. [Applyl DIEIZZ Vv 7 L, [OK]ZHEZ U v 7L

o
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$£1E Cisco ASA DHIE

W aAsomoOEH

#12 ASDM DEMEMEIZE T EEE (k)

Java

Version - EE

7Update 45 T X2 WFEBHENMEH & |Java O TIZE D, ASAWCBHETESEHEN A A =1 EN

TWAH4. ASDM T, REL
TN D HEIR B M |2 B 5 #8645 3
HEOTEREIND

TWRNWGA, JAR v =7 = A MMIAREL TV HHEREMEICET
HEENEATEREINET, ZTOBEZEHRL CHLREL
HA, ASDM 72 ICITHEIRIBYEN G FL TV ET, BERERIN
NI DITTBHITIE. BEEDO CANLEETE2RHELZ M X
h—F5h, ASA CHCOEBAMERAEFELERL 7
([Configuration] > [Device Management] > [Certificates] > [Identity
Certificates] Z &), ASDM Z @)L T, iEAZEICHT 2 EENRR
RE 725, [Always trust connections to websites] = v 7 K v 7
At L EFT,

ASA TIEB ARSI T A&
A (3DES/AES) 75048

ASDM Tid, ASA (Z SSL ##id D LE N H D £9, ASA ITEARY
M b7 A 2 (DES) LinfGEn Tk b, ZOfiR,
SSL ##t (29 DM b 1 7 7 B Mes e %55 . ASDM % i #) T
TEHA, o, JavaT 2T A AR —/LL T, Javab & A A
b =T HOMENDHY ET
(http://www.oracle.com/technetwork/java/javase/downloads/java-archi
ve-downloads-javase6-419409.html) , S L 2METI 2 SA . BL W
Java 6 2MEM STV D HAITIE, FIERSLZEIZRY £F (20
ROLUTZZM),

50 X aEEA D —PH 2 EH
TERW

Java 6 ZfEHL TWAHEA . Java DT 2L Y . ASDM T 50 XF
BBz LA —YHEERTLZ N TEERA, Java7 Tk, 50
VFHEHBz 52—V 4 E2EHTEET,

ASA TIXR AN 72k 5T A&
A (3DES/AES) WM (Fr~&
/o, [BIRESR 28 0 BE)

BUNCT 7 7% % ASA IZHG L C ASDM DAY T v 3 = ljjH &
o—R35Lx, 77T ASA (5L T SSL #kA3R A £9°,
ASA [TH AR S A 2 (DES) LMtEEShTHEL T,
ZORER. SSL Bl icxt T o hs 5k A4 7 7 a7 4. ASDM
DAT T vy alilizRRCTERVATREERHY £, 1ZFLALE
DOEFDOT 70U WFix, Wswiawgsibr A7 v 2R —FL T E
A, ZOD, BN ST A4 A (3BDES/AES) 235 &
TV WEEAIE, ROWTIOOERERZ#EH L £,

o FWEERLGAIL. ¥ UL E—RFLTHDASDM 7 F ¥ £72id
JavaWeb Start O s — b Uy b &ML £9,7 7 79T Java 6
RMass 2 bR AR —F S TR <Th, ASDM 7 F ¥
BL O JavaWeb Start D> = —h By MEIZNb & &b ITHEAT
HTENTEET,

e Windows Internet Explorer O %34 1%, [RI#EHK & L T DES % A
=TT H T ENTEET, FHHIC OV T,
http://support.microsoft.com/kb/929708 Z M L T 72X\,

o TRTOFRL—T 47 AT L TO Firefox DGHEIEL, [H]
WER & L T security.ssl3.dhe_dss_des_sha iX E% A *—7 /WITT
HIENTEET, HFFRrRDar7sxal—var 7Y
Ty b AR BEREF D IFEIT OV TR,
http://kb.mozillazine.org/About:config Z S/ L T 72X\,
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Cisco ASA DB E

asom o=y W

#F12 ASDM DEZEHICET EELE ()

Java

Version - EE

ERNS o HLOBAMEEIIGEEHT ASA PACEAEHAEEZLIXEH R VIEHEZEMN T 254,

EXASAHINEE -
e JPv6

e Firefox 3 & O Safari

Firefox 4 LAF§ & Safari TlZ. IPv6 24 L 7= HTTPS # il L T M
THEARICIE X2 ) T 4 FI 2 BINT 52 ERTEERHA,
https://bugzilla.mozilla.org/show_bug.cgi?id=633001 =&ML T 72
W, ZOEEE L Firefox F 7213 Safari 5 ASA ICRESIND T
~RTO SSL ##EI B £9° (ASDM ##i % &), Z DL &[]
WET BITIE, B TE HAD D ASA (x5 L CTHRATL =it 72 3F
HELHEL £7,

e ASA T SSLH; B LZEIT ) I
I%. RC4-MD5 & RC4-SHAI
EWTELED DD,
Chrome C SSL false start %
T4 E=TNICTHHLERD
D FE9,

e Chrome

RC4-MD5 B LN RC4-SHAL 7T U XA (ZHHDOT /LT Y XA
E7T 7 4V FTAR—T V) ORI aBRINT 572012 ASA @ SSL I
B EE T L 7-354E . Chrome @ [SSL false start] HERED =81
Chrome | ASDM # B TX A, ZNHDOT AT Y XLD 1D
EHEARX—TNCT B L EHELEL 9 ([Configuration] > [Device
Management] > [Advanced] > [SSL Settings] X1 > & &), FiL,
http://www.chromium.org/developers/how-tos/run-chromium-with-flags
\ZfE > T, --disable-sslfalse-start 7 7 2 % {i F L <C Chrome ¢ SSL
false start 7 4 E—7 WIZTHZ & TEET,

H— 3D IE9

H— 3@ Internet Explorer 9.0 {Zxf L Ti&, [Do not save encrypted
pages to disk] 77> a VAT 7 4L b TA F—T TR 5> TV ET
([Tools] > [Internet Options] > [Advanced] Z& ), ZDOA 7 3
TiX, &PID ASDM O & 7 —RIZRKL £9, ASDM TH ¥
Ya—RETHIICE, COFT v a v ERFEICT -7 L
TLEE,

OS X

OS X TiZ, ASDM DOFJEEFTREIZ, Java DA > A b — )L &EER X
NAEEENHY £, LEIJSL T, Tar 7 MItnEd, A
VAR —ILDET %I ASDM NEZHL 97,
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#1E CiscoASADEE |
W aAsomoOEH
#12 ASDM DEMEMEIZE T EEE (k)
Java
Version &4 EE
F T 0S X 10.8 LA ASDM IZ Apple Developer ID TE4 SV TWRWD, EITTE D

FOCTLORENRDHY ET, X2 T A OREZELLRNE,
T —WRENPERSNET,

b “Clsco ASDM-IDM" can't be opened
A b because it is from an unidentified
o F developer.

Your security preferences allow installation of only
apps from the Mac App Store and identified
developers.

Cisco ASDM-IDM™ 15 on the disk

f-3.dmg". Safar
today at 347 PM from 172.23,185.57

) OK g
1. ASDM % EITT& 5 X 5129 5I1Zi%. [Cisco ASDM-IDM

Launcher] 7 A4 2> %2527V v 7 (F720% Ctrl F—% L 723
527 Uw7) LT, [Open] Zi#INL 7,

A Chess.app Mar 21, 2013 2:14 PM 1

2 Cisco Jabber.app
| Comacts.app

Show Package Contents

1 Move to Trash

1 of 62 selec
Get Info
Compress “Cisco ASDM-IDM.app”

Burn “Cisco ASDM-IDM.app” to Disc...
Duplicate

Make Alias

Quick Look “Cisco ASDM-IDM.app”
Share >

Copy "Cisco ASDM-IDM.app"
Show View Options

Label:
x| & -

aTi05z

d

2. RO T —HEARRINETN, ZOHEENS ASDM %
EECcExEd, [Openl 27 U v 7 L FEF, ASDM-IDM 7 >
F ¥ NEEN L F9,

™y “Cisco ASDM-IDM.app” is from an

. } unidentified developer. Are you sure you
o want to open it?

Opening "Cisco ASDM-IDM.app” will always allow it
16 run on this Mac.

Google Chrome.app downloaded this file an
Decernber 4, 2013 from 10.B6.118.3.

';_s _ Open Cancel |

37053
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Nn—kmzr7eyIrnzr7oERit B

N—FHOxz7&EVYITI MY T7OERMYE

PR—FENTVDEN=R 72T VT ET =T OFEMZR Y A MO0 T, KO Web ~<—
@ [Cisco ASA Compatibility] 2L T ZE W,

http://www.cisco.com/en/US/docs/security/asa/compatibility/asamatrx.html

VPN O E #:1%

KD Web ~X—"D [Supported VPN Platforms, Cisco ASA Series| =ML TL7ESW,

http://www.cisco.com/en/US/docs/security/asa/compatibility/asa-vpn-compatibility.html

FTiRE

~

GE)  BAN. EF. 55O S T syslog A v E— UL syslog A v E—2 A A R ICRES
TET,

e [ASA 9.3(1)/ASDM 7.3(1) D ¥F#%RE] (P.1-7)

ASA 9.3(1)/ASDM 7.3(1) D #Fh ke

Jiy—x : 2014478 24 H
# 1-312. ASA X—3 3 93(1)/ASDM N—3 5 o 7.3(1) DF#REA T~ L £,

# 13 ASA /\—2 32 9.3(1)/ASDM /"—2° 3 > 7.3(1) DFTHEEE

HeE
F7AT 04— IUHEE

IPv6 {Z%9 % SIP, SCCP, BLNTLS |[SIP, SCCP, BLUTLS & (SIP £721% SCCP #fffH) ZfEHAL
Fuax DY R—k TWAEE.IPV6 N T 7 4w JERBETEL LR LT,

A SN2 ASDM HHEIEH D £H A,

Cisco Unified Communications Manager 8.6 |ASA & Cisco Unified Communications Manager /N —<7 = > 8.6 /3 FH ALiE
DY R— b Manz k9272 L (SCCPv2l DY R—F &),

AW XLz ASDM EifIEH » R A,

TR IZN—=TEBLRNATIZET S (A RX—T7NVDGE, V= IVOREDTE TH, V—/LOEFREH I
= =D T s arya |[FT, L—LDORBENT < ANDEETIH Y WA,

YR ETN WO EAZLE L7, [Configuration] > [Device Management] >
[Advanced] > [Rule Engine],

L
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#1E CiscoASADEE |

N e
£ 1-3 ASA /V— 32 9.3(1)/ASDM /v— 3 2 7.3(1) DEF#BEE (#52)
HEE

JE—F 7O RBEE
75 A7 ML ASSL VPN IZxf3 5 77 A7 kLA SSL VPN IZxt7 % XenDesktop 7 DA — k 23EH1 S

XenDesktop 7 O H K — NELE, BRIV A A 2307 v 7/ ~— 7 2ERT 25612, 7
VF 4 N—=YDURL £ ar he— L ID ZEETES5L91C
By FELR,

WKOEENAEE X LE L, [Configuration] > [Remote Access VPN] >
[Clientless SSL VPN Access] > [Portal] > [Bookmarks],

ENANVEANT B F ENANBATuFY ISEEFENANBAYY 2—2 30 DaL R i—*%
V) BEHTAE AT IADENSNALNNTFAAL R EF LTI R
DENANTNA AL FESTLFIUFETERTES L1270 9,

GE) EANANEBEAToXTEMSEHTDICE. 2015 FHDOKEIO
ISEV Y —RIZEENSEISE DY HR—FBMEZRY 9,

WOMEENEANZLEL 7, [Configuration] > [Remote Access VPN] >
[AAA/Local Users] > [MDM Proxy],

AnyConnect 7 A % L @051k T AL LBMETIE, ASA ITHLAIA E 4L T2V AnyConnect DFRE (F
LT T T —R7eE) BERBLOREINET, WAZLBEMED
RENRIL I, EEOMEPLL Y REREARETEL LI F
L7z, BIfEIZ, DAZLBHEOX AT L4F1, BLMEOFRREN LT
2o TWET, £io, WAXLBWUAT AT Iv I TI7EARY
VeBRIOI N R —ITBEMTEDL LD LT, 93x 1
ToT 7L —=R45L, URNCERL LU A Z LEER Z 0k En
TeRRE7 A —~y MIEHINET,

WO NEAEIIEEINEL -,

[Configuration] > [Remote Access VPN] > [Network (Client) Access] >
[Advanced] > [AnyConnect Custom Attributes]

[Configuration] > [Remote Access VPN] > [Network (Client) Access] >
[Advanced] > [AnyConnect Custom Attribute Names]

[Configuration] > [Remote Access VPN] > [Network (Client) Access] >
[Group Policies] > [Add/Edit] > [Advanced] > [AnyConnect Client] > [Custom
Attributes]

[Configuration] > [Remote Access VPN] > [Network (Client) Access] >
[Dynamic Access Policies] > [Add/Edit] > [AnyConnect Custom Attributes]

TAI N T TT7y N T H—2D ACIDex (AnyConnect =2 K7 A > b J& M E 721X Mobile Posture & & I
AnyConnect Identity Extension (ACIDex) |I£#1%) IX. AnyConnect VPN 7 7 A4 7 > kAR AT ¥ {F#H % ASA IZ
B2 DB @ﬂﬂ‘?‘éjﬂffﬁ‘ X AFIv s T8RRI —TIL,
2—PFORWIIZ NGO RAR A MNEMEPIEHILET,

BUAE, AnyConnectVPN77/fT/]\& X, TAZ Ay A —F ¢
V7 A7 A (Windows, Mac OS X, B3L WP Linux) D7 F > b 74—
LEBIBERE AR S LTV 5 1E A, DAP THEHI ATREZR MAC 7 R L A
T BHEINTWET,

WOEHNER XN FE L7, [Configuration] > [Remote Access VPN] >
[Dynamic Access Policies] > [Add/Edit] > [Add/Edit (endpoint attribute)],
[Endpoint Attribute Type] Ci% [AnyConnect] % &R L £, [Platform] K
0y SE Yy YAMIUIANL —T 4 7 VAT APBMSI TN E
9, F7-. [MAC Address] 7% [Mac Address Pool] (&8 Zi1FE L 7=,
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Hmee W

# 1-3 ASA /N—2 3> 9.3(1)/ASDM /Y—22 3 > 7.3(1) DEF#EEE (#EZ)

Hike

%II':

BA

VPN (Z%F9 % TrustSec SGT DE| D 24T

VE—h a—P2R3#EHEd 5 L &2, TrustSec EFX 2T 4 J—7F X
7" (SGT) % ASA @ SGT-IP T— 7 /VIZEBIMTES L9 LT,

ROBEENEANEZTERSNE L,

[Configuration] > [Remote Access VPN] > [AAA/Local Users] > [Local
Users] > [Edit User] > [VPN Policy]

[Configuration] > [Remote Access VPN] > [Network (Client) Access] >
[Group Policies] > [Add a Policy]

N TRLSE T 1 #5E

PTG ARY U THRNDOEY 2 —/LD~)L A
T ) o TNTRT AR — kDl

ISABY L THNDOEY 2— LD~V AR T=X Y 7Tkt 5 R—
MR — Rk EL 7=,

EHEEIN7- ASDM HifELdH D £ A,

N—RTU T F 22— )LD~V A F=
2V TOT 4 =T N

ASAIZT 74N P T, RESNLTWDHN—FT =7 £V 2—/1 (ASA
FirePOWER £ 22— /L2 ) D~V A T=Z ) 72TV ET, BT
DN—=R 72T TV 2a—LVDEEZLS>TTz—NF—"—% 11
H—=FTBH5ZENLEELLRVWERIX, TV a2—NVDOE=F) T %

F A4 =T NICTEET,

WOBEEMNEFIZ/2 Y £ L7z, [Configuration] > [Device Management] >
[High Availability and Scalability] > [Failover] > [Interfaces]

T3y b7+ — Lk

ASPa—RK RS v 7

asp load-balance per-packet =~ > K OH L\ auto 47 v 3 » 2T

HELASADKA L H =T A AZ(FEV 7T, ASPR—RF RN

YT DF N T a2y BT EICERRITHI VAL LR TEET,

COHBEIAD=ALZEY, AR T 7 4 Z7RBEAINTWH D0

EIYMEBREL, ROMEEZFERET S Z &N TEET,

o Tu—LETOEENLRNT T 4y 7 OEINZE > TRET LA —
IN— T

s WEDAL =T 2 AAZBYV Tt ==Y T 27747 F%
REOZ B —|ZXoTHAT LA —1NN—F

o 1 ODAT TIEEMASNRNE S 2R, MR RERAWMNBIPI-T
WAL =T 2 A RAZE) VT TRATIZA—R—=F

EHEIN7- ASDM HiEixdH D £ A,

SNMP MIB

CISCO-REMOTE-ACCESS-MONITOR-MIB 7% ASASM % %4 — k¥ 5%
L2y £L T,
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$£1ZE Cisco ASA DIFE
N e
#* 1-3 ASA /V— 32 9.3(1)/ASDM /v— 3 2 7.3(1) DEF#BEE (#52)
Bigk S A

A28 —D x4 AHEE

N ARTL VN E=FRDT Y v
T N—T DI KBNS 250 1ZHEI

TV TNA—TDOEREN D 250 @izt L=z, 7
FT—RKTIEHEK250 ., ~VF E—RKTlEHEary T A MbVRK

250 DT Y vV SN —TERETE, K7V P SA—TITIIHRK
AEDA L R —T 2 A AERETEET,

WOBEENEEINELZ,

[Configuration] > [Device Setup] > [Interfaces]

[Configuration] > [Device Setup] > [Interfaces] > [Add/Edit Bridge Group
Interface]

[Configuration] > [Device Setup] > [Interfaces] > [Add/Edit Interface]

L—F 1 VT ik

ASA 7 A% U 7Zxtd %5 BGP O
A=k

ASA 7T AZ Y 7%kt D BGP DY AR—FNBMENEL -,

WO AAET X LE L7, [Configuration] > [Device Setup] > [Routing] >
[BGP] > [IPv4 Family] > [General],

)V AN T T T —F 4 TN
% BGP OH¥AHR— |k

JUANY T T F T =T 4 7T S BGP O AR — R B S E
L7,

WOBHENERE S NE LT,
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TR, AV T FANEBEVAT LA ALy T7 (X al—va iR ELET, IR, T
ET—RHRELFEILL, A= T v a7 ¥zl — /a/kiﬁ@iff VAT A Ay
T 4X¥ a2l —T 3 0E, ASA DR ﬁz%pﬁ%lbiﬁ‘ VATA AT 4 Fal— /a/c
X, XY T =0 AU =T 2 ARLXy NI =V RTEIEGENFTA, ZORDVIT, Ry
%7~7UV~XK7&%%¢6%%$$DK&%_(ﬁ~ﬂﬂ63y%%xh%ﬁvyu~
R4572E), YATATIEHaA L THFAMLELTHEESENLTWE A THF A OWT g
ERL £,

BHlaL TR AMI, thoaTHF AL FEFSELFELTY, 2L, 2—PREIHa L TF
ANl AT HE VAT LEREWHEREFFOOT, VAT A arTXFANBIOMOT
RTCOATHANMIT IV ERAFRRICR A SRR 5,

ASA VS RBV 2T DHE

ASA VT AZ VU THFIHT AL, D ASA # 7 Vv —7fLL CT1 DOGET XA R ET 5
TENTEET, VIRFIT, BT AL ZADOTRTOFMEYE: B, Xv T — 27 ~DO%
B) BHMAD—FT, BT AAAARAZL > TEWAL—Ty hBIXOTEMEZERL £,

FTRCOary 74Xzl —ralffE (- RN Ty T ar74F¥alb— a2k
Z, YRAE— 2=y F ETORFATLET, a7 4 Falb—valid, Ay Na=yZ
HRxnEd,

»
FERDITFHRGEL A — Y —

THIOY—E A =2 T, FREBENARBLOA L T A2 ST LIFFIOSHNIC S
DET, HAROFEMAR Y AMIOWTIE, RO Web X—T 2 ZHL TLZE 0,
http://www.cisco.com/go/asadocs

o BBy —E RHETDH AR (P1-20)

o [EHEREOY—v 2 (P.1-20)

o L HY—H—LRXTAF] (P.1-20)
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#1E CiscoASADEE |

N gROBRBRLELIS—HY—FEX

WG —EXICEATEHH MK

ek — 22 FHAL T, =&z, EEEY—1Y A (Unified Communications) D&% = U
Ty TaxvERELED Ry xRy N N T T 4w T4V E YT % CiscoT v T — b
P—=ROFAF Iy T T—H_X=RLHBEDLETRMELL7ZY . CiscoWeb t¥=2V T 4 77
FATYAMHO WCCP H—E RERME LIV THT LI, ASA LD R a O A
HEHNAREICR D £3, 2D DRk —E 2D —EIZ oW T, BIOT A R CTHAL £,

EHEDH—E X

FHEHELEOREREIZ DWW TIX, ASA RN—Va Vv ORETA R EZZL T I, [AEEIC, %o
FELMThN-iE (NAT (N—2 3082 L 83 DBIICRELAEMK . hTv AT L v
N E—=FDA v X =Tz A (NRXR—=V 583 L¢84DMICRELZFEM) L) ITONTIL,
EN—=TaVDOFRETAREZSZRL TLEEV, ASDM [ZLLATD ASA VU — R LDk A #
MEMZTHOETE, BETARBLOF T A ~VTTRHEHTOV UV —ZXAONEL MR
ENTWEHA,

LAS—HB—EXHASF

LAY — P —E RTBEDL ASA TYHR—FENTWETRH, LVEERT—EY 22RbD0IC
HATEXAEAENHV T, LY — F—E RZOWTIEHBDOH A R CHBEINTHET,

Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)
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CHAPTER 2
EARY SHIIC

ZOETIL, Cisco ASA DEHZBALET 5 HIEIZ DWW T L £,

e (A~ RIA L A F =T 2 AADA LY =L~ DT 7 EA] (P2-1)
e [ASDM 7 7 ADi%E] (P2-7)

e TASDM OjZ#h] (P2-12)

e [ASDM @ ID GEHED A > A b —/L ] (P.2-13)

o [ £—FKThD ASDM O] (P2-14)

o [THHMIFDT 7 4V % E] (P2-15)

o [EREDBLE] (P.2-19)

e [ASDM TOa~v>RI A4y A ¥ —T x4 A Y —)LOEM] (P2-19)
e TASDM a2 7 4 FXalb—vay AEUDEK] (P2-21)
MEfloxt+5ar 7 4 X2l —y ar OEREDMM] (P2-22)

FGA AR —TTARDAVY)—IL~ANDT Y

ASDM 7 7 ¥ ADIEARH 3B T4, CLIZEHAL TITHOMNERLLIBANH Y £9°,

MR EZITO L, 2 Y — Vv R—F0OE#ECLIIZT 7 EALET, ZO%IL, 36 =
BWHT 7 A OHFEICE 5T Telnet £721LSSHZHHL TV E—h 77 B RAEZHRETEE
T VAT ARTTIZIATF a0 FF AN T—RTEEL TWAESIZ, 20V —L F—F
T 7 ®ATDEV AT LADFRITANR—RIZAY £7°,

ASAV DAV — ) T I ERZOWTIL, ASAVD Y A7 AF—K HARZZRL TIEIN,

o [T7FIAT LAY —)L~DT 7EA] (P2-2)
o ASAYV—E R EFVa—)Lary)—L~DT 72| (P2-3)
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M o< FSq0 4

v

B—JIAZADAVI—UMADTFT IR

TTIS5SAT72RA)—ILADT IR

2Ty 1

ATFvS2

&2 ]

ATv74

ATYvSH

TTFIAT VA Ly —)LIZT 7 AT 51213, WROFIBEIZENET,

FIE

ffeoay ) — r—7 V2L TCPCE Eay Y —)L R— IR LET, #—IF/L =
Ral—HEERREE 9600 R—, T—X Ewv 8 RNUTF 4L, Ay EYHI, 7a—
B2 LICHREL T, 2 Y — L8R L $£1,

a Y — )L =T IO ONTIE, THEHAD ASA DN—R 7 =7 TAREZERL T
AN

Enter ¥ —Z#L C, kO7n 7 N RRRIND T L EHERL E£7,

ciscoasa>

Zo7uar 7 ME, 22—V EXEC E—F CTIEEL TCWAZ &2 RrLE9d, =2— EXEC £—FK
T, EARAa~v L FORrEFEHTEX E4,

¥i#E EXEC E—RIZT7 7B A T2121F, koa<rFeE AL £,

ciscoasa> enable

W7o NRERENET,

Password:

BELANADTRTOa~v2 N, 8 EXEC E— RN CHEATX 3., H#E EXEC E— R b
V7 4 X2l —Tary BT—RICABRZ L TEXF T,

Far 7ML T, AFX—T N RXAT—KE2AHLET,

T 7 3V E TR AT =R IIZEAHICRESINTWA 72D, Enter ¥ — &L CTHEICHERFE T,
AX—=T N NRATY—=REZERETHIE, [RAME, KA UL, BXOAX—T 1 2T —
K & Telnet 782 U — b@&iJ@Ml)%ﬂ%LT<téw

FarF NN ERO LI FT,

ciscoasa#
FRHEE— R 2/ T3 21213, disable 2~ K| exit 2~ R, Fioldquit 2~ FE2AHL ET,
Jua—\)ar 4 FXalb—ary B—RKIZT77ERATHIZIE, kOa<wREANLET,

ciscoasa# configure terminal

Far T NBRO X HITEL T,

ciscoasa(config)#

Jua—N)ar7 4 Xal— /a/%~bﬁ%ﬂ$A® REXABTEES, Fe—rL 3
TA4Xalb—raly T—RFREKRTTHICE, exit a~<w2 K, quit 2~ F, i end =2 <v2
KEANTLET,
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ARVESAY AV E—T A ADAVY—L~ADT o2 B

ASAH—ER EDa—)LavV—IADT7IEX

MR EDS A, AA v FIZ (Y =L K—FIZ, H25\E Telnet £721% SSH %/ L T
VE—FT) #lL Ca~r Ry A0 2 —T 2 A RATT 7 AL, ASASM (285 L %
T, ASASM I[ZIZ THHAEOT 7 4Lk a7 4 X2 —a U REaERTWHARWNTEZD,
ASDM Z L C7 7 B A9 BHHIIZ CLI TOREDFEITNSLETY, Z I TiE. ASASM CLI
W27 7B AT B IHFECHOWNTIIAL £97,

o [ HiBIZ oW T (P2-3)

o ASAYV—bE X EVa—)L~Duas 1] (P2-4)

o [avy— vy aroaZ 7w b (P2-5)

o [(TUT 4T ary — LR OKT] (P2-6)

e [TelnettwvarousZ 7w (P2-7)

EHSAEICDOINT

AA v F CLIN G, ASASM I[ZHft 3 2121, RO 2 DO HFENMEHTE T,

o IRV — )L : service-module session =~ R Z{fEH L T, ASASM ~O1{#AB =
V=NV ERAER L £, AR = Y — IR, EBRO 3 Y — VO & IR A
TR TWOET,

Rl 2 RIR L £9,
- BV m— bRl M7 FLERA,

ASASM Vo — R L EfiZ MR CE, AX— K T v 7 Ay B—URERINET,

ASASM N A A—V % —R TEXRWA, ROMMON (Z7 7 EATEET,

- HIHIRAY =R OREFLETIILD FHA,

IR Z IR L £9,

- BERNMEE T (9600 R —),

- TEET T4 TICTEL ALY =R 1 DT T,

- ZoOa<r R, Ctrl+Shift+6, x N FZ—IF /L =R T o T MNIREAZHDT R
=T =l ATHDB AT =R LI HT A EIITE ERA,
Ctrl+Shift+6. x IX. ASASM =V — VB2 T A —TF LT, AAvF 77 MIRE
LD —rr o ATEHY ET, LERoT, ZORMT, ASASM = YV — L& #&
TLE2ET2L, =X F N VP —NRTForFPRETRTTLHZ LR T, &
Ay FIZE—=IF N =N HERLICGEG, ASASM a2 Y —L By a s nr s
TATDEETT, AAvT T hERTTAHAILIITEERA, a2V — L%
ALy F FarF MIRETICE, BEEVY TLAVERZEHATOILERLY £9, 20O
WA, CiscolOS TH —F I P —NRFHFAAS v F A —T LFE2EFTH, £
721X Telnet session =~ > K 2 L £,
~

GE) oY — I EREOKEEDZD, ASASMAZIELLS<as/ 7 hLpne, EIX
T 0L ELSEENFETLIAREEND D £9, tho ARN o/ 1T 58481,
MHEOBEGREKR T THLERH Y £,

o Telnet #%#¢ : session =~ K i L T, ASASM ~® Telnet #%¢ & /ER L £9°,
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F2E HRAYTSHEIC |

WM o9 FSAUAVE—TARDAVI—LADT 1R

~

GE) FHLWASASM IZH L TEZ o N2 MHL T T EHA, ZOHFATIE
ASASM ET®D Telnet 77 A > NRAU =R ORENDMLETT (F7 5/ FDI/RA
U—RiZdH D EFHA), passwd 2~ RZHHL TRV =R Z2RELHKIZ, Z
DO AREFEHTEET,

Rl 2 RIRL £7°,

- ASASM ~O#E¥NDty v a v ERIFICHEATE 7,

— Telnet B a i, BEERETY,

IR 2 IR L £9,

— Telnet &ty a i, ASASM YV o —KRIF K TL, #4277 L ET,

— ERIZuE—RTAETASASMIZT 7 ERATXEHA, LN -> T, ROMMON (27 7
EATEEHA,

- AN Telnet 27 A NAT—REHRETILENLY ET, T 74/ EDO/AT —
Kixdb o £8A,

ASAH—E R EDa—Ib~AQOTAY

VR EDEEG . AAYFIZ (AL FDar Y —i RB—KZ, &5V Telnet £7-13 SSH
AL TCYVE—FT) Bl Ca~vr KRI M0 [ X — 7:4’2& 77 AL . ASASM IZ
B L £,

VAT ANTTIZIF 2T A T—FTEEL TWAEAIL., A A v FREND
ASASM IZT 7B AT H EV AT ADETAR—=RIZAD £7,

ZD%IL, Telnet £721XSSH ZfEHL TV E—hF 77 &A% ASASM ICEHEXETE 7,

FIR

ATYFT1 AL TFhbH, WOWTNNEFEITLET,

o BHIDOT /EATHHARE : ALY F CLINLZDavwrRE AL, ASASM 2=
V=L T ERALET,

service-module session [switch {1 | 2}] slot number

Bl

Router# service-module session slot 3
ciscoasa>

VSS WD A A v F DG4, switch 515&E AJL £7°,

TV a— VDAY NEFERRTDHITIE, AL vTF 7127 T show module = < K
AL EFT,

22— EXEC T—RIZ7 7 kAL £,

o NV AL NRAT—RORERIMHEHAAFE : AL v F CLINLZDa~vwrRaEAHL, N
7 FL—2 %4 LT ASASM T Telnet #5555 L £,

session [switch {1 |2}] slot number processor 1

g7 Ay NRAT—RDOAIRRDENFET,

ciscoasa passwd:

Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)
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ARVESAY AV E—T A ADAVY—L~ADT o2 B

Bl

Router# session slot 3 processor 1
ciscoasa passwd: cisco
ciscoasa>

VSS WD A A w F DA, switch 515& AL 1,

session slot processor 0 = <> R (%, OV —E X EV 2 — L TEHHR—FINTWHET
M. ASASM TiIHAR—F SN TWEHA, ASASM([ZIZ7 oty 00n3bH Y EFHA,

EVa—NDAR Yy NEFERRTDHITIE, AAvTF 727 KT show module =~ K
AL ET,

ASASM ~Dnr 7 A2 NAT—REZ AL ET, passwd A~ REZHHL TRXAT—R %
HRELET, 74V FONRRAT—REH Y £H A,

2—HY EXEC E—RIZ7 27 EAL £,
ATFvF 2 EEOFHMEL )V TH D RiHEEXEC E—RIZT7 7 ®AL £7°,

enable

i

ciscoasa> enable
Password:
ciscoasa#

a7 MIHLT, A XN RXAT—=RKEBANLET, 774V TiE, RNAT—R 3%
ET-@AO

it EXEC £— R 28 T3 5I121%. disable =~ K| exit 2~ F, £/ quit 2~ F & A
L ET,

AFYFT3 Tu—N)ar7 4 Fal—ary ET—RIZT7E8ALET,
configure terminal

Jua—nN\)ary 4 Xal—rary BT—RKEKTT5HI21L, disable 2~ K| exit a2~ K,
Frldquit =~ K2 AHL £,

BEIEE
e [ASDM. Telnet, £721Z SSH ® ASA 7 7 v 2 DO#%E] (P36-1)

o [RANL, RAALVE, BEORAX—T L XAT —K & Telnet 7S AU — R OFRE]
(P.14-1)

aVvyYy—ILteyaroad 7ok

ASASM 2627 70 M LRWGAE, 3 Y —VERITHRE IS, YA LT7 7 MNIH Y £HA,
ASASM 1Y — L o a8 TLTAAYFOCLLICT 78X T2121%, ROFNEEFE
TLET,
BERETICBWEFEILRoTWDAREEDH D, O2—VDT 77 4 7T REREKTT5
WX, (7727 47 7eay )=V RO T (P2-6) L TIEEW,
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M o< FSq0 4

ATFvF1

v

B—JIAZADAVI—UMADTFT IR

FIE

AAvF CLLICREAIZIL, REANDL E7,
Ctrl+Shift+6. x
AAyF T 7T MIREY £,

asasm# [Ctrl-Shift-6, x]
Router#

~

GE)  KEPB LOREF —HR — K O Shift+6 (IF v L v bt (A) AL £7, BlOF—KR—
REFEHLTEBY, BMoXFEL Ty Ly his (V) 2HATERWEES, —RAY
FITKBNNC, =R —T LT E RO LFIIAE T TX 7, terminal escape-character
ascii_number 2<2 K (ZD¥Evy a  TEHET D), F7oid default escape-character
ascii_number 2= K CGKFAICAEET25) #HEHLET, L2 X, B0ty a v
DY —rrv A% Crl+w, x IZEE 3 5121%, terminal escape-character 23 = A )L £7,

FOT47EA0)—ILERORERT

2Ty 1

ATFvF2

Y = VB O KD, ASASM A TELLS a s 7o MLaWnWe, BHE Y b E B
DEAET AAREMENH U T, o AN v 7 AT 58581, BEOESGEZRTTH0LERD
U jz—;_ﬂo

FIg

A A F CLI/G., showusers 2~ N&2HAL T, #snhiza—VFE2ERLET, 2
V=)L 22— Teconl] EFFIEINET, mA M TRV A, 127.005000 ERRENFET (slot
EEYa— D Aay NEETT),

Router# show users

-z, Roa<~r FHEAE, Aay b2IHBEY2—1DT7 A4 0 D2—Y lTcon)] %R
LTCWET,

Router# show users
Line User Host (s) Idle Location
* 0 con 0 127.0.0.20 00:00:02

A= NERDOH LT A7 VT HITE, ROa~vr Fe AL ET,

Router# clear line number

wIZhlZ R~ L £,

Router# clear line 0

Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)
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ASDM 7 5tz W

Telnetzv> 3>RS 7ok

ATFvF1

Telnet > a v ZETLTAA YT CLIIZT 7 82T 5121%, ROFIEAEZEITL 7,

FIR

AA v F CLLICEDIZIE. ASASM ¥t — K £721Z2—H EXEC E— KM b exit Z AL F
T, a7 4 Fal—var T—RICA>TWDHEAIE, Telnet ¥y a M & T4 25 £ THe
DKL exit # AJJL F7,

AAvF T MIREY £9,

asasm# exit
Router#

~

GE) fRbvic, =xFr—7 > —4 2 Z Ctrl+Shift+6, x ZfEH L T, Telnet v a &=
Al —TFTHIENTEET, TOZARTFr—T =V AT E AL vTF 7
7~ T Enter ¥ —%#4Z LT, Telnet By a U ZHATEET, AAvFnb
Telnet v > a3 » ZHIWr+ 5121, A A v F CLI T disconnect *# AHH L F4, v 39
VEYIWE L Z2WEEA . ASASM BEEICHES T, KX A LT 7 L ET,

ASDM 7 U ADEETE

IITE, T ANN a7 4 X a2l —2 g TASDM I T 72T A HE, BIOTF 7+

IVERBREN2WIGRILT 78 AZRET D HIEIZHOWTHEBAL £9,

e TASDM 727 t2x (7747 A, ASAV) \ZxFT A THHHEOFT 74V s 27 4
Fal—Tarofif] (P2-7)

o [ TTITAT U ABLNASAY D ASDM 7 7V BEADH A X~ A4 X (P2-8)

e TASAY—E R EV2—/LD ASDM 7 7 EADEE| (P2-10)

ASDM 749 tR (775472 R, ASAV) 29 A ITBHGAEOT
I a7 4FXaL—a3 nDER

ATFvF1

THEHMEOT 73V a7 40X a2l — a2 HT 2848, ASDM #IIT 7 4L RO
Fy N = RETHENMRESINTNET,

FIR

RDOA L BE—=T 2 A ABLNRy N =7 EEMHEHL T ASDM IZH#Hi L £,
o BHALE—T AT, THEHOET VLo TERD £,
- ASA5512-X LIF§ : ASDM (28t 3 5 A o~ ¥ — 7 = A A% Management 0/0 T9°,
— ASAv : ASDM (28t 3 5 A v ¥ —7 = A A Management 0/0 T3,
o FTUFNFNOEHRTRLAIXKRD EBY T,
- ASAT 7T AT A :192.168.1.1,
— ASAv : BAFFICEHA L X —T 2 A ADIP TRV AZEREL £1,

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B
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W ASDM 7 5 EROFEE

e ASDMIZTV7®ATEDI7T57A4T7 2 MIRDEEY T,

— ASAT T TAT AT AT Mi%192.168.1.024 X b U —7 FIZHDHULERH D
FT, TN AT 4 X2 —2 30280 DHCP 3 A 32— VI ENH T,
BHAT— g NI OFPFANDOIP T RL ZAZE DY THZ LR TEET,

— ASAV: BABHCEMM 7 IAT U FDIPTRLZAZHEL £9, ASAVIL. SNz
7T AT MIZK L TDHCP — & L THEREL =8 A,

~

GE) VAT arTXFAN ET—RIAETHE, ERRORY N —IREEFEHL TEHaTF
AR ASDMIZT V7 BERATEXA L H12700 4,

A8:#EIE
o [THHHEOT 7 41 iRE] (P2-15)
o [=LF avFHAN T—RDOAX—T ML LT 4 E—T1k) (P7-16)

e [ASDM DiZ#)] (P.2-12)

FISATUVARELPASAVDASDM 7V ZRAD AR AT A X

ROFMIZ 1 DL LA TITELHAF. COFIEEZHEHL £7,
o THHHHKOT 74k a7 X2l — g RN,
o MIUAXTLU N 77 AT U4 —)L E—RNIZEBELEW,
o VwILF arTFF AL ETE—RIZEEFL,

N NA—TFT v R E—ROEE, ASDM ICIRENOBRZICT 7B AT H7-0ic, EHDOE
FIPT RV RAZRETCELA Ty a vz THHEMEOT 74/ a7 4 ¥ 21—
VarEEATAZ L EHREL £, ZOHEICEHINLTWARIEL, FllZe=—X (F 7
ARTUL U N B—RROIILT arTXFAN B—ROBRERE) BhHABELD. OB ERHE
BTAVLERLABRSIZOMMEHAL T EE W,

FIR

AFvF1 oV — )L AR—KTCLIIZTZ7EALET,
2AFvTFT2 (7 av) FIUARTLUN T AT U=V E—REAF—T NI FT,
Zoawr iR, REEZVTLET,

firewall transparent

AFyT3 FBEHALHX—T oA REFREL ET,
interface management id
nameif name
security-level level
no shutdown
ip address ip address mask

i

ciscoasa
ciscoasa

config)# interface management 0/0
config-if)# nameif management
config-if)# security-level 100
config-if)# no shutdown

ciscoasa
ciscoasa
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ATv74

ATvTH

ATv76

AFvF1

AFvT8

ATv79

ASDM 7 5tz W

ciscoasa(config-if)# ip address 192.168.1.1 255.255.255.0

security-level X, 1 ~ 100 D FT9, 100 BN b LETT,
(B SN2 EBAANH) BERy U —2ZO DHCP 7' — VA EL £,

dhcpd address ip address-ip_address
interface_name
dhcpd enable interface_name

i

ciscoasa(config)# dhcpd address 192.168.1.2-192.168.1.254 management
ciscoasa(config)# dhcpd enable management

COFBMBENICITEETRL ZAE2ESORNTL XN,
(VE—FEHAZANH) BHEAAN~DO)L—FE2HTEL FT,

route management_ifc management_host_ip mask gateway_ip 1

] -

ciscoasa(config)# route management 10.1.1.0 255.255.255.0 192.168.1.50 1

ASDM @ HTTP ¥ — % 4 F—7 LIZ L £,

http server enable

PR AN D ASDM ~D 7 7B A5 FHA L 7,

http ip address mask interface_name

Bl

ciscoasa(config)# http 192.168.1.0 255.255.255.0 management

REEZRFL £

write memory

(F7Fvay) T=—RFR&Z<vILF T—RFRITEELET,

mode multiple

TurFhREREnEs, MFEOREZEHA TR A MIER T DL I LKL T,
ASAZ U m—RT5LIROLNET,

#

KOBRETIE, 77 AT V4=V EF—FRFT AT LU b E—FICEB SN,
Management 0/0 1 & % —7 = A AR E S v, HEA A M3 L TASDM 8 A X —7 LI &R
\iﬁ_a

firewall transparent
interface management 0/0
ip address 192.168.1.1 255.255.255.0
nameif management
security-level 100
no shutdown
dhcpd address 192.168.1.2-192.168.1.254 management
dhcpd enable management
http server enable
http 192.168.1.0 255.255.255.0 management
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W ASDM 7 5 EROFEE

EEIER
o [THEHMFOFT 74/ h a7 X2 —2 a0 ] (P2-16)

o [T7 A7 U x— L E—F (U7 E—F) ORE] (P5-10)
o [ TTIAT LAy —b~DT 7 A] (P2-2)

o [ASDM OjE#)| (P.2-12)

o FIE IwNLF aryTFAK T—F|

ASAH—E X ECa2—I)LDOASDM 7 7 XNDERE

ASASM ([ZIZWER A v X —T = A A2\ 2D, ASDM 7 7 B AICHRIRESN TV ER A,
ASASM @ CLI L TASDM 7 7 AR ET HHLENRH Y £, ASDM 7 7 & 2HIC
ASASM #EET HI2iE, WOFNEEFEITL E7,

(ZC &SI
ASASM DV A 7 AH—K HARIZHES>T, ASASMIZ VLAN A H—T7 = A A& E D YT
S I

FIg

Z2FwFT1 ASASM IZHfmL ., Zue— )L ar 7 4 Xal—v gy T—REIZT77E8AL 7,
2FvF2 (A7 ar) RIUARXTLURN 75 AT U —)VLE—RE A RX—TIZL £9,

firewall transparent

oavwr iR &EEZZ VT LET,
AFvF3 THHOE—RIIEL T, KOWTNDOBREEZT-o TERAS VX —T 2 A RAEREL £,
o V=T YR E—FN 1 AU F =T A REN—T v F E-FTREL £,
interface vlan number
ip address ip address [mask]

nameif name
security-level level

1

ciscoasa(config)# interface vlan 1
config-if)# ip address 192.168.1.1 255.255.255.0
config-if)# nameif inside

config-if)# security-level 100

ciscoasa
ciscoasa

ciscoasa

security-level |X, 1 ~ 100 D#FTT ., 100 Vb EETT,

o NFUARTL UK F—FR TV IVFEBA L X —T oA AZHREL, TV vy T N—7
WEE VLAN 2% ¥ CF9,

interface bvi number
ip address ip_address [mask]

interface vlan number
bridge-group bvi_number
nameif name
security-level level

1l

ciscoasa(config)# interface bvi 1
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ASDM 7 5tz W

ciscoasa(config-if)# ip address 192.168.1.1 255.255.255.0

config)# interface vlan 1
config-if)# bridge-group 1
config-if)# nameif inside
config-if)# security-level 100

ciscoasa
ciscoasa
ciscoasa
ciscoasa

security-level [X. 1 ~ 100 ®¥F T4, 100 b L4 TY,

AFvFT a4 (HEEHGEINFEHEAANH) @B A% —T oA A2 Xy NU—27 FOER A N DHCP
A F—T NI FET,

dhcpd address ip address-ip_address
interface_name
dhcpd enable interface_name

il -
ciscoasa(config)# dhcpd address 192.168.1.2-192.168.1.254 inside
ciscoasa(config)# dhcpd enable inside

COHBENICIZEET RL A2 SN TL I,
AFvF5 (VE—FEFHFIANH) BEAARNA~OL—FEZHEL T,

route management_ifc management_host_ip mask gateway_ip 1

i

ciscoasa(config)# route management 10.1.1.0 255.255.255.0 192.168.1.50

AFv76 ASDM ® HTTP %r— "% A4 X —T L2 L F£7,

http server enable

AFwvT 1 EEHRRAND ASDM ~DT 7 A&EFFA L EF9,

http ip_address mask interface name

Bl

ciscoasa(config)# http 192.168.1.0 255.255.255.0 management

AFvF8 WEZHRMFLET,

write memory

AFvFe9 (AFvary) TE—FE<ALTF ET—FNIIHKELET,

mode multiple

Ta s NREREINEDL, BEORELEHI LTI ANIEHRT LI L E2KRLET,
ASASM #V u—RF25KH5RkROLNFET,

11
WKDON—F v R BE—RFRORETIT. VLAN1 DAL X —T = A A5HEL., BHFRXND
ASDM D A X —7 WiZL £7,

interface vlan 1
nameif inside
ip address 192.168.1.1 255.255.255.0
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security-level 100
dhcpd address 192.168.1.3-192.168.1.254 inside
dhcpd enable inside
http server enable
http 192.168.1.0 255.255.255.0 inside

WOFRETIZ, 77AT7 V4=V E—RENTUVARXT LN TE—RIZEHL, VLAN1 A
VH—T 2 A AEFREL T, BVILIZEI D BT, HHAEARND ASDM % A x—7 /MIZL
iﬁ‘o

firewall transparent
interface bvi 1
ip address 192.168.1.1 255.255.255.0
interface vlan 1
bridge-group 1
nameif inside
security-level 100
dhcpd address 192.168.1.3-192.168.1.254 inside
dhcpd enable inside
http server enable
http 192.168.1.0 255.255.255.0 inside

BEEIEE
o [ASAY—tE R FEVa—)L arV—~DOF7 7EA] (P2-3)

e HIE [wLF arTFHFAN E—N]
o [T AT T —LE—F (7N EF—LF) O#FE] (P5-10)

ASDM 02 SN

ASDM (%, kD 2 DO FIETCREICX £,

e ASDM-IDM T F % : T F xiL, ASAD Web 75U ZFAL THF Y e—REh
577V r—raryTY, INEFEHTLE, EED ASAIP 7 RV R ICHEHTX 9, b
D ASA AT DA, v F Y 2HEX o —RTHMLEEIHY A, 2T
F¥ T, e— IV THE e —RENE7 7 ANVEEAL T, (K48 ASDM 25 € £—FR
THEITHIL b TEET,

e Java Web Start : ‘EH9 5 ASA Z L2, Web 7 7 7 Y ITHEE L T, Java Web Start 77V
= a U EREELIIEETALEND Y £, fEETPCICYa—b Iy b EBEEFET
XFT, L, ASAIP T RL AT LIZya— "y FEHTHHLERH Y 1,

ASDM Ti, EHEHDZDIZHID ASAIP 7 R L AZ BN TE £9, 7 F + & Java Web Start ©
BEREDEVNL, FIT, 2=V R/RANIED L H T ASA IZ#fkE L. ASDM % EEIT 502 H Y
*7,

ASDM TIFHEED PCRV =V AT —L ar TENENT TUY vy ar #B& AL ASA

TR 2T EFEHTEET, 12D ASA T, Y 7N —T v K £—KD ASDM {7 +% v
varE5o0FTCYHR—hTEET, PCELIFV—Z AT —YaidthEn, FELiz
ASADE Yy a w1 DEF T IV TIEITTEET, vLF a2 TF AN E—FOHA,
ATHXFARNBIZY 5 ODASDM IifTEy v a v 2EITTE, ASAHT-VAE N2 By g
FCHERmTEET,

T 2T, FTASDM ICHHE T A FIEICOW T L £, WICT o F ¥ £7-1% Java Web
Start Z i L T ASDM % &EE3 2 HFIEIZOWTHAL £7,
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ASDM ) ID SEAED A2 +—) W

FIE

AFvyF1 ASDM 7 7 A4 7 FELTHRELZPC THRO URL # AL £,

https://asa_ip_address/admin

RDR L Ff> ASDM BE =V RFRSNET,
e [Install ASDM Launcher and Run ASDM]
e [Run ASDM]
¢ [Run Startup Wizard]
RAFyF2 FUFxEX VL a—RT5HITE, WOFREZFATL £,
a. [Install ASDM Launcher and Run ASDM] =27 U v 7 L £,

b 2—VHLLRRATU—-RDT7 4 —VREZEOEFIZL A A —LDEFE)., [OK] &
70w 7 LEd, HTTPS BiFNHRES N TV AR WESIL, 2—PFLAB I ORA RX—F L 2
U—K (F7 4/ T%AH) ZANLRNTASDM (Z7 7 A T& £¢, £ : HTTPS &
LA A R—T LGS, 2—V4 EBEMT O N AT —RE AL ET,

c. (VA —TF%PCIIREFELT, /A —F&2EBLIET, /AP —ADBETTB L,
ASDM-IDM T > F ¥ 23 HEIIZB & 5,

d BEIPTRLAZANL., 2—FL LRV —FR2ZHOFEFIZL (FHHEALA—1LD
BE). [OK] 27V v 7 L%d, v : HTTPS #BitAa A 2 —7 WM LA, =—T4 L ¥
BT ORI ANNRAT—REAHNL £7,

AFw 73 Java Web Start 35121
a. [Run ASDM] ¥ 7213 [Run Startup Wizard] #7 U v 7 L £,

bh. o T NNREREINEL, Ya— by M EPCIRELET, 7 a T, 77U
=g VERFETICHC L TE £,

c. a—hkAy bAD Java Web Start Z&#E) L £,

d. FHRENFEEATal Ry 7 A5t T, (EBEOHHELZZITANET, Cisco
ASDM-IDM Launcher N FERIINLET,

e. 2V LHERAT—REZZEHDOEEIZL FHRA L AN—NLDEHE), [OK] 227 Vv 7L
¥4, 7 HTTPS Rik&d A % —7 NI LT84, 2 —F4 LM T O AV—R &
ASHL ET,

ASDM D ID SEBHED AV A F—JL

Java 7 Update 51 LI Z 5 5545, ASDM 7> F ¥ [ZIXMEHE T X DR ER ML E T, 7L
EEOFEML, ACLBAMXOIDIHELS AL AN — AT A5 LIk o THBEICHEETZ &0
TEXFET, AFHAEEL A A —/L 35 FE T, Java Web Start Z{#/H L T ASDM ZiE&#+5 = &
NTEFET,

ASDM THEHT A7-DIC ASAICHCBA SN IDFGEAEEZ A AR —L L, JavaZ i L C
FEREAZ B ET BT i WDO~=aT )VESRL TLEE,

http://www.cisco.com/go/asdm-certificate

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B


http://www.cisco.com/go/asdm-certificate

F2E HRAYTSHEIC |

B F£ £—FTOASDM OEMR

TE E—F TOHASDM O fEFH

77— 9 ASDM Demo Mode ZRi& A A b —/L L TR+ 2 &, EF A 2 &2
I ASDM #3FTTExF4, ZOEF—F TliE, ROBELZFIITTXE T,

FT N AR LML K912, ASDM 2 B E & BRI L TR 2 2 7 & F1T79 5,
ASDM A v X —7 = A A2 X5 ASDM F721% ASA MEED T & FEITT 5,
CSCSSM # i L TREB L VOEEHR X 27 2FETT 5,

VT NWNEALDsyslog Ay E—TEFET, Yab—varslihb®x=4I 7 5—4n
X7 T ERETH, BT —HIELT X LTERSIVETR, ET 31 RTHHE L
TS &) R TE £,

ZOE—FRX, WOMREZYR—bT2X2T7 v 7= TWET,

Ta—r LRy —IZH L, YT —F v R B— RO ASA 1 L UM AL,

FT7V =27 K NATIZXHL, Yo IV —T v R T—=RFRDASABIORTZ7 747U 4 —)L
DMZ,

Ry bRy ST 497 Z4N0RICKHL, 0T —F v K B—ROASA BL Uk
X2 UT 4 arTFXAR,

IPv6 i+ A% A4 F>Y—% A K VPN (Z/Z 147> kL A SSL VPN £ L U IPsec VPN)
HESER] IDS (1R ARL1E)

Unified Communication Wizard

ZDOE—FR T, WOBEITTAR—FSNEEA,

GULIZERENTZar 7 4 Fab— 3 VTR 2 ERENEORLT
T ANENTT 4 AT OEAE
BlEE=2Y) I Tr—4
B o —
R DOFERE
— [File] A= =—
[Save Running Configuration to Flash]
[Save Running Configuration to TFTP Server]
[Save Running Configuration to Standby Unit]
[Save Internal Log Buffer to Flash]
[Clear Internal Log Buffer]
— [Tools] A==—
[Command Line Interface]
[Ping]
[File Management]
[Update Software]
[File Transfer]
[Upload Image from Local PC]
[System Reload]
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IBtmEoT 7+ rEE A

- YV )bN— [ R T —HF AN— > [Save]
— [Configuration] > [Interface] > [Edit Interface] > [Renew DHCP Lease]
- Tz VF—=R—EDAR N, FTIRAADRTE

o LT AX 2l =V a3 OEFRLAHBIET DRI, FHHALNMTDIS & GUL BT
DarT7 4 F¥al—aIREY £,

- arIX A0

[Interface] XA > D

[NAT] XA > DEF

[Clock] A > DEHE

ASDM %z 7 & F—F TETT 22T, ROFIAEZFEITL 7,

FIg

AFv71 ASDM Demo Mode - > A k — 7 @ asdm-demo-version.msi %, IKDFFNL XU a—R L&
9, http://www.cisco.com/cisco/web/download/index .html

AFvFT2 AVAN—TFEBXTNIV I LT, Y70 T HAL A=V FT,

AFwF3 FAZ kv 7 E® Cisco ASDM Launcher > 2 — sy NE2XZ T2 0w 7350, £-13.
[AZ—F] A==2—0 b E ET,

AFw7 4 [RuninDemoMode] F=v 7Ry 7 A%&A4 1L 9,
[Demo Mode] 7 1 > KR U NERENF T,

TIZHFEEEOT 74+ IL FERTE

HEEFOT 732V bDar 7 40X ab—va i, VAaBHLWASAIZEAL TW\Wb o
T A4X 2l — 3T,

e ASAT T I5A4T VAR TEHREOT 740 E a7 4 X2l —ariZhoTEHHAD
AL B —T 2 A AVRBREINDTD, ASDMEZHHL TCZIDA X —T7 = A ZITHEFL .
REETE T TEET,

o ASAv:EHAD—BELL T, BARE WIWOFREEAE) Lo TEHHO AV Z—
T2 A ANREENDTZD, ASDM ZHHL TZDOA L F—T = 4 ATHRL . REZ 5
TTEET, 72— VA —R—=IPTRVALERETEET, T, REIZSL T, [TH
HEHEEOT 74V | a7 X2l — a2+ 08 TxFET,

e ASASM: T 74k av 74X a2l —2aidbFETA, a7 X2 —2 a0k
FTAHIZE, TASAY—E XA EV a— )L arV—~DT 7EA|] (P23) L TLEE N,

THHEMEEOT 74V a7 4Falb—valid, =Ty R 77 AT7 74—/ ET—K ¢
U aryTR AN B—REFTHEATE £9°,
A

GE) A A=Y 7740t BENE) T740F ar7 X alb— a0z, logl,
crypto_archive/, 35 & % coredumpinfo/coredump.cfg 237 7 v ¥ = A E U NOIEHED 7 L4 L
T7ANTT, 77y a2 AEFINT, TNUHLDT7 7 ANVOAMIE, A A=Y 77 A/DH
fTe—HLBWEERHY T, NODT 7 A/WE, hIT NNV a—T 4 U TITELD ET
B, BEENBELZZLEZRTDOITTEDLY A,
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o [THPHMHOT 74V h a7 4 X2 —var0x] (P2-16)

o [ASAVEARRTEDE L) (P2-17)

e ASATTIAT LV ADT 740 a7 4Xalb—a] (P2-17)
o [ASAv DEAFKE] (P2-18)

IBHEEHOT 74 A T74FaAL—2a > DET

ATYF1

AFvF2

&2 ]
AFvF 4

& ]
& ]

ZOHETIE, THHFEROTFT 740k a7 4 X alb— a2 ETT 5 HECOVTRAL
F£7, CLIIB LU ASDM Ol 5 O FIARREES LT ET, ASAv TiX, ZOFIREETTD
L THEARENHESN, ASAT T I7AT 2 AOBE LFEL LFBHMBEOT 7 4Lk a2
TA4FX 2l —varNEHINET,

ASASM THIfIFDT 7 4V~ a7 4 Falb—vary&wHEixTbd e, REITHEINET,
THHWREOT 740 s a7 4 F a2 —vaiibh A,

[ZC®HBHIIC

IO, V—FT YR 75 AT U4 — L ET—R TCORMEATEET, hTFTLATL LR
EF—ROBPE. AV F—T 2 AADIPTRUVARYR—FEINFEHA, 512, 20T
VIV A THF AN FE—=RTORFEHTEEST, a7 4 Xab—a D7 073Nk
ASAIZIZ, ZOHEEEAZHEAL CHENICERET AEREADILTXANEBL Y 1A,

FIR

AAY ASDM 77U r—3 3> 7 4 KT, [File] > [Reset Device to the Factory Default
Configuration] DNAIZER L £7°,

[Reset Device to the Default Configuration] # A 7 B 7 R v 7 ANERINET,

(A7varv) FT7HE TRLA192168.1.1 ZEHAT b0 IC, BHA L H—T = A AD
[Management IP address] # AJJ L £7°,

(F7vayv) Rey7Z v JARHND [Management Subnet Mask] Z 3R L £97,
[OK1 %27 Uv 7 LET,
BHODHEATaT Ry 7 ANERINET,

~

GE) ZOBEFEICLY., 77— A A—URNFEET DHAEITZOHTEL . Mo EE LbIics Y
7 ZET, [Configuration] > [Device Management] > [System Image/Configuration] > [Boot
Image/Configuration] X4 > ClX, IMBAEY EDOA A=V 2 ETe, FFEDA A=
T—hTEET, HARFORTEIZRE L%, RIEIASAZ Ve —RF325L, WHT 7 v
Va AFRVORPIDA A=V LT =N LET, AT T vy a AFVITA A—TNRR
WiGA. ASAIZT7—F L EHA,

[Yes] 7 U v 7 L ET,

TNV EREEXEITCLTES, ZOREEXNET 7 v a AFVITREAFL £3, [File] > [Save
Running Configuration to Flash] % &R L £,
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IBtmEoT 7+ rEE A

COXFTvarvERERTSE, DENCBOBHEEREL CTWAHATH, a7 ¥ =
L — g NARZ— Ty a7 4 Fa2l—arOF 74V N OBEFICREEESNE T, o
V74X alb—arE VT LELREIE. ZONRARLE 7V T ERTHET,

ASAv EARTENDETT
ZDIATIX, ASAv OEARTEEE LT D HIEIZOWTHBHEL £97,

FIE

ATFYT1 Tz F—R—=%fTH72DIT, AX U RAEEBEOEFREZEY £4,
AL NAIEENT T 4 TN D 2 EBIET 572012, BREZYLLENH Y £, ERE
ANNT=FEFICLIEGE, 77T 4 7 HEEORTEMNETDE, AXUNAEBEBRT 7T 4720
DNET, UFIT 7T 47 ThoTmEER) o —F &, 7 =—VF—— 17 &L CHER
END L, HOWRERETHLWT 77 4 7EENORPIS N, LEREARENHEINET,
AFwF2 Ve—FRRBRICEARTEEZETLTLET, 72— F—R—%TH72DIZ, 77T 4 THEBETRD
a<w>REANLET,

write erase

GE) ASAYVDRBEOETAA—TET = T57D, TOT—b A A—VIKITEY FHA, TD
T—F A A=V ZMHTHITIE, bootimage =~ K EZHL T Z &0,

AT 4K 2=y g SIEFEL RV TSI E N,

AFvF3 ASAvE VUV uo—RL, BEAFREEZT—FLET,
reload
ATFYT 4 Tz F—N—EfTH DI, AXUNRAEEOBREHRRAL £7°,
[IER

TIOT 4 THEED) n— R, AZNAEEOBEREBAL FT, BABRENAZ A4
EE s ET,

AMSA7TS5AFTVADTIAILE AT 4 FXaL—3 Y

éh‘(b\i?o
- B A ¥ —7 A A : Management 0/0 (%&FE),
e IP7TRLZ: BTN Z1X192.168.1.1/24 T,

e DHCP ¥— % : BPIAR A TILDHCP — B A X —T N ENTWD720, BHLA L Z—
T = A ANZHEET A PCIZIE. 192.168.12 ~ 192.168.1254 DD T R L ANE Y B THNET,

e ASDM 7 7t R : AR A MNITHFAINET,
ZoarZ 4 FXal—variFkoa<wr R THERSNLTOWET,

interface management 0/0
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ip address 192.168.1.1 255.255.255.0
nameif management
security-level 100
no shutdown
asdm logging informational 100
asdm history enable
http server enable
http 192.168.1.0 255.255.255.0 management
dhcpd address 192.168.1.2-192.168.1.254 management
dhcpd lease 3600
dhcpd ping_timeout 750
dhcpd enable management

ASAv DE ARTE

ASAv ZE AF 2% & ASDM Z i L T, Management 0/0 A > ¥ —7 = A A ~DHEfi % A HEIC
TLEBDNTA—=2%T )V ty FTEET, —KNRERITITRORERH Y £7,

e Management 0/0 1> Z—7 = A X :
— 4 #i1E Tmanagement]
- IP 7 R X %73 DHCP
- BX=2UT 4 L0
- EHHEH

o TIUFNNTF—=F T2 AN LIEERA LA =T 2 A ADRLEHRANIPT KL A~DA
BT 47 JL— |

e ASDM ¥ — D HFFhk
o BWHIKRANIPTRL AHD ASDM 7 7 & &

e (A7 =) GigabitEthernet 0/8 HD 7 = — /A4 —_— Y 7 P 7T KL A,
Management0/0 D A X L /SA TP 7 N L X,

AFRTRY 2=y MZOWTIE, ROBREEZSEL TN,

interface Management0/0

nameif management

security-level 0

ip address ip_address

management-only
route management management_host_IP mask gateway_ip 1

http server enable
http managemment_host_IP mask management

T 2= NVF—=NR—=RXTDTTA<) 2=y MZOWTIE, RORTEESHL TS0,

interface Management0/0
nameif management
security-level 0
ip address ip address standby standby_ip
management-only
route management management_host_IP mask gateway_ ip 1
http server enable
http managemment_host_IP mask management
7 = — )V F—N—
failover lan unit primary
failover lan interface fover gigabitethernet0/8
failover link fover gigabitethernet0/8
failover interface ip fover primary_ ip mask standby standby_ ip
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gxopn H

&% 7E D FsA

ASA ZERTEBIPE=HFTHI120E, ROFIEEZFEITL £,

AFvF 1 Startup Wizard Z 1] U THIMIRRE 21T 9 1T1X. [Wizards] > [Startup Wizard] Z &R L £,

ARFwF 2 IPsec VPN Wizard % i il L C IPsec VPN $%fi & 5% €9 5 (21 [Wizards] > [IPsec VPN Wizard] %
BIRL T, BRINDHIEHER CTHRELITVET,

XFwv7F3 SSL VPN Wizard #{# /L T SSL VPN £kt % %9 5121, [Wizards] > [SSL VPN Wizard] % j%
WL T, ERINDIEMEECHRELITWVET,

AFyF a4 @S AT =8 )T 4 IZET OREME AR ET S I2IE. [Wizards] > [High Availability and
Scalability Wizard] % &R L F7°,

AFwF5 Packet Capture Wizard ZfEH L TXF7 v N ¥ 7 F ¥ 2K ET 521, [Wizards] > [Packet
Capture Wizard] Z %R L 7,

AFv76 ASDMGUI CHATELXFIFRALEAX AN EFEIRT HITIX, [View] > [Office Look and
Feel] &R L £7°,

AFvT 1 HEREEZRIET DI, Y —/L 3= [Configuration]| IR X & 7 U v 7 L, WENNDOERER &
vEIZYVy LT, HETORESNA R R ET,

@ [Configuration] B[ 23ZE A DAL, V—//3—T [Refresh) 7 Vv 7 LT, BEOIL T
VERRLET,

ATFvF8 ASA ZET=HXT5HI2iL, Y —/L3—O [Monitoring] RZ > %7 Vw7 L, ERX L Z 7 v
LT, B#ETLIZE=XV T XA E2RRLET,

(G¥) ASDM Tif. ZKSI2KB OHFTEEZVHR—FLTCWET, 2OV A XEB25L, X7 3r—~
VADHENELDZERHY T,

ASDM TOAR VK SA Y AV B3 =T 24X VY—)LD
& H

ZOIATIX, ASDM #fFHL Ta~> K& AT 5 HEB X CLI Off HHEICOWTEIBA L
F7,

o [a~r NI A B —T A2 Y —LDFEMH] (P2-20)
e TASDM Lo TEHEINDL I~ ROTF A Z ETOFRR] (P2-21)
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W aAsoMmchawy

avURS

ATvF1

ATFvF2

ATv73
ATv74

ATYvSH

ATv76

FoA4Y 48—z 4R Y—ILDOER

A A E3—T AR Y—)LDOEA

ZOREEIZIE, 2w FE ASAICEEL THREEZERRTD, 7TFANN—ZADY—L0HE
éhfmi#

CLI Y —/WZ L > TADAEEZRa < RiL, 2—VHERIZE > TRV I, A4 ASDM 7
TV = ary T4 RUDFEICH D AT —H AN—DERL ~L% BT, CLI fitEa <
R Z2FEITT 7 DICHBREHERD D0E I MEERL T EV,

(XL & BRI
e ASDM ® CLIY—/A0b AJJLTma <2 Rid, ASA O XY —IF Vb A Liza~wy
K ERRDEEEZTDHAENH Y £7,

o I LURN T — o ANaT U RICL s T2T—RRELLGA., TO#R o~
KiZAx¥xy 7S, 20O a~<r RZAEE I E T, [Response] fEIkIZIX, thooBHHEE
WELBIZ, TT—NRAELENE I DOV TOBRETRT Ay B—UNEREINET,

o AVBETIT AT AR R AV ETIT 4T awRE CLIY— A TidhAR—h 3
TWEHA, ZNLHbDOa <~ K& ASDM THEHT 5I2IE, ROa~v U RITRT LI
noconfirm ¥ —7U —F (FHTZXH54A) #FEHL £7,

crypto key generate rsa modulus 1024 noconfirm

o OFHE LOFE LN  HEOFEH - N ASADFETa L 7 4 X2l —T g%
Ty TFF—"T&EFET, ASDMOCLIY — /L Tar 7 4 Fal—ary2EBH T 584
X, T2 T4 7 REHEYE Yy v a rIMILIZRWT L2 FEFNCHERL TLEEW, #Ho2—
P RFEIFIZ ASA ZRET HHANL. ITOEENEITR D £9°,

U ASA CTHET 77 4 7 72t OEH Y v v a v 2 F/RT 5I21E. [Monitoring] >
[Properties] > [Device Access] DNIEIZEIN L £,

FIg

AAL ASDM 77V r—3 3 v 2 KT, [Tools] > [Command Line Interface] M JIAIZEE4R
l./ \i—;«(}

[Command Line Interface] # 4 7 07 R v 7 ANERINET,

MBRa~< FOA A7 UATERIFELRIT) 2R, Froy XXy JApba~vs R
ZIEINT D, FlIIERSINTZT7 44—V RIZa~ Fe AL £,

[Send| #27 Vw7 L Ca~<wr REFETLET,

FLwnwa~<wr REASTHITIE, [ClearResponse]l 7 U v 7 L Thb, FEITTHHlDa~<w K
PR (F7EAT) L ET,

Z DFEBE DIRBUAKAF~/NV T % F/Rx9 %5 1Z1L, [Enable context-sensitive help ()] = v 7 R v 7 A
AL ET, INRMEGFE~N T2 F 45 —7 VI T B0, ZOF 2wy VR 7 A%RF 7
l./ \i—a’_ﬂo

REZEEL7-854E1%. [Command Line Interface] # A 7 2 7R v 7 A% U 7% (2. [Refresh]
#27 V> 27 L TASDM COEHENELEFRRL £,

Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)
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ASDM > T 4 ¥aL—2a sk B

ASDM [Z &> TEBRINBZ ATV FDTFNNA ALETORTR

ATYF1

AFvT2

ASDM o >

ATYF1

ZOEEICE Y . ASDM XY R—h L TWWAWhWa~vwr RO—&E42»FRTXET, B ASDM
= :ﬂ%@f—"?/}‘ PEME L ET, ASDM (L, =2 —HFDFEfTary 7 4 Fal—rgrpa~w
VREEW, BIRTAZEEHD FHA, FEHIZOWTIE, THAR—F SR Tnna <2 K]
(P3-35) &ML T 7E &V,

FIR

AAY ASDM 77U r—3 3> 7 4 KT, [Tools] > [Show Commands Ignored by ASDM on
Device] DJEIZEIRL £7°,

BILEL, 0Kl 227Uy 7 LET,

24X —32 AEYDHKX

ASDM THR—F END2HKRET A XILS512KB T, 2OV A RXEZBxHE, N7 53— ~
VADRENREL A ERDHVET, LI, a7 4 F¥F 2 — /a/@m—%ﬁ X, 58
TLiEary 74X ab—yarQEENRAT—HAFT ATl Ry 7 ACERENET, 20
LE, VM ARORENT LT 4 X2 —2 32 TliE, ASDMIZE o CEFa sy 7 4 F a2 b —
va OB IThIL TV TS, mTLf_ 15O PEIEL, BIERTFEHIENTWE X9z
RAFET, 20X BRUNPEBELFESIT. ASDM P AT A b—7 AF ) O KR E BT
LI EEALEL 7,

ASDM t —7 AE Y A XERTHITIL, WOFIEEZFEITL I FryDa— My R
PETL ET,

FIR

Windows OIFE :
a. ASDM-IDM 7 F ¥ D> a—b Ay h&427 Y v 7 L, [Properties] & #IRL £,
b. [Shortcut] ¥ 7% 27 Vv 7 L $£7,

c. [Target] 7 4 —/V R T, [-Xmx] DTV T 4 v 7 AW 5HEEREL, LELE—
T HAXERELET, 12&Z21E. 768 MB OBAI1EL -Xmx768M IZZEE L, 1 GB O
AT -Xmx1G IZEFEL £,

Cisco ASDM-IDM Launcher Properties

General | Shatcut | Compatibility | Security

i'; Cisco ASDMADM Launcher

Target type: Application

Target location: spstem32

Target: w.eRe mnzBdm S -Dsunswing. enablelm

Start i "C:hProgram FileshCisco Spztemsha SOy

SBETD

Shartent ke e

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B



®2E FRTBAINC

B EScHTd3I074¥2L—Yav0EREOER

AFvF2

Macintosh D4 :
a. [Cisco ASDM-IDM] 7 A 22> %47 V > 7 L, [Show Package Contents] Z &R L F7°,

b. [Contents] 7 # /L% T, Info.plist 7 7 A NEXT NIV v 7 LFET, BAREY—NLEA
AR =L TWEEHEIE, 7uXr o VAN =F 4 ¥ TCHEET, 29 ThWEEIE,
TextEdit TBH & 9,

¢. [Java] > [VMOptions] T, [-Xmx] DT L7 4 v 7 AN W= XFHEET L, LB
E—7F A XEEELET, 2& 21E. 768 MB OEATE -Xmx768M IZZEH L. 1 GB D
BPAIT -Xmx1G ICEFE L F£7°,

S SR e

Fey=Java=key

adict>
Hey=Yorkinghirectory=/kevs
<ztring=$aPP_PACKAGE/Contents/Resources/Java</string=
Hey=YMlptions=/key>
%ey:ﬂuint'[ﬁ's'é';:}"key}
<=tring=con.cisco. louncher .Launcher </string=
dey=MVersion<kevs
==tring=1l.5+=/string=

nEm

d ZO77AnnuvrE3nbeE, RDOELI BT —NERRINET,

The file “Info.plist” is locked because you
haven't made any changes to it recently.

j” If you want to make changes to this document, click
4 Unlock. To keep the file unchanged and work with a copy,
click Duplicate.

Unlock Cancel | Duplicate |

=S

e. [Unlockl]#7 V v 7L, 77ANVEHRIFELET,

[Unlock] ¥ A 7 R 7 ARy 7 ANKRRENBZWVIEEIT, =7 4 X% TLET, [Cisco
ASDM-IDM]| 7 A 2> %427 Y » 7 L. [Copy Cisco ASDM-IDM] % 4R L T, &£ XALHE
R23o 28507 (T A7~y 7l) [T Ed, 20k, Zoav—nhbe—7 A
RuEBEELET,

B&EIZNT a0 724 F2aL—CaVvnEEDEA

a7 4 X2l —al il L TR )T 4 R —OEREEZ M EAT. T _TOHL
CEERECHT LV EX 2 ) T 4 KU MRS T, BEFOBERTIE, £ OB S
A CTRESNTOWERY o —DEANEITSNET, HOEEEICKT 5 show =2~ KD
HARE a7 4R ab =2 a VAL TEY, BHICE > TEEVERICET 27— 4
NEEFNRNZ ERHY £,

e ziE, A X —7 A A5 QoS service-policy # HIFE L, (EIEN—Y 3 v 2 FEBINT
%34, show service-policy =~ R Zi%, HTILWH—bE X RV o — & —84 58k & E
WA HNTND QoS WY U X DAHAFRREINET, HTWARY v —OREGFOER X~ N
WIEERINERA,

TRTCOBEGENPFLWVWRY O — 2RI TS L0, BIEOERZMERL. LAY
VAL CHEERTELLIICLET,
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| $£2& HERTSHIC

ERIcHT a7 FaL—LavozanaEs A

Bt x fibr4 51212, konwdFnroa~vr e AL T,

e clear local-host [ip_address] [all]

Zoavy R, BEHIRECHIEGORIRRE, 779 AT I DT H AL AT —
NEBOEELET, 2L, ZoawrNiE, 2L OHIBEERAL TWATRTO
BEREHIRL 9, BUEOT X TORER 27K R FlcRK T 5121%. show local-host all =<
VRESRLTLIEE Y,

SIERRELRWE, Zoa~vr NiE, 2L 53 XTO through-the-box ##it % 7 U

7L ET, to-the-box #f5ih 7 U 7§ 2121F BIEOEH Yy a v 25Te), al ¥ —U—
REMHLET, FFEDIP T RLA~ND, ERITRHEDIP T RV ANLOHEERE 7 VT

T BHITIX. ip_address 5IE AL £7°,

e clear conn [all] [protocol {tcp | udp}] [address src_ip[-src_ip] [netmask mask]] [port
src_port[-src_port]] [address dest_ip[-dest_ip] [netmask mask]] [port dest_port[-dest_port]]

ZoavwrRiE, TRTOREOEREAZKETLET, BIEOT X TOER AR TT 511X,
show conn =~ R A& L T 7E X,

SIBERELRVWE, ZOa~2 RiX7TXTO through-the-box #fc a7 UV 7 L £7°,
to-the-box i 7 U 795101 (BIEOEHE Yy a3 258), al ¥— U — R &2FHL
FT. FETIP TRV A, SLEIP 7 FL AL R—F, 71 b a0 TRIE D EEE
VT HITE, MBRA TV a v ERETCEET,

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B
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CHAPTER 3

ASDM 7574 Al A—HF 4282 —Tzx
AR

ZDETIE, ASDM 22—V A Z—7 = 4 ZADfEHFEICO W THIAL £,
o [ASDM z—H A % —7 = A4 A2\ T (P.3-2)

o [ASDM 2—# AL ¥ —T = f ADF 4 —r 2| (P3-4)
o [ A==2—] (P34)

o [YV—3—] (P3-10)

e [ASDM Assistant] (P.3-11)

o [AF—HZ N—] (P3-11)

e [[Device List]] (P.3-12)

o @A %) (P3-13)

o [¥—FKR—FK va—rhvb) (P3-13)

o %< D ASDM A > TOMBEKERE] (P3-15)

e [[ACL Manager] X1 > O %R (P.3-16)

o MEEERZ7 YV —2 U—& HHR—hDA3R—714k] (P3-17)
o [P 7 45— (P3-17)

o [~T7 T4 RulZonT) (P3-17)

e [[Home] XAy (v 7N EF—KREarFxzxh)] (P3-18)
e [[Home] XA > (System)] (P.3-31)

o [ASDM #EDEF] (P.3-32)

e [ASDM Assistant TO/iE | (P.3-34)

o BEANY v 7OA3x—T711) (P3-34)

o [PR—FENRTWiwna~wr R (P3-35)
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M ASDMa—¥ 12 8—T A RI2DVT

ASDMA—H /13 —T 4 RIZD\T

ASDM =—H% A Z—T = 4 AT, ASADFR—F L TWAISEXERMEICHEEICT 7 &
ATEDLLIICERHENTWET, ASDM 2—% f U X —T = f ATIZRDEELH Y £97,

o Ty AN, V=, 4P —FK, BIORNTIZITSIT IV EBATEL A= 2 —— R
Za—HHADEZLIZEF—FR—FK va—b Iy +bH T,

e ASDM OFES —F& A R2—TNWIZTBHY — /L 3—, V— )L X—1n 5 [Home] XA >,
[Configuration] ~X-1 >, I & U [Monitoring] XA 2T 7 EATEET, £/, ~LTDH
XA U lOFTE S —va b TEET,

o K v JHR[EEZR/E{H]D [Navigation] ~X1 >/, [Configuration] ~X-{ > <> [Monitoring] <A1 >
NOBENERLET, ~v X —1lhH B3 o0ORZX L B2FNFNI Vv ITHLE, A
DKL ETITE I, BEIFRER 7 a—T 47 XA U ~OET, XA DIEFRRME, £
72E_A &AL D Z ENTE E£J, [Configuration] X > ¥ L U [Monitoring] XA 127
IR 2T HITIE, ROWTANLEETL T,

- TV = ary Uy RUOEIH HAEMO [Navigation] XA DY > T %
Vw7 LFET, ZEIRL 7= [Content] XA L DX A KN INR—|IRANFRINET
([Configuration] > [Device Setup] > [Startup Wizard] 72 &),

— EREZRSAR Do TWDHEA. MO [Navigation]| XA > TU 2% 7Y v 7 L7<
Th, 77U —vary v RuoAlicd 5 [Content] XA > DX A N JL3—|ZH
BANITEET,

e [Content] XA > DAHEIZH 2 KL L OO A XNZRERT AR X o, £ [Navigation]
NAVDIRRRRREITVET,

o K v u[HE7R [Device List] XA >, ASDM M BHT7 VB ATEDLTNRAADY A NE2F
RLET, "X —ZHDI3ODRF L EZETNENT Vv 7 TDHE, XA LETR
XEIT, BEIRRER T a—T 4T RAUADOER, XA ORI, FEAA
AL Z &EMTEET,

o RT—HAN—, K], BRAT—F A, a—% AFY XTFT—FRA Fffar7 ¥z
L—3 gy AT —F A HERL~NL, BEXOWSSL AT —F 2527 XV r— a0 7 40K
7O FREIICERL £97,

o JEfHl® [Navigation] XA >, 77 A JL—/L NAT L—/L, AAA/)L—)L T 4)LH )L —
. BIOYV = 2 = LOMEREFICL—L T—T NV THATEL S EE AT V=7
FaRRLET, RACAOET XAV, BRL TS TEDLY 7, %
72, T DA 21 ASDM Assistant 23 F R SV E T,
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GE)

ASDM 21— /> 4—J /4 R(z2vt N

X 3-1 (P3-3) {2, ASDM =—#% A v X —T7 = A ADOHEFERL £,

& 3-1

[

ASDM 21— 7> 8—2J x4 X

File Wiew Tools Wizards Window Help Laok For: il
= = — — = = L} L} L}
@ Home o%é Configuration @ Mumtnrlng‘ B Save GReFrash| o Back (- [) | ? He\p| cisco
Device List & % % | Confiquration = Firewall = Access Rules o Addresses | Services [Time Ran.. |
& Add T Delete ¥ Connect ’—H RS | + 4% B B -|Q Fnd B Dagam [Esport ~ g 1) | Addresses G 8 x
2 10.10.10.0 - — | 4 add - @ et [l e
A 1010101 # Enabled | Sowce Destination Service Action | Hits
L.® 10.10.102 { ) A |
[ %110.10.10.3 A i @ any @ any wip @ Deny e a1
£ 5% management 1Pv6 (1 implicit incoming rules)
= = = [=-1Pya Network Objects
] @ any @ any rip @ Deny @ any
A | |E B gt (L implici incomning rules; .
- (23 NAT Rules = : ¥ a1 i 9/1uke3) ) : a8 mmt-networkiz4
£y, Service Policy Rulls i @ any @ any 0 @ Deny - B outside-nstworkys
g AR Rules = % momt 1P (1 implct incoming rules) = 1RvE Netwerk Obiects
BB Filer pules i @ any @ any i @ Deny @@ any
[ Public Servers & B outside (2 implicit incoming rules)
B URL Filtering Ser[ors i1 @ any @ Any less securene... e ip « Permit
b % Threat Detection P2 @ any @ any e @ Deny
(=I5 Objects = B outside IPvs (2 implicit incoming rules)
""" a8 Eatwm’fh“ tefGroups 1 @ any @ any less secure ne.. T dp o« Permit
H ervice Grou|s A 3 ® @ any B @ bery
v
< | |2
" — A A
£ Frowal
Remote Access VPRI
Ske-ta-Site VPN 4 | k:
Access Flde Type () IPvd and IPV6 () IPvd Orlly () IPVE Only
E) Device Managemer,
» [ Apply ] [ Reset ] [ Advanced. .. =
N
docs 15 B 7/24/09 3:06:11 PM UTC
N I 1z 5

90

R

®

@

GUI EXR

198

)(::L"_‘/R“’_‘

7 4 — VR

W — LN —

TES =g RA

[Device List] ~-A1 >~

/el [Navigation] XA >

[Content] ™A >

Al [Navigation] XA >

O ([0 Q||| | W] =

AT —H A /)N—

Y —)L B RS, [Wizards] . [Configuration] ~*-{ >, [Monitoring] XA >, AT —F A )N—%

G, GUIO S £ EREDITEMENRTWVWES, YV—/L by hE2FRTHITIT, w7 A% A
TR ANR—IHDT Al ¥EOD2Z—Y S X —T 2 f RAHEFD LITEX T,
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M ASDMa—¥ A2 8—Tz1RDFES—L 3y

ASDMA—H A 23— x4 RDFEHSF— 3

ASDM = —W A 2 —T = 4 ZA&HFINZBENT H72012, fIOHETHPAL A= — V—
NR— Ry XU T AEER AV BLOEM &AM O [Navigation] <A > & kA5 o w T
T&F9, HHTE HHBEIX, [Device List] XA D FDORZY JARMNIERINET, 72&
ZIE, U AMIIIROEEER X BN EENET,

Device Setup]

e [Firewall]

Trend Micro Content Security]
e [Remote Access VPN]
Site to Site VPN]

[
[
[
¢ [Botnet Traffic Filter]
[
[
[

FRENDERERZ L DU AN, BEALTZT A2y AEREICE S TR RENES, a7«
XFal—Vary Ba—FFEE=XY ol Ea—0BIR L FEREOBRIIORA NIT VAT 5
Wik, TNFENoORA 27 ) v 7 L FET, A—A E2—Ti, #ERZ IIfFEHTEEEA,

PRRER 27 > DRTFZLZ DB, ROFIREZFETL £,

Device Management]

ATFYT1 REOHERZ O FIZHH Ny T Z 0y VAN RZUEBERLT, 20 7THF AN X
—a—%FKRLET,

AFvF 2 KOWTNOLOL TV g U EBIRL £7,
o EBIRT DHARH L ZEELT 2L, [Show More Buttons] 227 U v 7 L ¥,
o FRTABRZLUEWS I ITIL, [Show Fewer Buttons] #7 U v 7 L £,

o RHUHBIMELITIHIEET HIiT1X. [Add or Remove Buttons] &7 V v 7 L, FE/RI N2V
ARNNLEBMELZHIRT IR 2270 v 7 LET,

e [Option] #®IRF 25 & [Option] ¥ A T BT KR > 7 ANEREN, RXL DY AN NEAED
HF CERENET, ROWNTMNEZRINL £97,

- VANAOREZ % EICBEIT5I121E, MoveUpl 227 U v 7 LET,

- VDRAMHNOREZ % FIZBENT 211X, [Move Down]l %27 U v 7 L9,

- UANNOEBDIEF 2T 7 4/ F&REICKETIZIEL, [Reset] 27 Y v 7 LET,
AFvF3 [OK]z27 Uy 7 L TREZRFEL, X ATl Ry 7 22ML £,

ASDM O A= 2 — 2%, U A3 F—FR—F2FHAL T 7R TEET, F—HR—F
AL A= 2— /§»—f\0)777‘{fz@§$7lﬁwﬁxt/3b‘f{i‘ [ —FR—K va—F~Dh Y
(P3-13) &ML T &V,

ASDM ICIZIRD A==2—NdH Y £4,
e [[File] A==—] (P.3-5)
o [[View] A==—] (P.3-6)
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e [[Tools] A==—] (P3-7)
e [[Wizards] #==—] (P.3-8)
e [[Window] #==—] (P3-9)
e [[Help] A==—] (P3-9)

[File] A=a2—

A=a—

[File] A==2—TI%, ASADIL 7 4 Fal—ary2EMTxET, ROFXIZ, [File] A
—a—%EHLTEITTEAX AT ERLET,

[File] *=a2—I8H

86

[Refresh ASDM with the Running
Configuration on the Device]

FiTar74F¥al—varoat—% ASDMIZr—R L
£7,

[Refresh]

ASDM IZFEfTa v 7 4 X2l —L a v OREHOar —neg
FndEolcLET,

[Reset Device to the Factory
Default Configuration]

a7 4 X2l —arE THEHEEDT 7 44 NZE T
=

[Show Running Configuration in
New Window]

HIEODETa Ly 7 4 Fal—varyZHLnWy 1 R
%ZT—\‘L/ jz—jao

[Save Running Configuration to
Flash]

Rifar74Ral—varpat—&77yva A
ICEZIABET,

[Save Running Configuration to
TFTP Server]

HEOFETa Ly 7 4 FXalb—ay Ty AvOat—%
TFTP % — NIZRFEL 77,

[Save Running Configuration to
Standby Unit]

FIAVEBEBOFETa L 7 4FX¥alb—ay 770D
AV —%, T LA —N— ZE R AEEOETa
TA4Xalb—va ICEELET,

[Save Internal Log Buffer to Flash]

W7 Ny 757527 T vy a AT VICREL £,

[Print]

BREOR—=V AL £5, v— A Z2HRT 585456, <—
VEMAMICT DI L a2 BB L £9, Internet Explorer #
Laid. BAMNET 7w b ERNIEKR L 7R TR
HERRDS 52 5L TWET,

[Clear ASDM Cache]

27—V ASDM A A—T % HIFRL £9, ASDM ([Z#kiT 5
ELASDM ICE O A A=V R —h it ran—R Sh
7,

[Clear ASDM Password Cache]

HLWANRAT—RZ2TERELTERIC, TNEITERLBEFD
NRAT =K NEEHRS> TWAHEHAIE, XAT—F £y v
vamHlIBRL £9,

[Clear Internal Log Buffer]

syslog A v &—Y Ny 77 &2 7,

[Exit]

ASDM Z#FALU £,

CiscoASA V) —XASDM a> 7 4 ¥al—> a3y H4F (—BMGEE)
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[ | A=a—

[View] A =1 —

[View] A==2—TiZ, ASDM 2—H AL 4 —T =2 A AD S X £ RO A2 F R TE 3, BE
DE 2 — L UERECHANREKR REINET, BIEOL 2 — R R TERVHBEITRIR T F
A, IROFKIZ, [View] A=a—%fHL CTIITTEL X AT ZRLET,

[View] A= a21—I8H

A

[Home] A—b bBa—%FrLET,
[Configuration] a7 4 FXal—vary ta—%FRLET,
[Monitoring] TR T Ba—EFxLET,

[Device List]

R X VHRERNA NTT AL ZADY A &2FRLET,
FEMIZOWTIL, T[Device List]] (P3-12) #&fRL T2 X
A%

[Navigation]

a7 4 FXFal—Yaryrtta—BIOE=FY T v a—
T [Navigation] <A > & F£R LI2ITFHFFRITL £77

[ASDM Assistant]

H AN T2 ASDM O FIEO A~V T R L, RO
T ET, ZEMICOWTIL,. TASDM Assistant] (P3-11) &%
L TL7E&E,

[SIP Details]

FREAY MU= EREFRELITERTICL T,

[Latest ASDM Syslog Messages]

AR — 2 B = — T [Latest ASDM Syslog Messages] ™A1 > % &
IRFEZIFEELERICILET, ZOXA 0, A= E2—T
OAHFEHATEET, HHOV Y —RT T TV —RT5%
7DD AEYNRAREL TWDHILGEIE, syslog A E—Y
%ASA-1-211004 DERK I L, A1 AR =L TNDH AE
UV, BEORER AT REINET, 2O Ay E—T0F,
AFRIVUNT v 7T —RINDET, 24 BT LITHER
SNET,

[Addresses] [Addresses] XA > & FRRFEILIERRICL £7,
[Addresses] XA %, a7 4 F a2l —r a3 Ba—0D
[Access Rules]. [NAT Rules], [Service Policy Rules]. [AAA
Rules], # L O [Filter Rules] XA > TOMREH TE £,

[Services] [Services] XA v & FR FTITFIHEFERITL £, [Services]

NRANE, a7 4 F a2l — 32 B a—0 [Access
Rules]. [NAT Rules]. [Service Policy Rules]. [AAA Rules].
F L O [Filter Rules] XA > TOAMHEFTE £7,

[Time Ranges]

[Time Ranges] A > Z R R EZIFHEFRRICL 9, [Time
Ranges] XA i%, a7 4 FX¥alb—vars Ba—0D
[Access Rules], [Service Policy Rules], [AAA Rules], ¥ X
X [Filter Rules] XA~ TOIAFEHTE £9,

[Global Pools]

[Global Pools] XA > & F/RFE7-I1XFIEFRRIZL £9°, [Global
Pools] XA id, 27 4F a2l —T a3y B =a—0 [NAT
Rules] XA TORFHATE E7,

[Find in ASDM]

HEHES> ASDM Assistant 72 K OHEH BB L £7°,

[Back]

BIDNRANIREY £, FFZ Wik, M3EEAR & > )
(P3-13) &ML T 7E &V,
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A=a— [ |
[View] A= a1 —I18H By
[Forward] PIHTICFR R L 2RO A BB L £37, FEMIC OV T,

(MR 2] (P3-13) #2MRL TL7E&0,

[Reset Layout]

L AT NETFT 740 Dy 7 4 X2l —2 a3 lREL
ij‘o

[Office Look and Feel]

BE D7 4> ~ &% Microsoft Office R EICEF L £,

[Tools] A =1 —

[Tools] A== —IZ{%X ASDM THEHTHKRDO—EHD Y — 2 H Y 7,

[Tools] #*=a1—IEH

A

[Command Line Interface]

AR Z ASA ICEEL THRERZFRL £,

[Show Commands Ignored by
ASDM on Device]

ASDM TER I NT/=, VPR — b Da~ 2 K EeFRL
*7,

[Packet Tracer]

FBELEERLTT RV AEA L X —T =4 AMBSEEE T,
NryhERFL—ZALET, Y2 halBlOF—%
T A ATICEHD YR IBETE, £ITETEINTAL
BOFHMT — X2 E&i\ry hO—HEkEERTEET,
FEAZOWTIR, V7 AT U4 AT 4 X2l —Ta
VA RESZHRL TLIEIN,

[Ping]

ASA BL ORI 2@E) v r70ary 7 4 X2l — g
REEAMGEL ., DRy N U—27 FTARAL ZADIEARN T
ARNEFITLET, IOV TE, 77 AT U4 —/L 2
V74 FXalb—vary HARESRL TIES0,

[Traceroute]

IRy RS RICEIET A ETONL— BT £, 3F
fMcHONWTIL, 77 A7+ —/bary7 4F¥alb— g
HAREZSRL TLIEEW,

[File Management]

7Ty va ARVIREEINEZT s ANV EER, BE), 2
F—, BXOHIBELEY, £/, 77 v v a2 AEVICTT 4
V7 NUEERTBHZELTEES, /2, TFTP, 7T v
Ya AEFY, B—HhHNLVPCRESENERT AL AT
LAETT7 7 A NVEEENRTE ET,

[Upgrade Software from Local
Computer]

ASA £ A—, ASDM A A— T3 —H PC Ofthd
A A=V ETTyvva AEVICT vy —RLET,

[Check for ASA/ASDM Updates]

AP —REFEHLTASA V7 F 7 = 7B LN ASDM
TN =T ET v 7L —RLET,

[Backup Configurations]

ASA D37 4 ¥ 2L — 3, Cisco Secure Desktop -
A=Y BELO'SSL VPN Client f A=V BLRNT 7 7 A
NEaENRy I T v T LET,

[Restore Configurations]

ASA D=7 4 ¥ =2 —3 3, Cisco Secure Desktop
A—3 BLOSSL VPN Client £ A—Y B L7 27 7 A
NIl £,

[System Reload]

ASDM ZHEE L., (#EL7-ary 7 40X a2l — g% A
TV e—RFRL%ET,

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B
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[ | A=a—

[Tools] A= 1 —IEH

Bl

[Administrator’s Alerts to
Clientless SSL VPN Users]

RPN 7S5 4T hL A SSL VPN =2 —H|27 F— h
Av—UEEETEDLILHICTLET, FEMIZOWTIL,
VPN 2> 7 4 F¥ a2l —ary HARERRBL TLEFEN,

[Migrate Network Object Group
Members]

83 LIRICBATT 284E . ASA IZLRIfE Xy N U—2 %
7Vl bEERL T, —HOBREEDOA T AP TR L
AEEEHZET, LA EAT o7 NITMAT,
ASDM |Z2 v 7 4 X a2l —T a rTHEHAINTWST T
DIP 7 RV AR L CARIR LA T V=7 b &= BEIMICE
%Liﬁo_ﬂ%@§@¢ﬁ3n6ﬁ7xlﬁbim7ﬁ
XX > TORHRIE N, ZRinE, 7Ty 74—
LBEICLFTEAT 27 MU TUIFEEL T A,

BATO— & L CLARIfT&EA 7Y =7 b & ASA MERRT 5
Ba., AT LN E ASDM A7V =7 M, 4
mﬁ%ﬁ7/mﬁb WCEBRIS N ET, ME-0fsNE, x>
FO—2 F TV N TA—T DL EF TS b
Ty, Xy hUV—0 ATV N IV—TRNIZHDHIPT
KU ADLARIT &4 TV =7 k& ASA BMERT 254
ASDM 3 ELRIf&E AT V27 ML EE, EHEL
A7V =2 b ASDM TERL £, ZNbHDF 7V =
J N &=—U T 5121E, [Tools] > [Migrate Network Object
Group Members] Z &R L 77,

FEAMIZ DWW TIL, TCisco ASA 5500 Migration to Version 8.3
and Later] Z#ZML T7E3 0,

[Preferences]

vy a BTORED ASDM HEEEOEIELZ ZE L £,
FEAMIZ oW TIE, TASDM REDEF] (P3-32) R L T
<TFEEW,

[ASDM Java Console]

Javaa Y — a2 FKnrLET,

[Wizards] A =1 —

[Wizards] A== —I|ZX 0, SEIEREEEZRET DLV 4P —REZEITTEET, ROEIC
FEHTREZ2 Y 4 P — R B X 2O E R~ L £7°,

[Wizards] * = 1—I8H

EEI;

BR

[Startup Wizard]

ASA DHIMIa > 7 4 X2 — a3 OB FIRZ R L
*9,

[IPsec VPN Wizard]

ASA [ZTPSec VPN /R V) o —Z R ETE ¥4, FHEMIZOW
Tk, VPN a2 74X al—ary HTAREZBBL TL
7230,

[SSL VPN Wizard]

ASAIZSSLVPN R Y U —%FRETEET, sEfic>VTIL,
VPN 7 4 Fal—ary HAREBRL TLIFEN,

[High Availability and Scalability
Wizard]

VPN 75 AKX o —R RT3 7 F7-13 ASA TD ASA 7
SABY T REDT 2 — NI —R"—DBRENTXET,

Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)
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A=a— [ |

[Wizards] * = 1—IEH

Bl

[Unified Communication Wizard] |[ASAIZIP 7 4o R EDZ=T 7 A KN a3 a=b— g

HEEZHRETEET, FFMcO>VWTIE, 77 AT U4 —/b
a7 4FXal—ary HARESRLTIIEE N,

[ASDM Identity Certificate
Wizard]

Java 7 Update 51 U2 M9 554G, ASDM 7 > F ¥ 121
FHTZ LEAENLETY, EHFOEM|IL, BHCEL
FEDOIDFEAEELZ A AL —1T 52 LTk TRHHIZ
Wl enTcEEd, 2OV F—F2HEHL CGEIE
AL AN—)LT 5 FETIE, Java Web Start Z{HH L T
ASDM % 8925 Z LR TE E£F, FEMIC OV T,
http://www.cisco.com/go/asdm-certificate Z L T X,

[Packet Capture Wizard]

ASA Ty h Fx T F Y AR ETEET, 20U ¥ —
Fid. AHIIA L X —T 2 A ADFNEFNT/ Ty b F v
TFxx& 1BIFEITLET, S+ 7T Yy OETHE, T 7
Fxrzara—XIRGEL, Ty N TTF I A EEH
LTHxF Y7 F Y 2RHEBLIOOHTE 9,

[Window] A =31 —

[Window] A==—%ffHL T, ASDMOUY 4 RURBEBEITEET, 77747780 4
FoRNgEREnzrv 4Py L TERREINET,

[Help] A= a1 —

[Help] A ==—Tlf, A>T A2 ~NLT~DV > 7 OMIZ, ASDM & ASA OfF# b It
F79, ROKIZ, [Help) A=a—%HL TETTELXAT7ZRLET,

[Help] A=2—IHH

A

[Help Topics]

HLWT 70 v Ruz2BWT, Zlo7 1L —AIZHIK,
T4 RU4, BIOHESITHEESNIE~ T 2RRL 7,
INHDOFEEEHL TEEDO R v 7O~V TF T H,
[Search] # 7 Zfi L THEBL £,

[Help for Current Screen]

FOEEICET 2R GE~N T AR X ET, 70 F—RIL,

ZORRTHWTWAHEE, XA, FRBFF AT e Ry s
ADNVT HFRRLET, Fio, BEF 2) O~VT T A3
7 Uy 7L TERRTDHILELTEET,

[Release Notes]

Cisco.com (T DIF/N— a3 D ASDM J J—X /— P %A
EFET, VU= J—HMZIE, ASDMDOY 7 h 7 =7 En—F
T =T BHEORGER, BXOY 7 by =T BT ICET S B
HEHnREE I N TWET,

[ASDM Assistant]

Ciscocom W H X 7o a—RA[RERa LT U Y ERBTE, BFiE
DX AT DEITIZETHEMMA DD ASDM Assistant % B &
iﬁ‘o

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B
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H y—pi—

[Help] A=a2—IHH

Bl

[About Cisco Adaptive

VIR 2T N=Tary N—RUzTH#HR, A¥— T

Security Appliance (ASA)] |Hplzce— R &a&nbdary 7 4FXal—Tay 77 A0/ 7 K

VT AA—TRE ASA ICHETAERERSLET, D
IR TTNY a—T 4 v T ORBRITESLSEHRTT,

[About Cisco ASDM]

VT RT 2T R—=T gy, KA., HERL L, F2L—
TAT VAT A, TANARARZAT Java DA—T g Y
ASDM [ZE8T 21 ER L £7,

W—J)L/\—

A=a2—D FIZHAY =V R—n, Ah—AEBEa— a7 4F¥Fal—YagrbBa— BX
PNE=HF VT BEa—ZT778ATEEY, £, L F 2 TF AN E—RTUVRATLE
X2 TF 4 AUTFFARNEBRNLEY, FEA—T arBLOFofM L AT 385 E

TTEEY, KORIZ,

V=N N—% L CHEITTEDL XA ERLET,

Y—ILIn—RE Y

g&

BA

[System/Contexts]

EOaryTHRANMIWDNERRILET, EXA D TFXFAL

VARNZBRSICIETRAIZ 7Yy 7 LET, a0 TXFAMDORr YT
oy VARNELICETIWIEERMEZ 7Yy 7 LEST, ZOU AR

NEBEINTWA EZIZERAZ 7V v 735 ERA 3TV =72 F
. BEFRHZ 27DV 73T 5E_RAURTICED F3, VAT AEER
THIZE, Fay7Z oy UARMNDS [System] Z38IRL F5, 2>
TXAMNEEHTLHIZE, Fey ¥y URAENLarTFH AL

ZERL £7,

[Home]

A B =T 2 A ADAT—H A, BITHOR—=Tar, T4 A
W, NI =~ ARED, ASA ICHETHEERIFEREZELRTED
[Home] XA > &R L £7, IOV TIEL, [[Home] <A (¥
VIV =R EaryTXALN)] (P3-18) B TLLEEW, v/
F E— R DA, [Home] A 1EdH VY 8 A,

[Configuration]

ASA ZF&EL £9, ZEMlD [Navigation] XA > OIEFER X % 7 U »
7 L CHERBZ R E L £77

[Monitoring]

ASA #E=% L £, EM® [Navigation] <A > OERER ¥ % 7
Uy 7L CHREZREL £7°,

[Back]

ERANZER AR LT ASDM OSA IZREY £,

[Forward]

ERTIZFRAR L 72 ASDM D2 A TS E 7,

[Search]

ASDM DHRE A B L £, MBEERIL, S~ D& A i
RTHRRBLCBHEAZRRLET, "AR—=V 7% 7V IT5
L. UL UNEEBICERRENET, [Back] 721X [Forward] %
IV 7F5HE BHELE2 0L 2 T3P0z 52 Ln
T&EFEJ, FEMZOVTIL, TASDM Assistant] (P.3-11) #ZML T
<TZEW,

[Refresh]

HAEDFETa L 7 4F a2l —2 a3 TASDMZY 7L vy 2 L ET,
72720, FE=X )T RAOT T 71X 70 v a2l FEFEREA,

Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)
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ASDM Assistant W

Y—ILnn—REY % EA

[Save] EXIALT VB ANHRERI L THFAMIRY, Ef7ar 7 ¥ =
L —ar b AX—F Ty ar7 4 Xal— gyt TRFL
£,

[Help] FORERTERRINTWDWEORWEFE~LVT 2R R L ET,

ASDM Assistant

ATFvF1

& ]

ATvF3

ASDM Assistant TiX, BFEDZ 2 72O\ TD ASDM OEH FIED LT B L THRT
XFET, ZOHBEIX, VN arTHXFANEVAT A IUTXFANDOAL—T K E—RE
O T 2T L BE—FCHEATEET,

I T 7 v A3 5I1ZiE, [View] > [ASDM Assistant] > [How Do 1?] Z##IRT 500, A==2—
/X—@® [Look For] 7 4 —/V N IZHBEEREZ AL EF,[Find] Kuey 77X v UZXK)bH[How
Do 17] #34R L TR ML £7,

ASDM Assistant ZfE 42 121%. ROFIEEZFEITL £,

[View] > [ASDM Assistant] Z &R L £,

[ASDM Assistant] XA ' NERINET,

[Search] 7 4 —/V N IZHRT H1EHREZANL T[Gol 227 U v 7 L ET,
BER EN7-E kDY [Search Results] <A VTR RENET,

[Search Results] fEE 35 K O [Features] FHIBICER RS ND(EEDOY 2727 Y v 7 L, iEflfE®
ZANFLET,

i

ART—RRX /IN\—

AT —HFAN—[ZTASDM 7 4 V' R U D FEICEREINET, IROFKIZ, ENDLHICEREIN
BHE A R L 9,

FRis Bl

[Status] a7 4 X2l —varDAT—H A (IDevice configuration loaded
successfully.] 72&),

[Failover] T 2= VA —=NR—EEBEDODRT—H AT, TIT 4T EFITAZ A
DUNT D,

[User Name] ASDM 22—V D a—H4, a—VLLhLTcal A LERE, 22—
#1% Tadmin) T,

[User Privilege] ASDM == — ¥ D i HE,

[Commands Ignored |7 A2 %27 Y v 795 L, ASDM TRE SRR olca 7 4F a
by ASDM] L—varpa<vryROURANPRERSINET, ZhbDa<wrRNid
a7 44X a2l —varpbilRshEEa,

[Connection to ASDM & ASA Ot AT — X A, FEMIZ DUV TiL, [[Connection to

Device] Device]] (P3-12) =&ML TS0,

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B
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M [Device List]

ik B7LL

[Syslog Connection]  |syslog #HfAENEMEL TRV . ASA BE=FX S TVET,
[SSL Secure] ASDM ~DF##IC SSL 2L, #e2ThDHZ &2 RL £7,
[Time] ASA TR E S VT2 REH,

[Connection to Device]

ASDM (T ASA & D#fi % & ICHERF L. [Monitoring] < > 36 X Uf [Home] <A > DT — X & fix
IR ET, ZOXAT TRy I AEHRAT —FANRRRINET, 207 4F 21—
arvEERETAEA, EHELTWAME ASDM 36428 5 — ol X, BERKDS LZF0H
BEHCETHN, COXAT Ry 7 202 DHOERIIE RSN EE A,

[Device List]

ATYvF1
AFvF2
ATFv73

2ATv74

ATvTH

[Device List] 1L R v &> A RERSXA LT, ~v X —IlH D3 DORZ L 2T NETNT Y v
7B L, RALOERKLERITEL, BB T7a—T 40T XAUA~DEFE, XA D
FELRME, FREFEA U EZALDZENTEET, ZOXSEF—L, I T 4 F a2l —

vayv, FE=XV T BV AT LAOFZEE 2 —TCHEHTEET, ZOXA U E2FEHL T,

BOTNAZIZHVEZDZENTEETN, TOTNAAATHHAEFEIITLTWHWAE LD EFRT
N— 3D ASDM BNEITINTWDIMERH D £F, XA U EBEEICFKRTHITIE, Vi<
EHL2O0DT NRAART AMIRREINTWDILERHY £, ZOX[f 0, oI ay
TX¥AR, wILF aTFANBIRVAT LIV TFARNOIL—TFT v R F—RFRBLARFT
VANRTL U N BE—RTCHEATEET,

ZORAVEMAL CHOT N A AZERT D2, WOTFNEZFEITL ET,

[Add] #Z7 U > 7 L TCTU A NZHIOT/NA Z2EBIML £7°,

[Add Device] ¥ A1 7T 0 7R v 7 ANERENET,

FNRA A EZTAAZADIP TRL A2 ANL, [OK] 227U v 27 LET,
UARNBEIRL 12T A Z&HIBRT 521X, [Delete] 27 U v 7 L £7,
[Connect] 7 U v 7 L CTHIDT /N A 2T L £97,

[Enter Network Password] # £ 7 0 7R v 7 ANRFRINET,

A=W ERRAT =R EHEYTHT 4 — /L RICASNL, [Loginl] 7Y v 27 L%E7,

Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)
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#ERs N

HBERE Y

%< @ ASDM XA T

WORIRTREZUNEENTWET, BOIEEZTZ T T2

(EN Eﬁé‘?‘éf&/%‘:?) v 7 LET,

Ray Bl

[Apply] ASDM TOEENREEZ ASAIZEEL, Ffrar 74X alb—r g
AL £,

[Save] EfTFar 7 4 Xal—ar0att—%75 v a AFJICEXA
HET,

[Reset] ERNEZMWFEL T, EHAT, E721E [Refresh] X° [Apply] & H& %I

Uy 7 LIRS OFRRERICEL F9, [Resetl 27 VY v 7 LT1-%4,
[Refresh] #27 Vv 7 L C, BIEDOEITa L7 4 F a2l —v arOiF#H
iﬁi@?éh“@ﬂé’ EERRERL ET,

[Restore Default]

BIRLTEREEZ 7 VT LTCT 74V MREICEL £75

[Cancel] EEAREWHEIEL T, fIOXA IR £7°,

[Enable] BEREIC DWW TRt AN HHOMEHERE R L 7,

[Close] W Wb E ATl Ry 7 A% £9,

[Clear] 74—V BIEREHIRL ET, £0E, Fov IRy I RELT
WL ET,

[Back] AIORA IR Y £,

[Forward] WDNA NZBEL F1,

[Help] BIRL AN EIF AT e Ry 7 2R R ET,

F—mHR—FK a—krAhvyk

F—AR—FZEHL TASDM 22— f X =T = A X% F /S —FT&EET,

# 3-11%. ASDM 2—H% A H—T7 = f 2D 3 DO EER LM 2 BE T 572D HTE 2
¥F—AR—RFK va—rhy hO—-ETT,

# 3-1 XA D FORADF—R—F S3—FHy F

BTIHR Windows/Linux Mac0S

[Home] ~A1 >~ Ctrl+H Shift+Command+H
[Configuration] ~~ 1 Ctrl+G Shift+Command+G
[Monitoring] ~~ A > Ctrl+M Shift+Command+M
~)VTS Fl Command+?
BIDRA Alt+75 5H] Command+[
WDRA Alt+£7 K H] Command+]
GNP A F5 Command+R

IR Q) Ctrl+X Command+X

T — Ctrl+C Command+C

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B
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B x—K-Foa—ravh

# 3-1 A2 D FORADF—R—F 23— FHy A (#S)

BTIAR Windows/Linux Mac0S

BL Y fHiF Ctrl+V Command+V

a7 4 X2 — g ORTE Ctrl+S Command+S

Ry T T T A=a— Shift+F10 —

vHhFY U4 RUEAL S Alt+F4 Command+W

BB Ctrl+F Command+F

BT Alt+F4 Command+Q

TNV EITTH A EROK T Ctrl_Shift F7-1% Ctrl+Shift F7-1%
Ctrl+Shift+Tab Ctrl+Shift+Tab

#3201, RAVHAEOFEF —v a NMFEHTEDLXF—KR—FK va—b by hO—ETT,

& 3-2 N HBDF—FHK—F >3—Fhw F
T7+r—hRDOBHE x—
DT 4 —/VF 27
BT 4 —J)UR Shift+Tab
WDT 4=V K (T—TNVHNIZT +—TARNDH Ctrl+Tab
L5%8)

BT 44—V (FT—TNVHNIZT7 +—DANRH Shift+Ctrl+Tab
L556)

WKDHET (BTN T 5 —HANDHDHHEE) VEPNE]
B2 7 (27N T7 +—H ANDLHBE) FERH]
F—T ILNORDE L 27

T —7 IVNOHTD &)L Shift+Tab
WDNRA Y (BEDOS_A U PNERENTVDHE)  |F6
AIDNA Y (BEOXA U REREN TN DHEA)  |Shift+F6

7% 3-3 1%, Log Viewer CEH T 5% —FR—F va—br Iy hO—ETT,

# 3-3 Log Viewer DF+—iK—F & 3—F A v F

B & Windows/Linux Mac0S
Real-Time Log Viewer O —WRH{Z 1L L OB |Cul+U Command+

as RNy 77 XD T ya F5 Command+R
NEEa 7 RNy 7 7 DIEE Ctrl+Delete Command+Delete
BINL7zn s = MY Oab— Ctrl+C Command+C

v 7 OIRAF Ctrl+S Command+S
=yl Ctrl+P Command+P
EHhoFY) U4 R TEHL S Alt+F4 Command+W
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£<{DASDM RA > comzee N

#3413, A=a—HH~OT 7 EBAIFEHTEEXF—AR—K va— Iy FO—ETT,

% 3-4 AZa—BERICFOERTEEDDF—F—F >3—FHvF
VA VS | Windows/Linux

A= a— N— Alt

RO A= 2— A RH)

D A= =2— Ve =1
RDOA=a—FTav T 4E

AIDA=a— AT gy ERED

BN A= —F T av Enter

% < D ASDM R A1 > TOIREHAE

—HRD ASDM XA 2%, 2L DEFREFSOT—TANEENTWET, Hroor U &2
HICKMRBIOWMAFRRL TRETH7-DI12, B ASDM XA 21X, 215D A L ND
F TV M ERBETEDIRBEENSEINTOET,

MBEETTHHEAE, [Find] 7 4 — AV RIZTZL—X%ASL, FEDSAL L NOTRTOH
TAERBTEET, 7V—RAZEFIANVREDI—RXLFD ] BLR 2] 25052 ENT
TET, T 1 OUEOFE—HL, VITEED 1 XFE L ET, [Find] 7+ —/V KO
Wb b ERATE TREVEMEHL T, & (F) 721381 (F) 7L —XOHBLUIBEIL £7,

[Match Case] F = v VR 7 2% A 2T 5 &, AN LT RIFIR X OVNCFITEMIZ B
L U ERBLET,

7oL 2 B¥ton-L* EANTH L RO —BBRRSNLET,

Boston-LA, Boston-Lisbon, Boston-London

Bo?ton & AT H &, WO—HEPEINET,

Boston, Bolton

WD Y AR, BREREE M TE 25 ASDM A v &R L £,
¢ [AAA Server Groups] =1

e [ACL Manager] ~<A > : [ACL Manager] <1 » ORFEFEREIX, LD~ A > DORFRERE & 1T R
720 F9, FEMIZOWTIEL, [[ACL Manager] ~<1 > ORSEEERE ] (P3-16) &ML << /2
Sy,

¢ [Certificate-to-Conn Profile Maps-Rules] ~ 1 >
DAP] ~<A >

Identity Certificates] ™A1 >~

IKE Policies] ™A1 >~

[
[
[
e [IPSec Proposals (Transform Sets)] <~ >~
[Local User] ™~ >
[Portal-Bookmark] <=1 >
[Portal-Customization] - >/

[

Portal-Port Forwarding] <~

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B
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W [ACL Manager] R 1 > Q&R #8EE

CA Certificates] ~X A1 o/

Portal-Smart Tunnels] X1 >

VPN Connection Profiles] ~-1 >/

[
[
e [Portal-Web Contents] X1 >/
[
[VPN Group Policies] = >

[ACL Manager] R 1 > DR FEHEHE

ATYF1
ATFvF2

ATFv73

ATv74

AFvTH

& ]
AFvF1

ACL BEX O ACE LIS ES ERF AT DEZHOBERNE EN TS, [ACL Manager]
AV DIRFRBERETIL, MDA DMBEHEL D b RARERKSToRBEEITTEET,

[ACL Manager] <A W TERZZMRBET HIZ1E, ROFIEEZFEITL £,

[ACL Manager] <A > C [Find]| #7 V v 7 L ¥7°,

[Filter] 7 4 —/V R T, KRy 7 X0 URARNNLIROAL T arONTnERIRL £,

e [Source] : RRIZIX., "N T T 4 v 7 EHFAELIIEGTI2EETLORY NI —F TV x
I ITN—TDIPTRVA, [ X =TT A ADIP T KL A, FZZOMDOT KL A
NEENFET, ZOTRLRAFIAT Y7 4 TIEELET,

e [Destination] : MiZZIZi%, [Source] EZ7 2 a IV AN ENTWAIPTRLA~D KT
T4y I OEFEHFANELIFERINTODEEIP TRV A (FRAMERIIRY hT—
7) WEENET, ZOTRLRFIAT v 7 4 THEL £7,

e [Source or Destination] : MR IZIX, BEILEITFILONTNNOT KL ANEENFET,
ZOTRLVAFIAT 7 4 THRELET,

e [Service] : BERIZIX, V—E R TN —TF FEHITHFMERHEADOT—E AR =08 FhH
¥4, N0 —E R TAT Y S 4 TEELET,

e [Query]: Ky 7 Xy URARN5 [Query] ZIRT H5A1E, [Queryl 227 U v 7 LT,
RO 4 5DFT XTHOA T 9 ([Source]. [Destination], [Source or Destination], L
[Service]) IZ L Dt EH/TEL £7,

2EFHDOTZ7 4=V KT, FayZZo UZAMNRLROWTNIOL TS g 0 28I $£17,
o [is]: AT v 4 TCANTIHEEMIKTDmE—HKEREL £,

e [contains] : AT v 7 4 TANTHEMEGTen, TIIZIRE S 72V ACL £721% ACE ©
RBEEREL £7,

3FHDT 4 —/LF T, H#%ET 5 ACL £721% ACE (B 5 BAREY 22 502 A1 50,
[Browse] %7 U v 7L TCACL £/2IXFACED a7 (X a2l —a IR ATEAREREL R
//E"Fi:]\/\ij_O

MR A& EITT DL, [Filter] #27 Vv 7 L £,

ASDM DR FHEMEREIC L Y . HEEL 72&H 251 ACLB X WNACED Y A M NIRENET,
BMHESNTZ ACLBEIWNACEDY A&7 Y73 5I21L, [Clear] 27V v 7 L ET,
RWIx]EZ 27Uy 7 LT, REEEX AT R Ry 7 2% £7,
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BERIY—> Y—F 4HR— D, x—T it B

WERRA D) —2 ) —F B R—r DA R—T Lk

2Ty 1

ATFvS2
ATvF3
ATv74

T 74/ KT, Tab ¥ —%#HL TRXAUHEBEIT L & X2, TV ERBIEY 7 OBt
MO SNET, JAWS DL R—FHOA 7 Y —> V=KX, 7+ —HADHLHMEAT
V2l NI EFHAHALETET, JEEAZ V=2 V—HF B R—EBARX—TNIZTDHE, TN
WVEBHICS ¥ T EBEIS L LR TEET,

WA 7 ) =0 V=& B R—=F 2 A R2—=TNVICTBI20E. ROFIEEZFEITL £,

[Tools] > [Preferences] ZER L £9°,

[Preferences] Z A 7 0 7 iR v 7 ANFRINET,

[General] % 77 @ [Enable screen reader support] = v 7R v 7 A& 4L £,
[OK1 %27 Uv 7 L¥ET,

A7V = V= B R—= E2T 7T 47129 2I21%. ASDM # HEEL £7,

BIERI ALY —

A 7 4FXal—Tary bPa—BIRE=X) L Ea—DFEFr—Tary A4 UIE5EN
H—HOT7 AN, BEST a7 a2l —v gy R URE=Z VT XA
UNBHY ETA, INHDOTFAFIE, BMETSIa T 4 X2l =gl FAITRE=H Y
BRI BT AOIENLET, ChoD 7+ EE2 2 )y rT 58 A0
[Navigation] XA NIV T7IHEO Y A NBRERSNET, YTHEOA4HEZ Y v 735 L%
DIHBIZBEICE £,

AT 942 F9IZDUNT

EREREZ TG T 5121, ROFBIZVARMENTWE, F4T5R2 %27 v 7 LFT,

Ray SRR

[About ASDM] ASDM ICRHT 2 EHRER L ET, FAN, XN—=Va &K, 7T/
AARABAT . ASADY T 2T N—=T g 0FK5, HEELUL, 22—
Y FHTAFTR—F 4T VAT AREREENFET,

[Search] FoT A ~VTHANOEREBRL £,

[Using Help] T T A ST O IR IRFEHFIECONTHAL £,

[Glossary] ASDM B L TNASA THHSNTWHIHEED U A M ZRRL £7,
[Contents] HRAZFRRL ET,

[Screens] VT T ANDY A EBHEOAATS LICERKRL T,

[Index] ASDM DA T A2 ~IV T D~ VT HE DR KR L £,
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B [HomelRAY (VUL E—FETUTHRF)

[Home] RA Y (0TI EF—FKEQAVTFERRN)

ASDM @ [Home] XA > Tld., ASA ICEHT2EERFE®REF "L £9, [Home] XA L DAT—
2 ZERIT 10 BB CTEF SN ET, 2D 213 H . [Device Dashboard] & [Firewall
Dashboard] @ 2 2D Z 7 03%H 0V £9°,

IPS BV 2= AR CX EVa— VDL RN—F Y =27 LBV T V2T OEY 2—ABNT
NARZAV A D=V ENTVDLEE, TRoDOEY 2 —VHICHIO X 7 NERIRSNET,

[Device Dashhoard] & 7

[Device Dashboard] # 7 ClL, A v X —T =2 A ADAT—F A FITHONN—Tary, T4k
VAER, NI = AR E | ASA OEBERE —H CTHRTEET,

3-2 12, [Device Dashboard] ¥ 7 D EFE #RL 7,

5 3-2 [Device Dashboard] % 7'

Cisco ASDM 7.1 for ASA - 10.86.118.2
% configuration (] Monitoring | (i) save (@ Refresh ) Back ) Forward| 9 Help

Device List & ” Hame.

4% Add ] Delete & Connect L) Device Dashboard- ) fucuall Daslggacdy

Device Information Interface Status (—@
@ License  ASA Cluster Interface IP Address/Mask Line Link. Kbps

management  no ip address @ down @ down 0

il
Cisco

management2  no ip address ® down @ down 0
= 10.86.1185 HELALD e outside 10.86.118.2/22 @ up o up 7
Biosc1iks ASA Version 100.8(40)34 Device Uptime: 10d 1h 42m 14s
= 10.86.118.12 ASDM Version: 7.1(5)13 Device Type:  ASA 5585-55P-10
 10.36.118.13 Firewall Mode: Routed Context Mode: Single
2 10.86.118.15 Environment Status: % 0K Total Flash: 2048 MB
5 10.86.118.19
= 10.86.194.44 Select an interface to view input and output Kbps
.86.194.
i 13 i: :za T:e VPN sassians Traffic Status < : )
B4 riae523 IPsec: O Clientless SSL VPN: 0 AnyConnect Client: 0 Details Connections Per Second Usage
= 10.86.194.225 System e i
B 10.36.154.252 Total 9 Total CPU Usage = Core Usage  Details
= 10.89.147.142 - S
& 10.89.147.144 Memory Usage (MB) " L
8 10.89.147.152 [ 6,000 1 1711 17z FEXT) 1714 1715
5 10.89.147.156 —_ W UDP O M TCP. O M Total: 0

171.69.42.239

: 172.23.3421 4000 ‘management2' Interface Traffic Usage (Kbps) (—@
e 1

B 172.23.34.136 3,000

1487ME
= 172.23.204.21

8 172.23.204.32

= 172.23.204.51 1000 0l H : L ]
8373 a066s | 756 357 7358 359 w0
& 172.23.204.67 17:15:17 11 1712 1713 1714 1715 M Input Kbps. B Output Kbps.

= 172.23.204.73 |

= 172.23.204.155 000

=1 172.23.204.168 [Severity Date Time
= 172.23.204.169 o i

& 172.23.204.188
= 172.23.204.197
8 172.23.204.221
& 172.23.204.231
= 172.23.204.241 : Y "

# 172.23.204.242 6 Oct24.. 17:14.. 106015 10.19.36.104 52... 10.86.118.2 443 Deny TCP (no connection) from 10.19.36.104/52528 to 10.86.118.2/44:
B 172.23.204.243 L6 Oct24 ... 17:14. 302014 10.19.36.104 52... 10.86.118.2 443 Teardown TCP connection 1554 for outside 10.19.36.104,/52528 to iden
17233704 244

2,000 g o
Fpan e Interface is down.

Latest ASDM Syslog Messages
Syslog 10 Source IP Source Destination [P Destini Description

wfml~| |

FOOOOO®

0825

Device configuration loaded successfully. docs. 15 o= & 10/24/13 5:15:17 PM UTC (V,\,J

R

GUI EFH B
1 [[Device Information] ~<- > ] (P.3-19)

.'E-EI;

[[Interface Status] X > | (P.3-20)
[[VPN Sessions] ~<A > | (P3-20)
[Traffic Status] ~X1 > ] (P.3-21)

Al w]|
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[Home] R4 (o5 L E—FEavFEzE) M

GUI E% BT
5 [[System Resources Status] 21 >] (P.3-21)
6 [[Traffic Status] ~X- > ] (P.3-21)

[[Device List]] (P.3-12)

[[Latest ASDM Syslog Messages] X > | (P.3-21)

[Device Information] X 1 >

[Device Information] <X > {Z1%. [General] % 7 & [License] ¥ 7 &£\ 9 T34 AMEREFTRT 5
2O0DXTNHY £9, [General] ¥ 7 TlI, v AT L ~LVAN—H Thh 5 [Environment
Status] R ¥ T VB RATE £7,

[General] 47

ZOETITiE, ASA ICETAERERNPFERINET,

[Host name] : /3 A ADKRA M2 FERL ET,
[ASA version] : T/3A A ETEITENTVWDASA Y 7 b =T DNR—V g wHRKRLET,

[ASDM version] : /34 A L THEITENTWVWAEASDM V7 h U =27 DONRX—=T a B FRRL
i‘j‘o

[Firewall mode] : 7 /3A ANRFE[TINTWDTZ 7 AT U 4—)V T—REFR L ET,
[Total flash] : BI{EMFH &N TWVW5 RAM O& 2 ERL £,

[ASA ClusterRole] : 7 T AX VU TN A F—TNDIGFHIL, ZOEBEOOT—L (Z AKX —
FTIFALV—T) BRRLET,

[Device uptime] : HZICY 7 vV =T %27 v 7o —RLTHL, T/ ABEEL TV 5D
REff 2 Ron L £,

[Context mode] : T /XA ANETENTWNWEILTHFAN T—REERLET,
[Total Memory] : ASA |{ZA > A —/LE LT % DRAM %#FE/RL £,
[

Environment status] : ¥ A7 A ~LVAZERRL £, ASA 5585-X |%. [General] # 7 D
[Environment Status] 7~ /VOEMPICH D7 T AEHE (+) 227 Vv 735 &, RUATRER
N=R T 2T O HOFFEREERRL £T, REBSN TWDHEREEROHE., 77
EEREY 2 — VOBEWERT — X ADBHF, 3L CPU OIRE L 2T Ao JE PHIRE DB
xS T CE ET,

—#%1Z. [Environment Status] ;R Z > TY AT A ~NLAN—HThMHhD) £, 2T LAHND
FoARBOTRTON—FR T =T 3R —3 b BDIEFRFEHANTEEL TW 554,
7T AT () REXEEERTROTERINET, —FH. "—FRv =7 AT 4
WO R —3 831 OTHIEFRFGHENATEHEL CTW2EEIT. 77 A5 (+) AHF
UBREDIIZIR ST I VT 4 AN AT =A% R L, N—Ry=zT arRK—xr MIH
LTIz BETHLZ EERLET,

BrEDN—F 7 =7 OMHBFRICET MOV TIE, TOTANALAADNAN—R T =T H
AR EZZRL TLEEW,
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B [Home]RAY (VTN E—FEAVTFERER)

~

GE) WHVU—RADASAILT v 7 7L —KRT5700AF)NAEL THDHEHEIZIE, [Memory
Insufficient Warning] % 4 7 2 7R v 7 ANRKRRENET, ZOX AT TRy 7 AR RIN
HFRICHES T, AR—F ENTWD F1ET ASA BL TN ASDM Ziflkf: L T L £9°, [OK]
77U LT, ZOEATal Ry 7 2A%2HL £7,

[License] 27
ZOXTITE, TARVAKREOY Ty BERRINET, BT A AFROEKTE
TEH L WT 7T 4= 3 F—DANSIEATH 1ZI1L, [More Licenses] 7 Vv 7 L £7,
[Configuration] > [Device Management] > [Licensing] > [Activation Key] XA ' BRI N FE T,
[Cluster] 40

TDETNE, VTAEDA L A =T 2 A T—RFRBIRT T AIDAT—H ANFEREINET,

Device Information

General License

Cluster Interface Mode: Spanned EtherChannel

Cluster is not enabled.

Details

[Virtual Resources] 27 (ASAv)

TR T, ASAVICE o THHAEN TWAIRBY vV —2anFERrENET, vCPU D,
RAM, ASAv D7 B b a = VT OBAERNESENET,

[Interface Status] X 1 >

ZONRLNE, BAVHE—T 2 A ADAT —HANERENET, A0 X —T =2 A ADIT%
BRTDHE, ANNBLOH I ALV—T"y F 23 Kbps AL TT —7 VD FIZRRENET,

[VPN Sessions] R A1 >/

ZDORANZIE, VPN F U R AT — A ARFRENE T, [Details] 27V v 735 &,
[Monitoring] > [VPN] > [VPN Statistics] > [Sessions] 1 ZBEIL 7,

[Failover Status] R A >/

TONAUNTNT, T 2= F— R — AT —FANEKRINET,

[Configure] % 2 U v 7 L C, High Availability and Scalability Wizard ZE& L 9, 2D 7T ¢
YP—REZRETTHE, TJo—F—R_R—ar7 X2l —1 g3 AT —HXA ([Active/Active]
F 7213 [Active/Standby]) NE RSN ET,

Tz V= N—REREINTWVBHEGEIL, [Details] 27 Y v 79 % &, [Monitoring] >
[Properties] > [Failover] > [Status] <A > 230 & £ 7,
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[Home] R4 (o5 L E—FEavFEzE) M

[System Resources Status] N o >

ZORAIZE, CPUBLOAEY ORI T A HEHERDBFTRRINET,

[Traffic Status] R 1 >
TORANNE, A F =T = A ARKOWBEMOERE L, EF 2T 4 Pb RV
BT o2 AADNT T 4T AN—T NDIT T IRERINET,

I T 4 X2l =T a il EX a2 T4 LARRELENA A —T o A ARERESENTE
D, ZOWTNNOLFIN Toutside] THILGH, TDOA L EZ—T 2 A ANRNT T 4 v 7 A
N—T NOT S 7IHERENET, ENLSNOEE. ASDM iZEX =2 U F 4 LARESLIE
WAL E—=T oA ADT VT 7 Xy MED U A NDOERPIOA X —T = A A% @IRL £,

[Latest ASDM Syslog Messages] R 1 >/

ZORA U, ASADERLTERBFOY AT A Ay =N 100 HE TR RESNET, vF
VITINT 4 =T e o TV D AT, [Enable Logging] #7 U v 7 L CA Rr—7 ML £7,
3-3 12, [Latest ASDM Syslog Messages] <A > D #HFE &/~ L £97,

& 3-3 [Latest ASDM Syslog Messages] N1~

Latest ASDM Syslog Messages

| Severity | Date Time Syéiog 1D . Source IP Source Destination IP . Destiné Description

| 6 Ock 14 2009 |17:54:47 302021 feB0::214:6aff... |0 Ffo2::1 0 Teardown ICMP connection For Faddr fe80::214 | |

. i 6 Oct 142009 17:54:45 302020 feD::214:64ff.., O ffo2::1 0 Built inbound ICMP connection for Faddr feg0::2 O(}

: ] Ock 14 2009 17:5%:42 302021 feB0::20b:Fcffi.., O fro2::1 0 Teardown ICMP connection For Faddr fe80::20b[, | ’ g
[ m L Bl S

Rk

GUI &R ExEA

1 NRADOYAREERTTHINE, TANRNAT 2 LFELITTFICR T v 7 LET,

2 NAVEPRLET, XA ET 74N O YA XCRTICIE, ZEOEFRFE
DTAarw7 )y 7 LET,

3 Ta—=T 4T NAVEERLET, XA B Ry X THITE FyF
VI LTeRAy T AarE Yy 7 LET,

4 HEFERREARX—T AN EIEZT =7 ML 3, HEBFERRN A X —T
VIR AL, £ TRBIZH % [Latest ASDM Syslog Messages] AN % > ® B2 —
NEBEITLHE, NAUNETRINET, =YV~ Unbiid &, ~A
NIRRT £,

5 RAVEHAUET, XA EFRRT HITIL, [View Latest ASDM Syslog Messages]
ZEIRL £,
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[Home] RA > (YU ) E—FEAVTXRF)

GUIEH

%II‘:

BA

feATL £

FRZH DT A %70y 735 E, syslog Ay E—YDRROLH %

EIEL 7,

FHZHLRNT A2 %20y 735 E, syslog Ay E—YDORRFOEH %

T ET

HHCo D7 4NE T A% 7Yy 73 %L [Logging Filters] ~ 1 > A5

AR NEFHZ Y v 7 LT [Clear Content] Z3&ERT 5L, MED Ay -V 2HEL T,
ARV NEHZY 7 LT [SaveContent] 27 Vv 735 L, BED Ay E—T% PC LD

77 ANVIERIEL £97,

AR &7 Y w27 LT [Copyl iIRT 2D L, BIIEONEEZaE —L 7,

AR NEAEZ Y w7 LT [Color Settings] % i®INT 5 &, HEREIZHK ST syslog A~

=Y oEEALAHIRAEERL FT,

[Firewall Dashboard] &2 7

& 34 [Firewall Dashboard] # 7'

& Cisco ASDM 5.3 far ASA - 10 B&,54 BB

[Firewall Dashboard] # 7 ClX., ASA #9577 4 v 7T 2 EEREHREHR TS E

T ZOXyYaR—RE, oIV ar7X¥ AN F=RELEIvATF a0 THFAN E—ROD
EBLLTHLIMNCEVELY FF, v VF 2 FF A~ ®—FK Tid, [Firewall Dashboard] (345 =
UTFXFAMNAICERTEET,

3-4 2. [Firewall Dashboard] % 7 O EFZED—F &2~ L £,

Fili Vim Totls ke Whcs Hap

o |y ot || et | e Qe Qe )

! Jhnh.
T e I cisco

HI

"
4 [ T ———)
a
L ]

[

-

S
i oaE ol 1 i

W Car=rrern: ] W FA Doy 0

et Pty s
=-

L |
f|
a i
T L
- - waw - e ®
—— e e~
AL Ewpemt 0 B racomen Dot 0
Farven T v T S B
: | i |
| o T T
wad b i d
.'mi.i e R TE T

I e Al B e 0

T YT 3 )

T a0 | "o | Soweoms | oo L Dvmdimtinss. Ty 1 Lbany
e ] Lo

T T {0 i st v o lishioed o i i il i
Pl G, W b 3 sl LAl

ey e [= ] |l i 0 qn.-:ﬁj
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[Home] R4 (o5 L E—FEavFEzE) M

R

GUI EXR E L
[Traffic Overview] < > | (P.3-23)

[[Top 10 Access Rules] ~X1 > | (P.3-23)

[[Top Usage Status] ~<1 > ] (P.3-23)

FoReL) [[Top Ten Protected Servers Under SYN Attack] X1 > ] (P.3-24)
For7e L) |[[Top 200 Hosts] ~1 /| (P3-24)
FHoRp L) [[Top Botnet Traffic Filter Hits] -~ > ] (P.3-25)

~|~| ~]| W N| =

[Traffic Overview] R A >/

T7HNETIE, AF—T VT, EREBEMRMNET 48— NMICTDHE (7 AT U 4+—
a7 44X alb—ary TAREZSM) . ZOMEKICZIE [Enable] R U BNER RS NET,
[Enable] /R % > &M L CHREAZBEMREZ A 2 —7 VI TE 9, EITRHORERICT, £
INBHDOIRDIERMPE N FET,

o HEfIE L NAT ZHis,

o TIUEBAVANMNILDHEREBLIOT )V r—vary AV AT g llo TRy /&
NI= Ny N EURD,

e Fuvw 7 hry N, ZHid, AXF ¥y WEO—HE L TEHEEINLIES L. K2R
tyvart L THHENSES (TCPSYN WEBELT — %7 L UDP kv a v HWEE K
HLESE72E) "b £,

[Top 10 Access Rules] R >

FIZHNLNTIE, A FZ—T LT, T8RN LOBEREFKEERET + E—T 10
HE(T7AT U F—ar7Z 4 Falb—ar TA4AR%E25MK), ZOHEIZI [Enable] 7R ¥

VINFEIRENET, [Enable] RZ U EMEHL TT 7 v A V—LOKEHEHRE A *—T MIZT
FET,

TN Ea—TiE, VANDPOBAL—EBIRLTEZ V7L, Ry 7T v7 A=a—IH
H® [Show Rule] # R/~ TX 9, ZDOIHEHZHEINL T [Access Rules] 7—7 MIZBEIL, T—
TIARNICHDHFDNL—LERIRL 1,

[Top Usage Status] R 1 >

FI7FIVETIE, TAE=TNANTT, ZOXLUICE, RO 4ODXTRH Y £7,
[Top 10 Services] : BB H ¥ —E &

e [Top 10 Sources] : &ty —¥ &
[Top 10 Destinations] : & @& 4 —¥ X

e [ToplOUsersl: 7TAT Y7474 77 A7 U+ —/L ¥ —E X

B®HID 3 >DH 7 ([Top 10 Services], [Top 10 Sources], 33 L O [Top 10 Destinations]) TlE, &
BRI — e AT A MEHE R AR L £5, £¥ 7L, ENETNOEEHRHY—E X%
AR —TNWIZT % [Enable] R¥ U BHVET, 77 AT U r— a7 4 Fab—var A
RiZHE-» T, INBEARX—TNICTHI ERTEET,

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B
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[Home] RA > (YU ) E—FEAVTXRF)

[Top 10 Services Enable] R % T2 L, A—h &7 v b a/LOEHFOMFHERS A *—
TR ET (L6 RFHICAR—TNMITTHHENRH Y £77), [Top 10 Sources] A ¥
> 3 X O [Top 10 Destinations Enable] AN % 325 & | A N OREHERD A X —T VT
DET, AAM GEEIRBLOSEE) O i EHAT —Z ZHEHEHR, BLOR—K &7 m
INANBRRINET,

4FB DX T [Top 10 Users] Tlx, 7TAT VT 4T 4 77 AT 74—/ P—E RET D HE
HRERELET, 74T T 474 77 AT 04—V F—EATE, 2—HFO7 A7
TATACEST 78R avbr— Va2 L £, #EILIP TR L 2ATIEAR2—¥4
Lo ST RICHESNTT VA =L e eFa T 4 R LV — 2R ECTEET,
ASA T, IP La—HY D<oy BT F—=FRX=AZT7 7EAL T, ZOF—E2&HL E4,

ASA T AT U T AT A4 T7AT T3 —)L P —EREZREL TWBEHEE (Microsoft Active
Dlrectory %‘ Cisco Active Directory (AD) TV MNREDOBNa R =R NORTEEE
o) | . [Top 10 Users] # 71T —# BRRINET,

iig?ﬁbf:ﬂ‘7‘/ 2 I U T, [Top 10 Users] #Z 712, AL 10 =—H D3{5 L7 EPS /X7 > k|
EELZEPS Ny b, BLUOEEINTZHEIC Fﬁﬁqéﬁﬁfﬁiﬁﬁ‘%ﬂ“éﬂi'f
(domain\user_name & L CHRRIND) £2—FICEHL T, Z0XT7IZiE, £Oa2—FDEY
EPS X7 v~ BIIEO EPS N7 v b FUH— BIXOGIH ANV MR ERENET,

HEHERE A R—T NN TH E, A FZ—T NI L TFEEHERO Z A 1250 T, ASA DO/R7 3 —
TURACEETHIERDY ET, RANOREHEREAR—TNICT DL, RNTxr—< U R|Z
KEREENDHLVET, b T 74y 7OAMNEWVESIE., TOX A7 OFGFHERIT Rz A
F—T T DHZEERPIL TLIEEW, 2770, N—bhO#HiERE A r—7 ML TH, £
EEHEITH Y XA,

[Top Ten Protected Servers Under SYN Attack] < 1 >

FIZFN T, T4E—7 VT, ZOFEBICE TSN TS [Enable] R &2 fEH L T,
COMEEEA X —TNMIZTEET, FHE, 77 A7 U ar T 4 FX¥alb—Tary A
RIS TAR—TNICTHI EHTEET, WBEZ T CTRES L EAL 10 — O
‘F‘%i&bﬁ%ﬁéﬂif

WL — N OBA, ASA IV —MHERE (G734 M 304) LT3R LT —4
A /7 L‘i?‘

BEOBBEZ N NDE 1L, [<various>] DRZRICHRKEDOHEEFEDIP 7 KL ANKRRINET,
[Detail] # 7 U v 7 LT, 10 BEOY =715 T, T_XTOH—sN (FLK 1000 &) OFEHE

%&%i@rbi% JBIEY TV T2 EHERTHIEL TEET, ASA ;tl/ I fH b
WCIBEIMEY 60 BV 7 U570, F 7 +/L 8D 30 5 TIiE 60 B LIk EHERM UL

gLEhET,

[Top 200 Hosts] R 1 >

T 7 AN TIE, T 4 EB—7 0 TF, ASA BRI CTHRt S iz B4 200 DF A R EFRRFL 7,
RA L DHT R VITE, Txb@m?bvxk A BT K - TG S Bkt OB E *
A, 2O R VIE ROV LTy I TS hET, ZORREAX—TNMTT HITIE
hpm topnenable = ~ >~ Fé”]\ﬁbiﬁ‘o
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[Home] RA> (v T L E—FEavTERE) A

[Top Botnet Traffic Filter Hits] N o >/

TI7HNETIE, T4E—=7ATY, ZOBEBIIE, Ry Xy b 8 T7T7 407 T4V 5%
RETDHEDOV IR GEENRTWHWET, L 1I0HORy FRy kA4 k. R—F, BIW
YR AN DLUR—FE, T—ZDAF v F gy M ZREEL, HEHEROIERBLUED
10 EHBIZ—HLARWEAERHY 9, IPTRLRAEZA27 Y v 745 L, whois ¥V —/LNEE)
LTRy bRy b A MOFEMRFRINET,

FHEAMZONWTIE, 77 AT U4 — a7 4 Xalb—vary FAREBRL TLIEEN,

[Cluster Dashboard] & 7'

[Cluster Dashboard] # 7 \Zi%. 7T AFD AL NR—=2 o F LV —2fFHROY <V —RNER
SNET,

Resource Utilization

i Ml IP Add | |‘|r i Upti Erivii Health
Device Mame ‘ nagement ress Role Ersion | prime AVIFONMERT STatus ealth Starus L Used Memory
clsl 172.23.204.243 MASTER 100.8(0.94) 2d 15h 56m 49s = r )| .
FAIL 2 [ e
2001:b0b:6500:3 | E—EEAL| T Unknown | e ol

5 R 5 Traffic Statu:
Average CPU Usage (percent) Throughput Load Balancing [ _|

100
a0 Cluster Overall
80 z
70
60
50
a0 ]
30
20
10 a i

_— [i} = —— " —
JE: 1100 D07 808 0808 OE:10

1%

007 .08 0509
WMUDP. 0 ETCP. 0 M Total: 0
Owerall Memory Usage (MB) Par MerabesTotl
500
450
400
350
300 i
250
200
150
100 0 -
50

2

0807 08:08 080 0810 0811
Wcisl: 0

i ; - - g
18:11:0° DE-o7 0808 0&.08 D&:10

[HT

e [Cluster Members] : 77 7 A X Z T 5 A L N—D4HT & FEAREHR EEIP 7R L X,
N=Tay JITAZNOR—LRE) BEORRAUNRNR—=D~NVA XA T—H A (REAT—
HA ANV ART—HRA BIRY Y —XEHER) 2R R-LET,
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Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)

[Home] RA > (YU ) E—FEAVTXRF)

~

GE)

<)LF aLTFHFAN BE—R T, oL T% 2 M ASDM Z 8L . IRICHID
AVTEFARMAEL TS, UAMRFSNTWLEEIP 7 F L AFHEO= T
FAMOEHIP T RL RACETEINEHEA, ASDM NEIEHEHG SN TND A A
JFAADIP TR AZEGREHa L THFAMDEHIP 7T RL 2%, Jl&fmaR
RLUFET ET,

e [System Resource Status] : 7 7 A XKD Y YV —2fFHE (CPUKLORAEY) LT
T4 IDTTT (IVIFTAABERBILOTNNART L) 2FRRLET,

e [Traffic Status] : & & 7 ZIIRD T T 7083 H 0 £,

[Connections Per Second] % 7'

[Cluster Overal] : 7 7 A X RO BN OB NERINET,
[Per-Member Total] : 45 A > 73— DR ENL DRI BN R R SN ET,
[Throughput] ¥ 7

[Cluster Overall] : 7 7 A Z 2KOKREH NI AN—T"» N BRRRZNET,

[Per-Member Throughput] : A2 /R—D A)L—T"y h ¥, AU NR—=T LI 1{TFOERE
j/bjz—d’_ﬂo

[Load Balancing] # 7'

[Per-Member Percentage of Total Traffic] : A N—WNZFELIRITAY NTT 47
DENEGNR, A NN=TLIZEREINET,

[Per-Member Locally Processed Traffic] : = — W /VIZABLE = b T 7 4 v 7 OFEIG M,
AUN—=TLIZRRENET,

[Control Link Usage] % 7
[Per-Member Receival Capacity Utilization] : Z5EFEDOMHE RN, AL N"—T LIZER
SNET,

[Per-Member Transmittal Capacity Utilization] : SZE & ®EDOHEHEN, A =T LTF
RENET,
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[Home] RA> (v T L E—FEavTERE) A

[Cluster Firewall Dashboard] 2 7

[Cluster Firewall Dashboard] % 7 (214, [Firewall Dashboard] {2 /RSN AFHREFEEDO N 7
T4y 7 OBELIO ltop N] MEHERPFRRINETR, 77 AXL2KRIZOTEDRFHITFRR
INFEHA,

Connection Statistics

Interval: | Last 1 hour +  Based on: Packet HitsDisplay: | Tab

4

The Top 10 Access Rules feature is disabled in the Security Appli
1 Please click the button to enable it.

| Enable

0
0807 0808 0809 0810 D&:11
M Connections: 1 M NAT Xlates: 0

~Dropped Packets Rate

The Dropped Packets Rate feature is disabled
in the Security Appliance.
Please click the button to enable it.

Top 10 Services Top 10 Sources > |

Interval: | Last 1 hour + | Based om: | Packet Hits 3 [

“Possible Scan and SYN Attack Rates —

The Possible Scan and SYN Attack Rates : . o A
feature Is disabled in the Security Appliance. The Top 10 Services feature is disabled in the Securi

Please click the button to enable it. Please click the button to enable it.

|m| Enable

CiscoASAV ) —XASDM a7 4 ¥alb— 3y HA4F (—BNGEE) B
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[Intrusion Prevention] & 7
[Intrusion Prevention] % 7 Cli, IPS (BT 2 EHERE M AR CTEET, ZDOHX 71X, ASA I
AV ARN— L ENTNAIPS TV 2 — A RBbHEEAICOLERINET,
IPS &Y = —/VIZHEET D I2IE, RO FIEEZ EITL £9°,

ZXFwF 1 [Intrusion Prevention] # 7% 7V v 7 L £,
[Connecting to IPS] X A TR ViR v 7 ANRFREINET,

Connecting to IPS...
ASDM will make a new connection to the SSP=IPS module in this ASA system.

ASDM makes a separate connection to the IP address of the management port
on the 55P-I1P5 module.

S5P-IPS Management IP Address: 10.89.147.143 Port: 443
Username:
Password:

| Sawve SSP-IPS login information on lecal host.

“Password cache is encrypted. Use File > Clear Password cache menu to clear it.

Y s Y 'S 2 Ny
Help Cancel Continue
- Yy - .y -

255100

2AFyF2 IPTRLA,  RA—b, a—VF RNRAU—FZANLET, T74VEDIPTRLABLIDY
A— ML, 192.168.12:443 T, T 7 4V s Oa2—HFLB L/ AT — R L, cisco & cisco TT,

AFwF3 vl A UtEHRE v — BV PCIZIRTFET H1ZI%, [Save IPS login information on local host] F = > 7
Ry 7 A&F L ET,

AFv7F4 [Continue] #7 VU v 7 LFET,

Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)
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RABHEICEET %

LTLEEN,
3-5 12, [Intrusion Prevention] # 7' {2 & % [Health Dashboard] ¥ 7 DZEFE Z R~ L £7°,

& 3-5

ZEHZOWVWTIE, 77 AT U4 — N ar 7 4 Xal—ay HAREHHR

[Home] RA Y (VTN E—F EQVTFHRE)

e

[Intrusion Prevention] # 7" (Health Dashboard)

= cossonsziomn w0 ¢ 1 | | _______ _ CEX

Fle ¥iew Joos Wierds Window el

Lo |k For: 175 Rules Go

= oL 40556
B Fwli40555
Bl vbst1:11100
= o 6884
B vFwi16534
B wbst1:11010
B vbst1:11300
B wFwii295s

‘@ Home | &2 Configuration @ monkoring | () swve (¥ Refresh || ) ack () | Do) cIsco
Device List 3.8 % | Home [=1
& add [ Delete 5 Connect & Device Dashboard | B [ rawal Dashboard” | intrusion Preves  on |

Bl vFwl:49443
‘% Tedh Db % | | 7] Add Gadgets (@ Add Dashboard

SE sensor Information - sensor

Host Name: ssm-40 [P Address 107.4|3
1PS Version: T1(0Z)E3  Device Typ A5A-5(M-20
In Bypass: No Total Memc |y 20791(8

Tokal Sensing Interfaces: 1 Total Data |torage: 912 M
Analysis Engine Statusi - ©) Running Normally

Y

[7,1 CPU, Memory, & Load - sensor ated 4:58:41 PMIY) ) ()

‘s Interface Status - sensor Updated +:56: 41 PMR) &) (6

Received
Packets

Tnterface 4% Unk  Enabled | Speed(Mb.. Mode Transnitted

Gtimheretod [+ | e | |

GigabitEthernet/l @ up Yes 1000 unpaired

8 sensor Health - sensor

Sensor Heath

Metwork Security Health

© petaic

 Detais
« Normal

D Critical

P Licensing - sensor Updaked 456141 PM(A) &) (¢

License Status: Mo License

Signature Version: () 386.0
Released Cn: Mar 25, 2009 12:00:00 AMUTC
Applied On: Aug 20, 2009 8:32:15 AMUTC

Auto Update Status: Not Checked

Engine Version: 03
Released o Aug 20, 2009 3:34:07 AMUTC
Applied On: Mar 13, 2008 12:46:09 AMUTC

Auto Update Skatus: Nok Checked

247351

<adnin> 15

E=] o)

(B 3113108 2:16:25 A amr

Rl

GUIEH

%II‘:

BA

[Sensor Information] =1 >,

[Sensor Health] ~-1 >,

[CPU, Memory, and Load] ™= >,

[Interface Status] <1 >,

| | W[ N

[Licensing] ~- >,

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B
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[ASA CX Status] 2 7

[ASA CX Status] % 7 121Z. ASACX EY a— VICHTAEERIFEERAERINET, 20X T
X, ASAIZCASACX BV 2 — AN A VAP —LENTNEEBICOBRFERENET,

& & ’ - Home
s i R i sl 8 A5G St
I5F e
| Device Information Last updated: 10:56:39 AM Interface Status Last updated: 10:56:39 AM
Model: ASAS5585-55P-CX10 Application Name; ASA CX Security Module
Hardware Version: 1.3 Application Status: Up
Serial Number: JAF1543CGRE Application Status Description: Normal Operation
Firmware Version: 2.0(13)0 Application Version: 0.6.1
Software Version: 0.6.1 Data plane Status: Up
MAC Address Range: 70ca.9bf0.1ca0 to 70ca.9bf0.1cab Status: Up

HEET

Connect to the ASA CX application: ©  hitps://10.89.147.153:443

[ASA FirePOWER Status] 2 7

[ASA FirePOWER Status] # 7121, ZOFY 2 — VBT AERNBERINET, ZoF#RIC
X, TV, YUTAEES, VTR T RXR=U g RhEOEY a—VIERE, T U r—
Tavk, TFIr—ay AF—FA F—F FL—y AF—HF A DEORAT—HF A
EOEY a—)L 2ATF—Z2ANEENFET, ZDOFY =2 —/U FireSIGHT Bt & — (288
ENTWAEEIE., Vo222V s LT AU r—arvzZil&E, BNMOSHReEY 2—/b
DFREEITH ZEMTE X7,

ZDHF T X, ASA FirePOWER £ 2 — /LT NA AZA VAR =L ENTWDHEHIZORE
REINFET,

Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)
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[Home] XA > (System) W

[Home] N > (System)

ASDM ¥ 25 LD [Home] XA > Tld. ASA ICBIT HEER AT — X AEREHERTE 7,
ASDM ¥ A7 L@ [Home] XA VIZEKRINDFEMDZL < 1 ASDM DD CH BB TX £
TR, TOXA L TIEASA OFEIREELZ —H TR TE £9, A7 LD [Home] XA > DA
T— 2 ZEWIT 10 BERCEFR SN ET,

¥ 3-6 (P.3-31) |2, ¥ AT LD [Home] XA > DEHFEEZRL £7,
& 3-6 SRFAD [Home] X1

172.23.204.65 | System MEE]

File Wiew Tools Wizards Window | Help lookfors | |
[ rene

%, Configuration @ Mummnng| B save @Refrash‘ o Back .\) ‘ ? He\p| cIsco

Device List G [ x| Home [m|
Add Connect Y
"'@ | £ @ Interface Status Connections Status <
£y 172.23.204. 65
i Interface Contexts Kbps i Total Connections \ Context Connections
&-TE) Contexts GigabitEthernet0/o admin 0 Connections (#)
B admin context1 -
> L[ contextt GigabitEthernetd/1 0
- [fEg context2 GigabitEthernet/1.2 context? nia 4
) 172.23.204.64 GigabitEtherretd/1.3  contextz s 5
Bl 10.86.194.171 GigabitEthernet0/1,4 contextz nja
8 172.23.204.51 GigabitEthermeta 2 0 2
&l 172.23.204.19 GigabitEthernet0/3 0 |
B 172.23.204.17 M i -
8] 10.05.94 55 snagemen admin B
contextl o
Bl 10.86.94.87 1633 16:34 1835 18:38
B 172.23.204.16
=) 172.23.204.42
) 10.86.194.225 )
1) 10.86.194.224 —— > CPU Status Femory Status <
Total Usage | Context Usage \ Total Usage | Context Usage |
Sramp l:| Display: Memory Memary Usage Histary (ME)
[ale]
400
I system (0.1) 100 300
M admin (0) 0%
W context2 (0) 0% 203ME 200
context1 (0) 0%
100
o
< | B 163728 18:33 18:34 18:35
™
&
B active | <admin 15 =)= 512309 4:37:23 PM POT N
Y

@

R

GUI E% EL)
1 VAT AL AT A OER,

2 [Interface Status] XA >, A X —T oA A%ZHWTHNT T 14 v 7 D%
FRTDITNE, A F—T = A X &@BRL £7,

[Connection Status] <1 >,
4 [CPU Status] -1 >,
[Memory Status] ™~ >/,
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W AsomMBROEE

= ==
ASDM %7 D TE &
ZOMREICE D BED ASDM REDEIELZ ERTEX £,
ASDM D X FX B ELZEE T HI2IE, RO TFIEEFEITL £,

XFwvwF 1 [Tools] > [Preferences] ZiZER L F9,
[General], [Rules Table], 33 U8 [Syslog] @ 3 DD X 7 D& % [Preferences] ¥ A 7 0/ Ry 7 A
NRRINET,

AFvF2 BEEZERTIHIUL., o0 XT D127 )27 L ET, [Generall ¥ 7 TIXILHT Y 7 7
L A%FEEL. [Rules Table] # 7 TlE [Rules] T— 7LD F YV 7 7L v A& EL£1, £
7. [Syslog] # 7 TlE, [Home] XA Y IZHERIND syslog Ay B—YOHNBAIEE LY,
NetFlow BE D syslog A v £—T DELE X ¥~V DFEREA X —TNMIZ L= TEET,

ATvF3 [General] # 7 Tit, RWOEHZHETEL £7°

[Warn that configuration in ASDM is out of sync with the configuration in ASA] F = v 7R > 7
AEFNIL, AF—R T v T ar7 4 Xalb—vartFETarz ¥alb—rarn
FHIL Then e 3Em+ 2 L 9 ICREL £

ELEIRF LT read-only = —H 2% L TIRD A v E— % KR T 5 121E. [Show configuration
restriction message to read-only user] &= > 7R v 7 A& AN L T, ZOF T a I,
T 7 F N TESTT,

“You are not allowed to modify the ASA configuration, because you do not have
sufficient privileges.”

ASDM ZPAL 5 & IR T 2R T L7 0 7 EBRRRIND L HIZTHITiE, [Confirm
before exiting ASDM] F = v /Ry 7 A% AL Ed, 20O+ T avid, 774V KT
o T9,

A Y=y =K —% A F—T )27 HIZIL, [Enable screen reader support (requires ASDM
restart)] F= v VAR J AEF U NILET, ZTOF T arEARX—TNITT HITE,
ASDM % BEE T2 MLENH D £,

ASA AE Y OF/NEZREEN, ASDM 77V r—3 g o OSERRIERZ FITT 21T R+
CHhDHEEICBMEZET 5 I12iE. [Warn of insufficient ASA memory when ASDM loads]
Fxy IRy 7 A%A L £F, ASDM (T, EEFICTF AL N — Ay k- AE
VEEEZFIRL, ASDM DX A L N— TX A NMNIAvE—VUEERL, 24 BT &1
syslog 77 — b ZX(E L £,

ASDM (2L » CTHERE NS CLI 2~ K &#FK/ART 521X, [Preview commands before
sending them to the device] = v 7R v 7 A% F 2L 7,

ASA IZHEEDa~< NE 1 DO NV—7 L L CTEET HIT1E. [Enable cumulative (batch)
CLI delivery] &= v 7R v 7 A=A L £,

AALT TN AyE—UREREDKERMEZMEMNTANILET, 774/ T 60
<7,

Packet Capture Wizard T, ¥ v 7 F v SNy FRFERIND XL HIZTDHITIE, £
ND—0 R=T 7 TV r—aOA4uie AT D0, £z [Browse] 7 Vv 7 L
TT77AN VAT LNTHREL £,

Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)
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AsomBEoes B

AFv74 [Rules Table] # 7 T, kOHEAAZEEL £,
a. [Display settings] Ti%, [Rules] 7—7 VL TONL—LVDERFEEZEETEET,

— Auto-Expand Prefix B8 EIZESWTHEBNRA Sz Y NV =B —E X F7
V=l kTN —T%FRT HITIL, [Auto-expand network and service object groups with
specified prefix] = v 7R v 7 A& AL £79,

— [Auto-Expand Prefix] 7 4 —/V R 2, BT 5 L ZICHBNICERMTL2XY NI —2%F
L O — txﬁ7/:7b7wa7@7v74/7x%ﬂﬁbi¢o

- Xy U= BIOY— Exﬁfyl&b7»~7®%yﬂ~k%®7w~7%%

[Rules] 7 — 7 WVIZERT HIT [Show members of network and service object groups]
Frv IRy I AL I Liﬁ“o F v IRy I ARFT 7 OEEZ, T A—T47
IRERINET,

— [Limit Members To] 7 4 —/V N2, KR THRXYy NV =7 BIXO—E XA 47T b
TN—TDREANNLET, AT V=T 8 TN—T AUAREREND & &I, &
O n O A NPT NRERINET,

— [Rules] 7—7 T XTOT 7 a v &FKaAT HIZIE, [Show all actions for service policy
rules] T v VAR J AEFNZLET, AT7OHAET. U —RERINET,

b. [Deployment Settings] TliZ. [Rules] 7— 7 WVIZEHNEZEH T D & D ASA OEMEE R
ETEET,

- HLWT 7R YV ANEZWEAT D EXIWINAT 77— V&7 T3 51203, [Issue “clear
xlate” command when deploying access lists] = v 7R v 7 A% AN L £7, TORE
IZED, ASA TRESNDT Z7EA UARR, TRTOEHRT KL 223t L THEIS
HHINA LIl £,

c. [Access Rule Hit Count Settings] CiX, [Access Rules] 7—7 VDt v NET v 7T —hF

LHEAZRECEET, By MIUX \%f%@w~w TIEGEA S ET, KRR —
LDt v ML, [Access Rules] 7 — 7 VIZIERRENEH A,

— [AccessRules] 7—7 /L Cb v FENBEENICT v ST —hEND X HITT BT,
[Update access rule hit counts automatically] &= v 7R v 7 A% A4 2L £7,

- [Access Rules] 7—7 /W2, by bEI T LEHHTLMELZDEATHREL £, A
MEOHPHIE 10 ~ 86400 £ T,
ATy 75  [Syslogl] # 7 Tid, WOHEHZETEL £7,

o [Syslog Colors] fEl ClE, BEREL LI LICE RO LHIRAERTL, )‘/‘12“—“/2'%/7“
AR~ ARXTEET, [Severity] B 7 LlZiE, FERKEL LN %HU%JZU%
FRINET, FERKEL L TAyE—VOERAELITAREEELT 51T, %ﬂi\
#éﬁ?A%&UyﬁLiﬁomwa&mqﬁ47mﬁf/7xw%réME¢o&@w
TNLOXTE7Y) 7 LET,

— [Swatches] # 7 TRL v b @EEIRL, [OK] 227 Vv 7L FET,
- [HSB] # 7 T H, SB@ﬁﬁ%%EL [OK1 %227V v 7L ET,

- [RGB] # 7 TR, #k, REEXEEL, [OK] 227 Vv 7 LET,
o JLER syslog%/*l? /%7‘4”!2 T féioﬁgﬁbfé)‘/f VDERE A F—
JVIZT 5 IZ1X, [NetFlow] #Ei% C [Warn to disable redundant syslog messages when NetFlow

action is first apphed to the global service policy rule] = v 7R v 7 A% A 2L £7°,

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B
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Bl ASDM Assistant TOBRRE

ATy 6

INGE3ODXTOFREER/ELTZEL T, [OK1 227V v 7 L TCEREERIT L., [Preferences] #

ATl Ry 7 AZAL £9,
N

GE) TV TV RAREEAT LV ERITATICTHI-NC, BEARIL conf 7 7 A IWITRIES
N, FORKETY—I A7 — a3y ECEITHOZOMD ASDM v v a VBRI CE
H5EH12720FET, TRTOEFEZFNNITHIZIL. ASDM 2 FHEEHTHILERH Y 7,

ASDM Assistant TOEE

()

ATYvF1

& ]

ATvF3

ASDM Assistant > —/LCliL, # A 72572 ASDM O HiEO~LV T gL, HaRr T
\ij_o

IBEHICT 7 B 2T 5121, [View] > [ASDM Assistant] > [How Do [?] #BIRT5H0, A= a2—
/X—® [Look For] 7 4 —/V R IZHBHERKAZ AL £, [Findl Fuy7&Z 7 U A5 [How
Do I?] 3R L THRREBIBL £,

ZOMREIX. PIX X2 VT 4 T IAT U ATIHEHTE 8 A,

ASDM Assistant 2T 5120%, ROFIEEZFEITL £,

[View] > [ASDM Assistant] % &R L £,

[ASDM Assistant] XA > BRRI N ET,

[Search] 7 4 —/L R ITHBET HIEREATILTIGol 227 Vv 7 L £,
TRk S N7 F DS [Search Results] XA IZFEREINET,

[SearchResults]‘127/3/3’0J20[Features]‘127/5/ IRRENBDEEDY & T v
L. FEMfE#aE AFL £,

BEAN)YIDAR—TIE

ATYF1

[Configuration] > [Device Management] > [Advanced] > [History Metrics] ~X A > Ti%, S £& E722
MEHEROBIEZRAFT 2 LI IZASA ZFKEL ., ASDM #ffHL T/ 7 77 —7 /L CRR
TEXFET, BEAN) v 72 A X—T NI LWGEEAE, BHITEXA20130 7TV A LAOMEHE
WIZTTT, BEANY Yy 72 ARX—T M7 5 &, EHATO 10 47/, 60 43, 12 K, 5 H
BOWE T 77 2R rTEET,

JBIEA T U v 7 R ET HITIE, ROFMHEZEITL 77,

[Configuration] > [Device Management] > [Advanced] > [History Metrics] % &R L 7,
[History Metrics] XA > NERINET,
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| 538 ASDMYS74h)a1—H L2 8—T(4R

gR—rshcuabvavrr B

AFwF 2 [ASDM History Metrics] F = 7Ry 7 A% A NI L TBEANY v 72 A X —TLIZ L,

[Applyl 7 U v 7 L £7,

HR—kchTWWEWLWavTUF

ASA TR ARE/ZR a2~ RIXIEE A ETRTASDM THAR—hInEdn, Blroar 7 ¢

Fal—rvarDavryRNO—fi ASDM CEHINLGARHY T, ZhbDa~vr Ko
FEAEITary 74X a2 —va VIZETZENTEET, FEMITOWTIL, [Tools] > [Show

Commands Ignored by ASDM on Device] &ML T 72 &0,

BRSNLIRTERIATUF

F 351201, CLITCEMNMLZSEAEIZASDM O 7 (F 21— a3 THR—FLTWELH D
D, ASDM TEMELITRENTE 2V a~<~r RO 2R FBEREINTWHET, ASDM THEA
Shba<r R ASDM @ GULIZ—HIFERENFHA, BREHa~ NIZGUIIZE RS

FTR, MEIXTE EEA,

# 35 YR— R HRADIVF YR,

HR—FIhTWEWLITUF ASDM DO ENE

capture R INET,

coredump WA INET, 24U, CLIZHEHL TORFEETE

7.

crypto engine large-mod-accel

EHRINET,

dhep-server (k> R 7 )v—T 4 —

ASDM Ti%, T_T® DHCP #— 2L T 1 DDO%

fix J& ) EDHBDFTF S IVET,
eject PR — b k54t
established W ET,

failover timeout mHEINET,

fips RS ET,
nat-assigned-to-public-ip MR I N FET,

pager WAL ET,

pim accept-register route-map

M SN ET, ASDM Tidlist 7> = L IZITRET,

service-policy global

match access-list 7 7 A CHEH I LTV DA TN,
WAl Z R L £97,

access-1list myacl extended permit ip any any
class-map mycm
match access-list myacl
policy-map mypm
class mycm
inspect ftp
service-policy mypm global

set metric

BEHRINET,

sysopt nodnsalias

BHRINET,

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B
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B yf—rEhTlABVaTUR

#3-5 YiR—FHFRHGFDIT R YX P ($FE)
YR—FEhTLEWLITUFR ASDM D EE
sysopt uauth allow-http-cache mHEINET,
terminal AR INFET,
threat-detection rate WA INFET,

HR—bRENADITURIZLDFE

BEFOFEITary 7 4Falb—varz ASDM I —R L7zgae, 28R —bxgstoa~
YREMRBH-TH, ASDM OBIEICITHEL FH A, VHR—F G40 a~r R E2RRTHIC
I1Z. [Tools] > [Show Commands Ignored by ASDM on Device] % &R L F7°,

BR— RN DERL TOEWVWY TRy XY

ASDM T, 255.255.0.255 D L HIZHfEL TWWS 7 Ry b v A7 I HR—F ST\ E
Fho meE WIIEHTE £EA,

ip address inside 192.168.2.1 255.255.0.255

ASDMCLI Y —)LTHR— SN TWEWA 259 T4 21— O
TR
ASDMCLIY —id, AV X507 47 a2—% a<w e R—hLTWEEA, {1 XT7
T AT REREMELTHCLIa~vr RaE AT 5 &, (yesmoll] DA ZERTLH T

FRFRENETH, ATTNRITRZRENEE A, VT ASDM 1L, WEORE X A LT D
FLET.

WITH R L 7,
1. [Tools] > [Command Line Interface] Z %R L £7°,
2. crypto key generatersa =~ R & AJjL £,
774/ R0 1024 £ b RSA F—ERSLET,
3. crypto key generatersa =~ > R ZHEATIL £7,
LIATO RSA ¥ —% LHE L THAERT 20 TIERL, ROTT—RERINET,

Do you really want to replace them?|[yes/no] :WARNING: You already have RSA
ke0000000000000$A key

Input line must be less than 16 characters in length.

$Please answer 'yes' or 'no'.
Do you really want to replace them [yes/no]:

%$ERROR: Timed out waiting for a response.
ERROR: Failed to create new RSA keys names <Default-RSA-key>

Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)



| 538 ASDMYS74h)a1—H L2 8—T(4R

gR—rshcuabvavrr B

[EIHER

e [ASDM] XA v b, 22— N ANRKLERFLEAEDa~ L RERTETE T,

e noconfirm 47> a0 HDH CLI a2~ NIZOWTiE, CLIa~> KR AAKIZZOAT
varEFEHLET, RIHERLET,

crypto key generate rsa noconfirm
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GE)

CHAPTER I

BWEES AR

FABY AT, $FED Cisco ASA ECARX—T NV THF T a v RELET, 20~
=27 AT, ARV AT IT 4_"—Vay F—OREFELT 7T 4 _X—2 a3 DHiE
WCOWTHHAL 3, F72, EETNMHEATEDL T A B AZOWVWTHFHHAL £97,

TOETIE, "=V 3930748 TIZOVWTIBAL 4, FoMoR—T g 020
WTIE, D URL TBEWVON—T 3 NS TEHEITA BV T =T VS TL
720,

http://www.cisco.com/c/en/us/support/security/asa-5500-series-next-generation-firewalls/products-lice
nsing-information-listing.html

[£ET N LI R—F SN TWDBEEDT A A (P4-1)
e 7 At 2T 5158 (P4-20)

(AR T A LHIRFEE] (P4-32)

[T A4 ZADOFE] (P4-33)

(T4 ADE=4Y 7| (P4-37)

[ A4k ZADOBEREREE] (P4-38)

ETILS EIZHR—FESNTWWBABEDS AU X

IOETEH., BETNMUMBHTEL T4 R E . T4 ACHT AT FHE IOV THH
Li‘g‘o

[TEF LT DT A A (P4-1)
[F A4 ZDOFR] (P4-14)
[VPN 7 A& A LHRED HHME] (P4-19)

ETILCEDSAEUR

ZOHETIE, BET VMM TELOHEDT A RE2RL 7,

[ASA 5512-X] (P4-2)
[ASA 5515-X] (P.4-4)

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B


http://www.cisco.com/c/en/us/support/security/asa-5500-series-next-generation-firewalls/products-licensing-information-listing.html

BA4E BEESAEUR |

B £FLZLICYR—FEhTOIREDS AR

e [ASA 5525-X| (P4-5)

o [ASA 5545-X] (P4-6)

o [ASA 5555-X] (P4-7)

o [ASA 5585-X (SSP-10) ] (P.4-8)

o [ASA 5585-X (SSP-20) ) (P.4-9)

e [ASA 5585-X (SSP-40 33 X 1'-60) | (P4-10)
e TASAH—E R ET2—/] (P4-11)

o [ASAv ({fH CPU x | Z##) | (P4-12)

o [ASAv ({48 CPU x 4 ##5#%) | (P4-13)

ST ZEATREINTZHEZ, AT A8 A (£721F Security Plus 72 &) 7 A2 R /N—
VarEBRTELMENOF T ary TARUVATE, T4V ATMARDEDL I ENTE
T, ez 242=T 7 AN ala=r—ar 7 Ak AL Strong Encryption 7 1 &
> A, 500 AnyConnect Premium 7 A &2 A & GTP/GPRS 7 A& A, £lid4>D7 A& X
P ANTRFICHEN T2 2 LN TE LT,

~
GH OB ERERD D EEA, HEREFRICOWTE, Hx OBEOEESRL T2
S,
NA B = RS EEEORNET A OREIE, RISRTHEEDO ~ AV FR—FahEdEr, ¥
R— b SHRVERED U X TN TR, A v — NS iEO R WET L) (P4-30) %
ZLTLSIZE 0,
TARYADFEMCONWTIE, [T A48 ADER] (P4-14) 2B TIEE W,
ASA 5512-X
#4-1 ASA 5512-X Z 1 > X DR
SAEYR EATAEVR Security Plus 5 1 £ X

F27AT794—IL 54tV RX

Botnet Traffic Filter

TAe—TN | F T g P DIFfN—X Z T e —T N | T g DIFN— X Z

AR AN ATBE SR AEH ETRE

7 7 AT 4 — LD 100,000 250,000

[ B

GTP/GPRS PR —rAL Fu4—TN \F T g TR

JH B[ BE

Intercompany Media Engine |5 4+ —7 )L |F 7> 52 Z 17X M\ T4 8—TIN | F a0 TSR E
M A RE M A RE

UC Phone fCEEHERR & 2 g 7a TR 2 g 7a TR

VA v, i UC RELHERR 24 |50 |00 [250 [500 24 |50 |100 [250 [500

g

WNSAE2 R

Adv.Endpoint Assessment |5 4 E—T )L | F T FLESR fE T A—TIN | F a2 FLESR E

JH ATGE JH AT GE

Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)



| B4%F HESAEUR

EFLS LIz R—FShTLd8EDS o2 1

F4-1 ASA 5512-X S 4t XDEEE (#)
A4V R BEXSM4EVR Security Plus 5/ £ X
Cisco VPN Phone i ® TAC—TN |\ F T 5 TSR M\ T AT ST 5 TSR
AnyConnect JH A BE JH A[BE
AnyConnect Essentials TA®—TN |\ FT a3 TSR M\ T ATV T g TSR M
JEFE 250 &> 7 2) HA[BE 250 &> 7 2)
AnyConnect for Mobile TA4Y—TN NG T TR T4 e—TN \F T TR
HH AT RE HH AT EE
AnyConnect Premium 2 g7 g kT A R 2 T g kT A X
(Eyvar) 10 \25 ‘50 \100 250 10 \25 \50 \100 250
g7 7 > DIFfN— X 250 T 7 2 DIERN— X 250
(VPN Flex 717t %) : (VPN Flex 717 t> X) :
7 g > DHE Z &R Participant |72 3 > DIHF Z &2 X Participant
FE /T Server, T—NDBEE: FE /T Server, T— NDBEE:
500 ~ 50,000 50,000 ~ 545,000 500 ~ 50,000 50,000 ~ 545,000
(500 H (i THNT) (1000 # iz THQ) | (500 AL TN (1000 H# iy THINT)
it VPN (v =), (250 250
LR AT DOEE
fliod VPN (B> =) (250 250
VPN 2—R RS20 7 |(BR—FAL YER—FHY
-’51V R
51k AR (DBES) | F 7>z ZrE X4 3K (DBES) |4 7> a> Z175EX
7t (3DES/AES) 7t (3DES/AES)
7 z— LA —R— PAR—h7eL TITATIAZ N FETZXT 7T 47
TIT AT
BRATDAH—T = |116 916
A A, KR,
X274 a3 TXAN (BPAR—FRRL 2 T 7 7 |5
>R
T AREY T PR—F72L 2
IPS EY = — /L FU—TIN |\ F T a3 FTLERE T ae—TN | g TR E
JH ETRE HH ETRE
VLAN. K 50 100

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B



BA4E BESAEUX

B £FLZLICYR—FEhTOIREDS AR

ASA 5515-X
#4-2 ASA 5515-X 5 1 > X DEEFE
2Q4€VR EXS1tEUR

F27AT794A—IL 54tV RX

Botnet Traffic Filter

T4 '—T N | F T g DIFfIN— X Z B X S A RE

T 7 AT U —IVOBER.
A Bf

250,000

GTP/GPRS Fa—TN |\ F T g TR fEH RS
Intercompany Media Engine |5 (2 — 7 )V | F 7> 52 F 72 R : fEHARE
UC Phone fRERMERE >~ |2 F7rar Z4E (24 |50 1000|250 500

v, MUC EMERR
MRV IV

VPN S/t R

Adv.Endpoint Assessment

Fav—TN \F g TR AR

Cisco VPN Phone F ®
AnyConnect

FA—TN N T T g TR AR

AnyConnect Essentials

Faw—TN |\ F T g TR EHERE 250 g )

AnyConnect for Mobile

F U —TN T T g TR S AR

AnyConnect Premium
(tvyvav)

2 g7 a DK T AR

10 ]25 \50 ‘100 250

T g > DIFRHN— X 250
(VPN Flex 71> %) :

g7 5 > DIF T 4 X Participant F /21T Server, Y — NDLGE:

500 ~ 50,000 (500 #f7 THI) 50,000 ~ 545,000 (1000 # {7 TH1)

A8 VPN (v =), |250

BHE AT DEF

fltd> VPN (B> ayv) 250

VPN o —R RS 07 [HR—FHY

—BS51E2R

51k A (DES) |F 7> 3> Z17 €2 X #/(E (3DES/AES)

7 — )V —N—

TITATIAR R, FIXT 72T 4TI T 7T 47

ERAT DAL H—T =
A A, KR,

916

XU T 0 aTHRAR

2 g7 g Z5E |5

R
ALY T 2
IPS £ =2 —/L Fuav—TN N F T g TR AR
VLAN, FK 100
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| B4%F HESAEUR

EFLS LIz R—FShTLd8EDS o2 1

ASA 5525-X
#4-3 ASA 5525-X 5 1 > X DEEFE
2Q4€VR EXS1tEUR

F27AT794—IL 54tV RX

Botnet Traffic Filter

T A —T N | F T g S DIFH]N— X T X S ARE

T 7 AT U —IVOBER,
A Bf

500,000

GTP/GPRS TAC—TN | F T TR AR

Intercompany Media Engine |5 ¢ v — 7 )V | F 72> 52 F7HE2 X : fli/HEJRE

UC Phone {YFEFEIR L~ |2 |# 7o a2 Sr¢ |24 |50 |100 [250 [500 750 |1000
va v, K UC REMERR R

yar

VNStV R

Adv.Endpoint Assessment |5 4B —T ) | F 5 T LB R - fEHATRE

Cisco VPN Phone i ™ Tae—TN |\ F T TR AR

AnyConnect

AnyConnect Essentials FAe—TIN |\ F T TR EHAE (750 22 )
AnyConnect for Mobile TAC—TN |\ FT g TR AR

AnyConnect Premium
(Evyvav)

2 T 7 q DR T A TR

10 ‘25 \50 \100 ]250 \500 750

G727 > DIFERE]~N— X (VPN Flex 71 750

T X)

g7 5 > DIF T 4 X Participant F 72T Server, Y — NDLGE:

500 ~ 50,000 (500 #f; THI)) \50,000 ~ 545,000 (1000 #f7 TH)

A8 VPN (v =), |750

XA TOEEH

flt> VPN (B> ayv)  |750

VPN B—R RS20 7 [$R—FHY

e e T3

2L A (DBS) | #7232 77X ;4L (3DES/AES)

7 — )V —N—

TITATIAR R, FIZIT 72T 4TI T 7T 47

ERAT DAL H—T <
A A, KR,

1316

X 2UT 4 arTFHRAL 2 g7 FLE |5 10 |20
R

T ARY T 2

IPS £ 2 —/L Fuav—TN | F T g TR AR

VLAN, FK 200

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B



BA4E BESAEUX

B £FLZLICYR—FEhTOIREDS AR

ASA 5545-X
F#4-4 ASA 5545-X 5 4 1> X D#EE
M4V R EXSMEVR

F27AT794A—IL 54tV RX

Botnet Traffic Filter

T4 —T N |\ F T g o DIFN— R Z B R A RE

T 7 AT U —IVOBER.
[i] B

750,000

GTP/GPRS TUAw—TN |\ F a2 TAEX AR
Intercompany Media Engine |5 (2 — 7 )V | F 7252 Z1+2 R - HAEE
UC Phone CHEEEIR & 2 T 75 Z 75 |24 50 100 250 500 750 1000 2000

v, MUC EMERR
MRV IV

VPN S/t R

Adv.Endpoint Assessment

Fav—TN | F g TR ARE

Cisco VPN Phone F ®
AnyConnect

FAv—TN |\ AT 5 TR S AT

AnyConnect Essentials

Faw—TN |\ F T a5 TR AR 2500 T g 2)

AnyConnect for Mobile

Fuv—TN | F g T X S ARE

AnyConnect Premium
(tvyvav)

2 T 7 q DR T A TR

10 ‘25 \50 ‘100 ]250 \500 ]750 \1000 2500

G705 > DIFE]N— X (VPN Flex 71 t2X) : 2500

g7 g > DHF T X - Participant F 7213 Server, ¥ — NDBEE:

500 ~ 50,000 (500 #fi7 THI) \50,000 ~ 545,000 (1000 # (7 THIL)

A3 VPN (v ar), 2500
L5 AT OEE

fihd> VPN (v a>) 2500

VPN 2 —R RS 07 [HFR—FHY

e e T3

fif 51k A (DES) |F 7>z F1 2% : #(Fk (3DES/AES)

R RTAT

TITATIAR R, FIXT VT 4TI T 7T 47

EHEATDA 2 —T = (1716

/])X\ %j(o

X2V T 0 arTEAL 2 FFar Tt |5 10 20 50
X

JIARY T 2

IPS ¥ 2 —/L Fak—TN |\ T g TR fEHARE

VLAN., &K 300
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| B4%F HESAEUR

EFLS LIz R—FShTLd8EDS o2 1

ASA 5555-X
45 ASA 5555-X 5 1 2 X DHFE
SA4AtR EXSAMEVR

F27AT794—IL 54tV RX

Botnet Traffic Filter

T A —T N | F T g S DIFH]N— X T X S ARE

T 7 AT U —IVOBER,
[i] B

1,000,000

GTP/GPRS Fuaw—TN | FF g TR A RE
Intercompany Media Engine |5 ¢ v — 7 )V | F 72> 52 F7HE2 X : fli/HEJRE
UC Phone fCEEHERR & 2 G 7 g TR

v, MUC EMERR
Ty a v

24 50 100 1250 500 750 1000 2000 3000

VPN S/t R

Adv.Endpoint Assessment

Fav—TN |\ FFa TR AR

Cisco VPN Phone F ™
AnyConnect

FAv—TN |\ F g TR A RE

AnyConnect Essentials

Faw—TN | F g TR EHERE (5000 T ST )

AnyConnect for Mobile TAC—TN |\ FT g TR AR

AnyConnect Premium 2 T g DR T AR

(Byar) 10 ‘25 \50 \100 ]250 ‘500 \750 ]1000 ‘2500 5000

72 3 > DIFH]~N—X (VPN Flex 7 1t X) : 5000

g7 g > DHF T X Participant F 7=/ Server, ¥— /NDLBEE:
500 ~ 50,000 (500 #HA7THN) \50,000 ~ 545,000 (1000 Z (7 THN)

A7t VPN (v a ), [5000

R5 AT DA

1> VPN (v =) 5000

VPN B—R "o/ [BR—kHY

—B/S1EVRX

51k

EA (DES) | # 7> 3> Zrt2 X 4k (3DES/AES)

7 — )V —N—

TITATIAR R, FIZXT VT 4TI T 7T 47

EHEATDA X —T = 2516

/])X\ %j(o

X2V T4 ITHRAL 2 F7rarZL |5 10 |20 |50 100
R

JIARY T 2

IPS Y 2 —/L Fat—TN |\ F g TSR A RS

VLAN., &K 500

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B



BA4E BESAEUX

B £FLZLICYR—FEhTOIREDS AR

ASA 5585-X (SSP-10)

=Dy ¥ —YTHRILCL~LD2 250D SSP Zfifl T E9, LLPRIELZ SSP TV A —F
SHTWERA (72& 21E, SSP-10 & SSP-20 DfAGDLEITVR—F SR TWVWERTAL), &
SSP AR D a7 4 X al —v a VBRI OEHEEZERFOMN LT N4 2L L TEIEL £,
MBS U T2 9D SSP 27 = — /LA —R_"— X7 L L THATE £,

#*4-6

ASA 5585-X (SSP-10) S > X DL

P fa 7P

BAS (>R L Security Plus 54 £ X

F7AT794—NL 54tV R

Botnet Traffic Filter F A —T) |\ F T g S DIFRIN— X F R S AJRE

77 AT U =Dk, |1,000,000

[F] iy

GTP/GPRS FA—T N T g TR EH AR

Intercompany Media Engine |5 4 & — 7V | F 7> 52 F 17X : (E/HAGE

UC Phone fREEMEIRE >~ |2 FTa LR

va v, f UC REHEIR 24 50 100 1250 (500 750 |1000 |2000 |3000

Tyia»

WNSAt2X

Adv.Endpoint Assessment |5 ¢ v—T )V | F 5 T LB R A ATEE

Cisco VPN Phone 1 ® TAC—T N |\ FTa FaLEX S AR

AnyConnect

AnyConnect Essentials FA—TN | F g FAEX EHEITRE (5000 T3 )

AnyConnect for Mobile TAe—TN |\ FTa TR fEHARE

AnyConnect Premium 2 G g DT AR

(Byiav) 10 25 [so [0 (250 [s500 750 [1000 2500 |5000
72 5 > DEfff]~N—X (VPN Flex 74t X) : 5000

T 7 g DG Z B X : Participant F 7= /3 Server, H— NDBE:

500 ~ 50,000 (500 (i THH) 150,000 ~ 545,000 (1000 #47THI)

“FF VPN (v =), |5000

BH2 AT DOEE

o> VPN (v 3 v) 5000

VPN 2 —RK RT3 o200 (R —FHD

o (e I

10 GE I/O BEERT AV AR T 4—T I, 77 A% |SecurityPlus T AV R 1 £ F—T )L,
ifcs IX 1 GE TEIMEL £ 7 7 AN ifcs 1X 10 GE TEIMEL ¥4

551k EA (DBES) | F 7> 3> Z7 X #fk (3DES/AES)

7 — )V —N—

TITATIAR R FIZIT VT 4TI T 7T 47

LR ATDA X —T = |4612

A A, FR,

X2 UT 4 aTFAL |2 T 79 T 5 10 20 50 100
N

IS5 AR T T4 —TN \F T g TR 16 H TR AT EE

VLAN. &K 1024
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| B4%F HESAEUR

EFLS LIz R—FShTLd8EDS o2 1

ASA 5585-X (SSP-20)

Fl—Dy % —YTRILLAD250SSP 2 TEEd, LULRRAEL T SSP ixHhAR—
ENTWERFA (72L& x0T, SSP-20 & SSP-40 DHHLEPLHITHR—F ENTVERTA), &
SSPFfABID a7 4 Fal —v a UV BXOWEHAEZRFOMN LT A AL L TEEL £,
MBS L T2ODSSP A2 7 = — VA —R_"— X7 L L THEHATE T,

F£4-7

ASA 5585-X (SSP-20) 541 122 X DHEE

A4V R

E#ES A £ R & Security Plus 5 1 2> R

T7AF2x—NL 34tV R

Botnet Traffic Filter

T A —T N | F T g o DIFHN— X T X S A RE

77 AT+ — LD, 2,000,000

Gilis3

GTP/GPRS FA =TI |\ FTa TLEX A ATRE

Intercompany Media Engine |5 v —7 )V | F 7> 3> 7 7B X - @&/ AJGE

UC Phone fREEHEIR >~ |2 F7ar FLEAX

;igg@UCﬁ@%@ 24 |50 |100 [250 500 |750 1000 [2000 3000 [5000 |10,000'

WNS At RX

Adv.Endpoint Assessment |5 E—T ) | F T g T LB X fEHAEE

Cisco VPN Phone f® TA—TN |\ FTm TR A ATRE

AnyConnect

AnyConnect Essentials Fuv—TN | F g TR EHERE (10,000 > 5 )

AnyConnect for Mobile TAw—TN |\ F T a TR ESATRE

AnyConnect Premium 2 T g DT A TR

(Byvar) 10 \25 \50 \100 ]250 \500 \750 ]1000 \2500 \5000 10,000
g7 g > DIFH]~N— X (VPN Flex 7 17t X) : 10,000

g7 g > DHE T X Participant F 72034 Server, ¥— NDLEE:

500 ~ 50,000 (500 H{LTHY) 150,000 ~ 545,000 (1000 44 THI )

AF VPN (v 32), 10,000

BHE AT DEG

o> VPN (v 3r) (10,000

VPN B —R RS0 7 [HR—=FHY

—{S1EUR

10 GE I/O BERTA R T 48—=T 0, 774 |SecurityPlus 7 A BV A 1 A X —T )L,
ANifes 1 1 GE CTEIMEL £4 7 7 A N ifes 1% 10 GE TEIMEL £

51k JA (DES) |7 7>z F7 ¥ X #fk (3DES/AES)

7z — )L — N —

TITATIARZ R, ETNET VT4 TIT 7T 47

ERAT DAV R —T =
A A, R,

4612

X aUTF o arTxAL |2 FFg> St |5 10 |20 50 100 250
R

VaY. YN T A —TN | F T g T R 16 A TR ATRE

VLAN., &K 1024

1. 10000 £y 22 UC T Aty ADBPE,

MAGDEEy v a VEITAF 10000 ETTTA, BT 2XY ¥y ¥ 3 O KREIL 5000 T,
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B £FLZLICYR—FEhTOIREDS AR

ASA 5585-X (SSP-40 & & U -60)

Fl—Dy % —YTRICLLNAD250 SSP 2 TEEd, LULRRAEL T SSP XA —

ENTWERA (72L& 21T, SSP-40 & SSP-60 DFHAESDLHIZHR—F ENTVETA), &
SSPIIfEBID a7 4 X 2 —3 a VBIOEHEROMS LT A 2L L TEIEL £,
VBTG T2 oD SSP A7 = — /L —N_"— X7 L L THEHTE $7,

#*4-8

ASA 5585-X (SSP-40 £k Uf-60) 51 > X DFHE

P fa 7P

EESAHVR

F7AT794—NL 54tV R

Botnet Traffic Filter

F =TI | T g DI — X T R S ARE

77 AT T F—IL DR,
[i7] B

5585-X (SSP-40) : 4,000,000 5585-X (SSP-60) : 10,000,000

GTP/GPRS FUAv—TN |\ FF g TR ARE

Intercompany Media Engine |5 t v —7 )V |F 725> Z7E2 X : ] ATEE

UC Phone fREEFEIRE >~ |2 I Tar FLER

RN FREEHEIR 24 |50 [100 [250 [s00 [750 [1000 |2000 [3000 (5000 [10,000'

VPN 5 {2 R

Adv.Endpoint Assessment |5 (v —T ) | F T g TR fEHATEE

Cisco VPN Phone f ® FTa4—TN |\ F g TR AR

AnyConnect

AnyConnect Essentials T U —TIN | FTg TR EHAEEE (10,000 F 25 )

AnyConnect for Mobile TA®—TN |\ FFa TR AR

AnyConnect Premium 2 T3 DT A R

(=) 10 \25 ‘50 ]100 \250 \500 \750 ]1000 ‘2500 \5000 10,000
T 7 > DIF]—X (VPN Flex 71t X) : 10,000

g7 g > DHF T X - Participant F 7213 Server, P — /SDBEE:

500 ~ 50,000 (500 #fir THIY) ‘50,000 ~ 545,000 (1000 # (7 TH )

A% VPN (v =3 r), [10,000
EH AT DEF

fliod> VPN (> =) 10,000

VPN B — R N5y |[HR—Fbb

—wS1 VX

10 GE IO A F—T Ny 77 AN A2 F—T = A A% 10 GE THE
fiF =k WA (DES) |F 7>z Fo X #ifE (3DES/AES)

7z — )V — N —

TIOTATIARBNAEIZET VT4 TIT 7T 47

BHAT DA HZ—T = 4612

/I,X\ %j(o

X2 UT 4 arTFHERL 2 a2 St S 10 |20 50 100 250
R

TS AR YT F =TV |\ FTg TR 16 HA TR AR

VLAN. #K 1024

1. 10000 Ev < 22 UC T Aty ADEPE,

MAGDEEEy v a VEITAF 10000 ETTTA, BT rXY ¥y ¥ g O REUL 5000 T,
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| B4%F HESAEUR

EFLS LIz R—FShTLd8EDS o2 1

ASAY—ER £ a—)

#4-9 ASASM Z 1 > X 45t
214tV R EXKSAEVR
T7AFTI7x—L 4tV R
Botnet Traffic Filter F U —TIN | F T g D N—X Z X AR
T AT DB 10,000,000
ELS3
GTP/GPRS FA4—TN | F g T X A
Intercompany Media Engine |5 ¢ v —7 ) | F 7> 52 F 7 E2 X : fEHEEE
UC Phone fRBEFERE >~ |2 FTa TR
VA, fe UC fUERHERR 24 50 [100 [250 [500 750 |1000 [2000 (3000 5000 |10,000'
Ty a»
VPN S5 t> R
Adv.Endpoint Assessment |5 v —T ) | F T g ToLEX - AGE
Cisco VPN Phone i ® Fuk—TIN | F a2 T X AEHARE
AnyConnect
AnyConnect Essentials TA4w—TN |\ FFa TR AR (10,000 T3 )
AnyConnect for Mobile FA4v—TI)N |\ FFm FLER I ARE
AnyConnect Premium 2 T g Dk AR
(Eyvar) 10 \25 ‘50 ‘100 ‘250 ]500 \750 \1000 \2500 \5000 10,000

7 5 > DI N—X (VPN Flex 71> X) : 10,000

g7 g > DHF Z 2 X Participant ¥ /= /3 Server, —/NDLEE:
500 ~ 50,000 (500 #(; THIN1) ]50,000 ~ 545,000 (1000 # (7 TH)

AR VPN (v =), 10,000
BH AT DG
flid> VPN (v =) [10,000
VPN 2 —FR " v |[HHE—FH D
-1V R
2L JA (DES) \zv"y_:/ > Z4 X L (3DES/AES)
Tz — VA —N— TITATIAL S NAEZRT VT4 TIT 7T 47
X2 VT a2 THFAL |2 g FLEX

5 \10 ‘20 ‘50 ‘100 \250
TGARY T PAR—F2L
VLAN, K 1000

1. 10000 > a2 UC 7 Aty ADGE, MAEbEEy v a U iTAF 10000 ETTTR, By vxy By v a O KREE 5000 TT,
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ASAv ({78 CPU x 1 Z#&#)

#4-10 1 DD VvCPU 5172 EH#D ASAv DIEEE
SAtR ‘Eﬁfi;UPremium SL4EVR
F77A470+— LS4 X

Botnet Traffic Filter YR—FEHY

77 AT T+ —LOEK. 100,000

[FIIRE

GTP/GPRS YHE—F Y

Intercompany Media Engine |47 R— K~ %

UC Phone fCEEHERR & 250
gy, ¥ UC {REMERR

tyia»

WNS A1t R

Adv.Endpoint Assessment  |fE¥EZ A R YR — 7R L Premium A4 2 X : 4R —FH Y
AnyConnect Essentials BES AR PR—FL Premium 7 /£ A : R — K72 L
Cisco VPN Phone H ™ BEES AR FR—F 2L Premium 5 A2 R : ¥ R—FH Y
AnyConnect

AnyConnect for Mobile BT AR PAR—FeL Premium 7 A &2 & : 4R —FH Y
AnyConnect Premium BETAA SR 2 Premium 7 A &> & : 250
(Eyva) HEFLETR = 2L

A% VPN (v ay), (250
2 AT DOEF

> VPN (v =ay) (250

VPN 2—R RS20 7 [$R—1+HY

—BS31EVR

=1t 58{t. (3DES/AES)

7 x— )L — N — TIT 4 TIAR N A
ERATDA L HE—T = |116

AR, &K,

X2V T 4 marTX PaR—h7aL

A R

IIGARY T FAR—NL

VLAN, K 50

RAM. vCPU [ ERR |2 GB. 5000 MHz
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ASAv ({78 CPU x 4 Z¥&#)

F4-11 4 DD VvCPU 5 12X F15D ASAv DIEE
SAtR ‘Eﬁfi;UPremium SL4EVR
F77A470+— LS4 X

Botnet Traffic Filter YR—FHY

77 AT T+ —LOEK. 500,000

[FIIRE

GTP/GPRS )

Intercompany Media Engine |47 KR— K~ % 0

UC Phone fCEEHERR & 1000
gy, ¥ UC {REMERR

Tyia»

WNS A1t R

Adv.Endpoint Assessment |[fE¥ES LB X HFAHR— R L Premium 7 A2 X : AR —FH Y
AnyConnect Essentials BES AR PR—-FL Premium 7 A &2 A : 7 R—F72 L
Cisco VPN Phone H ™ BEES AR FR—F2L Premium 5 A2 R : ¥ R—FH Y
AnyConnect

AnyConnect for Mobile BT AR PR—FRL Premium 7 A &2 R : 7 R—FH Y
AnyConnect Premium BT AR R 2 Premium 7 A &£ X : 750
(tyera) KT AT PF— AL

AF VPN (v ayv), |750
EHRATOEH

> VPN (v > =ay)  |750

VPN 2—R RS20 7 [$R—1+HDY

—B5M1E2R

=1t 58{t. (3DES/AES)

T oL N TITFATIAR N A
EHAT DA H—T = |1316

AR, &K,

X2V T 4 arTH YaR— k7L

Ak

7T AH PAR—RRL

VLAN, # K 200

RAM., vCPU [RS8 GB. 20000 MHz

GE) 4ODOVCPUTA L 2ZEWHT DN 22F7-1E3 2D vCPU 28 AT 541,
WOEESL T,
2 SDO{RAE CPU : 4 GB ® RAM. 10000 MHz ® vCPU JE R E R . 250,000 D [F]
BE 7 7 A4 7 0+ —VEEfe,

3 DDO{RAE CPU : 4 GB ® RAM. 15000 MHz ® vCPU JEEE R . 350,000 D [F]
BE7 7 A4 7 0 4 — )V,
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A4 ADER

#4122, [FFALTLEDT A Z] (P4-1) OBEORTHE SN D MM L i %

KL ET,
F4-12 SAERDER
Q4R FE

AnyConnect Essentials

AnyConnect Essentials 7> 2 = U {Zid, D VPN ¥ A 7T REENTWET,
e SSL VPN

o IKEV2 ZfEifHL 7= IPsec VE—hK 77 &R

IOTABLRE, TITUYPR=R (7T 4T b A) OSSLVPN 7 7 & 2 73 Cisco
Secure Desktop (XH 7R —F L CTWEHA, ZiUH OBEREIZXT L TiE, AnyConnect Essentials 7
A 2 AD Y IZ AnyConnect Premium 7 A £ ANT 77 4 7L S IvET,

(G¥)  AnyConnect Essentials 7 A £ X &3 % VPN 2—H|X, Web 7 7 U % Zfifi Ji]
LCueZ AL, AnyConnect 7 7 A7 M &X 7 a—REBILOES)
(WebLaunch) 752 & T&EET,

ZDZ A& AL AnyConnect Premium 7 A £ ADWTILTA 2 —7 L E 72021
BEfR72 <. AnyConnect 7 7 A7 > b Y7 MU = TIERLC 7 247 MEREDE > M2
SN THET,

¥FE D ASA TiZ, AnyConnect Premium 7 A > A (&4 A7) F721% Advanced
Endpoint Assessment 7 4 £ A% AnyConnect Essentials 7 1 &> A L [FFFIZT 7 7 o
TIWTHZEIETEETA, 2L, ARy PV —27HNDHEZRZ ASA T, AnyConnect
Essentials 7 A ‘£ A & AnyConnect Premium 7 A &> A& EIT7$ 25 Z LITAHEETT,

7 7 4/ K TIL, ASA X AnyConnect Essentials 7 1 > A& H L £33, webvpn %
f£ 1 L . ¥ IZ no anyconnect-essentials = <> N F 7= {%X ASDM T [Configuration] > [Remote
Access VPN] > [Network (Client) Access] > [Advanced] > [AnyConnect Essentials] <~ > % fif
9% Z & . AnyConnect Essentials 7 4 B> A% T 4 B—7 MIZL THOZ £ B R
PEHTEET,

[VPN T A & X LHEED E#HrE) (P4-19) L T &,

Cisco VPN Phone i ®
AnyConnect

ZDZ A &> A% AnyConnect Premium 7 A £ A & & HIZEHT 5 &, AnyConnect ®
AWM AAENTNDON—F T =7 IPEFENDLT 7 EATEET,
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#4-12 SAEIDIHR (BFEE)

A4t R FE

AnyConnect for Mobile | = ®F A > A%, Windows Mobile 5.0, 6.0, BXV 6.1 Z2FETL TV DH X v F AT Y —
¥ ENA) T NA ATO AnyConnect 7 7 AT b ~DT 7B A& L 97,
AnyConnect 2.3 LIED/N—2 2  ~DENA) T 78 AEZFR— T 55T, 207
A ABERT LI 2BBIOLET, 20T AU AEERT 5A T,
AnyConnect Essentials & 72 (% AnyConnect Premium O W NWNDT A B AET 77 47
T 2MERHY 9, i, FrSDH SSLVPN By v a v OAHEEEET 572
DT,

Mobile Posture H7R— k

UE—h 77F8Aarbu—nZ@HAL, XAV T AL ANLRAF ¥ T—H %L
79 % 121%, AnyConnect Mobile 7 A £ A & | AnyConnect Essentials % 721X AnyConnect
Premium 7 A £ ADWNT NN ASA A L A=V SN TV LORENRDHY £, A~
A= LT A RATEASNT, ROBEEZMEHTE £,

e AnyConnect Premium 7 A & > AF§HE

- DAP BB L OFOMOBEFEO L R A2 N BHIZE ST, R — |k xt4
FENAN TNAAZDAP R —%@EHL £, ZHIZiE, AL TRA R
MHEDYE—F T 7B AOF A£G RNE TN ET,

» AnyConnect Essentials 7 1 & AfkrE

- ENRNANWNTNRARAT IV AE T V—TENTAX—TNVELIET 4= I
LEd, ZOHELZ, ASDM 2L THEL £7°.

- CLI £721X ASDM % H L TR T NA N T AL ACETHERE L RL T
(7721, DAP RV =& L720 | ZhHDENAN FRAA~DY E— b
T IR ABRESFEA LD T OMETH D FEA),

AnyConnect Premium AnyConnect Premium 7> ¥ 3 i, RO VPN ¥ LA T REFENTWNET,

e SSL VPN

o 7747 L X SSL VPN

o IKEV2 ZflifiL 7 IPsec VE—F 727X

AnyConnect Premium HTHEIT AL RIZL ST, ASAITEEO IV FAT D ASA DEFT A2 A P —

Shared CLUTHEREL 3, AT A A T — IR T, Hx D ASA |2 X - T
ENDEy v arORERREE. KR T A2 ATHRESNDREREE2B2 52 &1
TEFEHA,

Botnet Traffic Filter HAFIv I T—ERXR=2A Xy ra—R35 20, 875 { (3DES/AES) 7 A
T ANKEETT,

51k DES 9A L AXT 4 B—T NI TE EH A, 3DES AL A% A A —/L L TW

586, DES 5|l & i C& £9, MRS b2 26 H L 72\ 5412 DES Off
HaEBik+ 512k, AR T2 AT L) IR ColEa <~ R E2RET
DHVBENRH Y FT,
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A4V R

IE

Intercompany Media
Engine

Intercompany Media Engine (IME) 7 At A% A X —7 V2T H L, TLS ¥
Ty varEREINLTLS 7ax v OflRE CHEATE 9, £7-. Unified
Communications (UC; =7 7 A K a3a=4/—a ) FABV AN A =)L X
nNTEH., FOHBEENT 7 405D TLS 7 ax v OflRE L 0 Z2WiEE, Bfivwox
TR T, ASA R UC 7 A4 ZOHIREBIZETE Y ¥ a VAR THIBRZ 3% E
LE9, TLS 7 u X Oif|[RIZ. tls-proxy maximum-sessions = <> K ¥ 72X ASDM T
[Configuration] > [Firewall] > [Unified Communications] > [TLS Proxy] XA > Z i L TF
B TRECEET, ETNVOHIREZFERT HIZIX, tls-proxy maximum-sessions ? =~ >
REANNLEST, UCTAEBS AL A A= T5& UC THEMTES TLS 7 e
Ty a T IME By v a CTHMHTAREIC/AR Y 9, 7o & I BRE S AL HIBR A
I000TLS 7 Xy By aryDiEs,. 150 By a D UC T4 AE AT S L,
®AID 250 IME £ > 2 3 £ Tk, UCITEHREREy v a v RICEE L E X £ A,
IME 2250 #8252y a s BNRBIZRDE, 77y M7 +—2DFIROFEY D 750
Ty a N UC & IMEIZE > CREIBICHEHASET,

o (K8 THDLDLI A AMEFREZDLA, TLS X £y 3 03 1000 FTIZ
HIBR SN FE9,

e K9] THDLEZTI AL ARIEFZTOHFAE. TLS 7 X UHllRiL, EHTIHREL Y
Ty M7 F—h TTIVIKREL 9,

GE) K8 LK, =TV AR—FICOWTEDTA B ARKIRENDINE I & RL
F9, K8 MRS T, KO ITHIREnET,

BigiloiE, SRTP bty a v AT EELH 0 $1,

e K8§ 7 AL ADHA, SRTP v 3 43250 £ TITHIRE N E 1,

e K97 Ay 2ADEE, HlRIZH Y THA,

GE) AT AT OB LEZNLE LT D a—A72F R, SRTP #HIRICXL Th o v
FENFET, 2—NITH L TRNRARL—DHEISNTWAESIE. WMHoL v/
73 SRTP TH->ThH, SRTPHIRIZKH L THU » h I ERA,

BRAT DA H—
Tz AA, EK,

VLAN., ®#, &, 7V v Y 71 —7, BX O EtherChannel A > X —7 = A A2 &
FTRCEEDEEA LV E—T oA AR, a0 7 X2l —varyTEREINTY
59 XTO interface 28, ZOHIRIZXHL TH T N ET,
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SR FE
IPS Y = —/b IPS Ea—L S4B ANHBEL, ASATIPS V7 " =T BV 2a— L EETTHZ

EWRTEFET, F2, IPSHIDIPS V7 =F ¥ YT A7 VT a U BRETT,
WDOITARTALESRL TLIZZN,

e IPSV 7 =F ¥ TR VT g EBATAHITIE. IPS RSV A A= ENT
ASA NMETY (EHE ST, 72L& 21 ASA5515-IPS-K9 D X 92 [IPS] "&£ h
TWHRENRSH Y £9), IPS TIERWHEEFE S D ASAIZIPS V7 =F % 7271
FrarEEATLIZEEETEERA,

o Tx— A —N—ZONTIE, MAFD2=y N TIPS V7 XF ¥ #7227V T3
VRMETYT, OV T AZ YT a0 ASA T 4BV ATRWED, T x—L
j‘—/\“—ﬁ?ﬂ_‘:c:;ﬂ\:ﬁéhi’@_‘/\/o

o Tx— LA —NR—ZOWVWTIE, IPSTV I X TF ¥ BT A7 VT ailidz=y D
LIZ—EBDIPS BV a—/L FA BV ARNETT, D ASA DT A &L R LR
W2, IPS BV 2— v T A4 B AHEINICIE Y == F— = T T AZ T 4k R
THEEINET, LIPSV 3T v 7R 7 VT a v OEHIZHIET DT
DT, 72— —R—DFEMITOWNTHIDIPS B 2— DT A A EHEA
TAHALERH Y 7,

Z DOt VPN ZOMD VPN £y g 1iE, RO VPN Z A 7R EENTWET,
e IKEvl Z{fi/HL 7= IPsec Y E— b 7 7 & A VPN
e IKEvl ZffifH L 7= IPsec % k> —¥% A K VPN
e IKEv2 Zffi ] L 7= IPsec %A k> —4 A k VPN
IDTABVAFEART A B RAIZEENLTVET,

AF VPN (v = e VPN tEv a3 DO KEDEFN., VPN AnyConnect & Z D> VPN > v 3 D

V) BEATDEE BERABEIVEEL > ThH, lMAEbEEEYy Y a VN VPN By ¥ a U OflR%E
MAZ5Z LiETEEHA, VPNORKE Y v a U BEBIT-5E. ASA &4 —/—
B—RLT, XYy NI DV A R EBWYNZTH I ENTEET,

e V7 A7 ML ASSLVPN v araBthL %, RN—%/L) 5 AnyConnect 7
TAT N By varyZBLIEGER. Git1 20ty v a UMEHS TV E
T, ZAUTxL T, &I AnyConnect 7 7 AT N& (RAZ KTy 2747
K72 EMe) BGLT-%. 79 A7 R ASSLVPNR—ZLica s A4 LT-EEe
X, 2500k Yy a M EHINTWET,
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A4V R

IE

UC Phone fCEEMERR & »
a v, MUC R HME
[RE>yirav

WOT TV r—3a Tk, BEERFICTLS 7%y vy a U 2FALET, 2nbo
TV —2 g THEASNAETLS 70k v ay (BLXORIhboT7 7Y r—
TarDH) ITUCTA B ADHIBIZHLTH Y M ENET,

o FEIETuXv
. 7vﬁyx71?v~yay7u%v
. FAEEFA AR g v

TLS 7uxy kv a2l 220077 ) r—rar (T4 ARAER
Mobility Advantage Proxy, fE53D IME Z A &> ANMEA IME 72 F) TiX, UC #IfRIC
HLTHY M LEREA,

UCT 7V r—vaicko T, 1 20ERICERO Yy v a v 2ERT2HEA13H Y
9, =&z 7 F A<V &y 7T v 7D Cisco Unified Communications Manager %
WG E L ;A1 TLS 7 ax VHEEHiN 2 2H 579, UCProxy By ar b 2
EH S ET,

TLS 7 v % > Oiil|BRIL. tls-proxy maximum-sessions = <> K £7-/X ASDM T
[Configuration] > [Firewall] > [Unified Communications] > [TLS Proxy] ~X > % {# i L T{#
BNCRETEET, ETNVOHIREZFR T HIZIX, tls-proxy maximum-sessions ? =~ >
NaEZ AL ET, f7¢w%®ﬂs7m%/ﬂ@i@%ﬁmUc?4ﬁ/x%L%¢6
6. ASA Tix, £ UC HIBRIZ—83 % & 912 TLS 7' 7 % OfilR2S B BIfIZ 3% E
NET, UCTA B ADHIRL D S TLS 7 2 % U HIIRBEL S E T, HS?D%/
HlfR%E UC 7 A B AL DD RLEETHE, UCTA BV ATTIRTOEY v a e
EHTEEHA,
G¥) [K8) THKbDZIAvr AMLE S (2 & 21 X2—WFHD 250 Ko7 A2 %)
TiX, TLS 7 r X v v 3 VI3 1000 ETICHIRSET, K9 TR Z
Ay ARGEF S (222 —FHENR 250 L EDT A& R) Tk, TLS 7'
XUOHIRIZT 7 4 F 2 —Ta VIKFEL, BT AVORIRN RIS £
T, K8 EKOX, =7 AKR—KIONWTEDT AU ARFIRINDENE 50k
AL ET, K8 IFHIBRENT, K9 IFHIBENET,

(72 & 21X clear configure all =~ > R & L C) :’/743?21/ varky
V7 95E&, TLS 7aX VHIRNET VDT 7 4V MIREINET, 20T
THNVENRUC TA B ZADHIREY H/hS & tls-proxy maximum-sessions ~
YUREMEHLEEEIC, BORHIREESDDL LT — Ay =Y NRERRIN
3 (ASDM O [TLS Proxy] =4 > Zfi[]), 7 =—nF—"—%ZMHHL T,
write standby =~ > R &2 ATJ 957, E£72IX ASDM T 7 A~ VEEEIIX L T
[File] > [Save Running Configuration to Standby Unit] Z{# f L CTHEIIc= > 7 4
X2l —rarOREEITH &, ’TZ7‘J/5\ U £ T clear configure all =~ > K 73
HENWIZAER S, B FVEBEICESE Ay E—UNRRRINDIIENH Y E
T, AT 4FX 2l —varyORHICEIY 7T A~ VEED TLS 7 v ¥ RO
MENMETLIND 2D, OB IIMACTE 7,

Bl iE, SRTP bty a v 2HTAEELH Y £,
e K8 A ZATI&., SRTP B v a3 1T 250 £ TICHIBE N E 1,
e K9 T AL AIZHIBIZH Y 8 A,

GE) AT AT OREALE A LEZNLE LT D a— A7 R, SRTP #HIRICL Th o v
FENFET, 2K L TR ARAZL—DRRESINTWAIESIT. Wi oL v 7
73 SRTP TH->ThH, SRTPHIRICK L THU b I FERA,
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#4-12 SAEIDER ()
Q4R FE
A8 CPU ASAV TR CPU FA BV AZ AL AN —LVTAHEVLERHYET, T4 2 F2 A R

h—n35FET, A)—7> NI 100 Kbps IZHIREN D728, TltERT A N 2347 T
xF9, BEOEBEICIE, (KB CPU 7 A4 ARKETT,

VLAN, fx K

VLAN BlfEOR L L TH T N TH A ¥ —7 = A A2, VLAN 28D X4 CFF,

VPN B —R RZ 27

VPN B — R NZ o702k, MK E{k (3DES/AES) 7 A4 B ANMETT,

VPN S 1t X E#EeD Bt

F 4-1312, VPN T At R LA MAGDLED Hika R L £7,

AnyConnect Essentials 7 A & > 2 3 X (" AnyConnect Premium 7 o £> A THAHR—h STV 58
BEDFEMIZ2 U A MT DWW T, [AnyConnect Secure Mobility Client Features, Licenses, and OSs) % %
L TS 7ZENy,

N— =z 31 :
http://www.cisco.com/en/US/docs/security/vpn_client/anyconnect/anyconnect3 1/feature/guide/any
connect31features.html

N— =22 30:
http://www.cisco.com/en/US/docs/security/vpn_client/anyconnect/anyconnect30/feature/guide/any
connect30features.html

N— a3 25
http://www.cisco.com/en/US/docs/security/vpn_client/anyconnect/anyconnect25/feature/guide/any
connect25features.html

#4-13 VPN 51t X LBRED T
ROVWTIDDFTA LV REAF—TLIZLET,'

HR—F 9 B#hE AnyConnect Essentials AnyConnect Premium

Cisco VPN Phone /] ® AnyConnect No Yes

AnyConnect for Mobile? Yes Yes

Advanced Endpoint Assessment No Yes

AnyConnect Premium Shared No Yes

7747 =A@ SSL VPN Yes Yes

TIUYPR—= (VF7A4T L A)  |No Yes

@ SSL VPN

IPsec VPN Yes Yes

VPN B —R RF vy Yes Yes

Cisco Secure Desktop No Yes

1.

2.

AnyConnect Essentials 7 - =2 XA £721% AnyConnect Premium 7 4 B ZDOWTFNN—FH DT A A X AT 720F
ETIT47ICTEET, T 740N TIE, ASAIZIE 2 &> ¥ a3 v H® AnyConnect Premium 7 1 & > A2V 1A
FHTWEF, AnyConnect Essentials 7 A Z> A% A A —LT DL TRNT 74N THEASNET, b
D IZ Premium 7 A B> A% A F—7 WIZT 5 IZIE, [Configuration] > [Remote Access VPN] > [Network (Client)
Access] > [Advanced] > [AnyConnect Essentials] <X A > Z 2R L 77,

Mobile Posture 78— kX, AnyConnect Essentials D34 & AnyConnect Premium 7 A £ ADGA LTI RARY £
o BEANCOWTIE, £ 4-12 (P4-14) 2L T2 &,
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160>y R2EY FOU—KBSE, £721X20°34 ) [ETHEIT V7T 4= g F—
TERINET, ZofllE, YU TES (11 LFOXLTH) & A X—T NI HHEREL 255
(AP 2

o [HFEAVAM—LINTNDLT AL A (P4-20)

o [k#T A& 2] (P4-20)

o [FEHlR—R Z 14tk Z] (P4-20)

e [AnyConnect Premium (:f) 7 At 2| (P4-23)

o [Tz LA —N—FILASA 7T AKX T A4 A] (P4-27)
o XA m—REESILHEREDRWET L] (P4-30)

e [ 4% 2D FAQ] (P4-31)

BAIAVAM=ILENRTWET51EVX

F7 4R T, ASA L, FABVANRA L A M — A EINERECHTENET, 20T 14k
VAT, BXLTERABREBLUONRU A =B A A=V LTEARIOGE T, 74 A &2BMNT
XAHERT AV ZDBELE, TRTOITA B ARTTIZA LV A=V ENTWAEELRH
DET, VA= LENTWDIIALLRAEEEETIICNE. (T4 2ADF=FT 7 )
(P4-37) =&ML T<EE0,

KESM4 LR

KT VT 4 _"—ary F—h 1O A —ATEET, KT 7T 4 X—L a3 F—I%,
1 ODF—IZFTRTDOT Ay ZHEREEZEML TWET, BEX—Z2 S4B A A A —
NTDHEASAITKET A B ALRHNR—RA T4 2% 1 DOFEITTA B RAHEARL E
T, ASANT AU AZREETDHHIEIIOWTL, kT A A L= T /& A
OfEE 1 (P4-21) 2L TLE I,

FRIN—X 54tV

K7 A B ATMA T, R Z A8 AZBWA LT FEREIGIROH 2507 A& 2% A
FLYTEFES, 72&xiE. SSL VPN D [FIEF = —F OB HIE IR AL T 2 72 D IZBRERE] N — R
@ AnyConnect Premium 7 A2 AZ AL | 1 FMADRAY bRy N VT T 407
TUNERERNR—Z T A B AT LD TEET,

o FHIR—RA FARV AT 7T 4_X=2arDHART A (P4-21)
o [HMR—Z F A4t R XA ~—0DEE] (P4-21)

o k7 A BV RALEEHR—R T A2 ZADFEA ] (P4-21)

o HMR—Z F AL ADAZ X2 (P4-22)

o [BFRI_—R T4 ZADOHNHIR] (P4-23)
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o BEBDOKHN—R T4V AE AL A=V L, RIUKEEBICERDO T A2 A&l T
ENTEES, FEL, —BIZ 727 TETEDLRHAN—R T A A1, 1 HREIC
DX NPT, T IVT 4T DTA R AFAV A =L ENT-FE T, HHTRER
RAECTY, 7= & Z21E. 1000 &~ > =3 > AnyConnect Premium 7 A &> A L 2500 &> 3
AnyConnect Premium 7 4 B> A% AV A=)V LTIEHE, 26D T7 A48 2D BN
N1 OB T ET /T 4 7ICTEET,

o F—DOHIBEEOMEZFE ST A A2 T 7T 4 TICLERE. TZICEETWY
HIBEEDONT INIHIET DR AN—A T AV AZFRRIZT 77 4 7T 252 &1L TE
FHA, REAF, T A ARy PRy b T T 47 T 4 HF L1000 &
2 AnyConnect Premium 7 A £ AN E ENDLGEH. AZ R 7 B2 ORRHEAN— 2
2500 £ v ¥ =2 > AnyConnect Premium 7 A E> A% Z OFMET A B> A ERIRFIZT 77 4
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HIBRAY 100 THHI-0, A ESNT-TFTA B ATIIRK 100 DT F 2 F BRHFARS
NEF, LER-T, ~AF— 2=y b ETHEKRKI00 2 THFAFEZHRETE 7,
FALV—T 2=y bbb, a7 4Falb—TaryOFRENLTI0 2 THFA %
FozZ iz ¥4,

- SSP-60, TNENS0 2 THFAIDIODOD2=v b, BIXOTF 74V D230 TF R
FD 1= k%> ASA 5585-X ASA % 4 DFHTAL TWET, 7T v b 7 +—LDHIRE
MN250 THHED, T4V RTAFHTIZar TR AMNIHEEENET, Lo T,
VAL — 2=y F ETRRKINAVTFANERETEET, FAL—T 2=y,
a7 4 X2l —arOEAENLTINaryTxF A N2 LIk £3,

o TABUVADAT —HANAX—TINELIEIT 4 B—TILDOEE, A X—TI) AT —HF X
DI AMEAENET,

o AFX—TNFELEXT 4 B—TWVIRE (DOEIET « T ERTZR) ORFER—R T A&
ZADEAE. AT TRTOT A AOHBOAF L7200 £, KN T T A~V /~
AR — 2=y hDTARADAD T N Xy Sin, MRS E, B X VA
L—T7 2=y hOTABVADHIT N XU UG, LFLREEETT, 20—
W, 72T 471707747 72—t —_"—L ASA 77 RAFZ V7 ICbmAEnET
(TRTCO2=y BT 7T 4 7 ICEEL T ThEH SN ET),

ez 22002 =y FDORY Iy s VT T 4T T ANE TAR ZAOHF YN
48 % > TV DAL, A S =AML 96 i CT9,
HEEINTETFTA B AEZRFTTHINE. (T4 ZADFE=FY 2| (P4-37) &L TL
fiéb\o

J2I—)A—N—F=IEASAVSRE2 2=y FREIDBIEDEHE

=y POBENERZ THOEOHMIN 30 HEZBA=HEE1Z. 2=y MJia—hicA
VAN ENTETA B ARTEAESNET, 30 BOMTHIRITIX, AN E T T4
ANRBEET_ATCO2=y N THEHAINET,

30 HIORM P PICEBENEBRL 25613, FBEX—X J /2R 250 TiE, R\EL 7~
BFEIN T T A~ VI AZ— T AUV ANLELSIDNET, 7T~V /vAEZ—TFT 4R
DHIRBOINICR D ETIE, BOVEAV/IAL—T SRV ADHT U b XU nfilled 52 &
XH 0 A,
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B TNHIEFENENRDT A B AL L THDIL, 748V ADFERIZED AV v MId
D EH A, FOBEERICIZ 30 HORMTHMG &N ET,

wIZhl L £,

1. EORY MRy N T T 40T TA4NE FTABLAN2ODZ=y NIV A —)L
SENTWET, A SNTEFEITTI AL 2T, 3BT 104 Blc2 0 £,

2 INbDa=y bR, 1 DO0DT7 =2—)bA—"— 2=y FASA 7T A& L L T 10 #EENE
THE EETABL AOHBIOEVIZM4BEERYET (FT A~V /~AX—|T 42,
v H L F Y IAL—T 2 5258),

3. 2=v FOBEMEREZXTZGE (e, 794~V /~AX— 2=y FMEIEL 725
E) X, BA A VAL —T 2=y MIASNE T A A eS| S EfEHL, 948
WO B ERITLET,

4. RFH_—2 T B2 ZOEMER, BEDPWVOEITLINDINICL > TRO LS I2ER Y F7,

e 30 HUW BB LN I A~ /~AH— 2=y FDOTA B ANLELSIDNE
T, ZOHAE, BEIF4EBBIETINET, LER>T 44BN T4~ /<A X —
FTABANLELGIMNT, BVIFAFH 0LV ET (X7 4/< V38, BHV
2T 5258),

o 30 HARMLARE : RRIBIFRHEI N H OEEN L E LN ET, Zo%E, WEX 6 BMEIC
BrxEnEzT, LENR-T, 6 NRT T4~V I~AF—LB WX VAL —T DlTDZ

AU ANBELIIPNT, BVIZEFSABELERVET (T A~V /~AHX—IZ 36,
ALK VAL —T T 468),

TJr— LA —=—IN—RTFOT7vIFT5L—K

T 2= A== XTI, MFOEEIZR DT A2 ABA L AR =L EZNTWD LI
RNDT, U Z AL LICKEEICH LT A A2WHATEET, Ve — N R_QnExR
Ki T A A (F 4-15 (P4-34) #2W) 2T 2546, Voe—RKpicfholEE~o

T 2= VA —N—%FTTEET, MHFOEETY v —RBLERIGEIL, FEELZEICY
O—R3HEXTUHALTRAEL FHA,

RAAO—FEBES{EBEEDLZNVETIL

AR = NSO VWET LV EEAT A Z ENTE £, D EIZ X - TiX, Cisco
ASA V) =X TRA =R bE A F—T M TEEHA, ASAY 7 b =T H, A
0 — RIS L2 LET VERIL, ROWEEZT «E—7 VLT,

o =Ty AR aIa=f—T g

e [VPN]

ZOETNTH EHEGHICEER S (3DES/AES) AL AE AL A —LTEET,
72 & 21X, ASDM HTTPS/SSL, SSHv2, Telnet, 33 XN SNMPv3 Zfli i C&x£9, Ay hxv
NNFT 4w T an& (SSLEMH) HOXAFI vy T—FRXR—REXra—RT5
L TEET,

FABL AEFRTHE (T4 Z2DF=FY 7 (P4-37) #BH). VPN B L=
T7ARK ala=r—arO742 AT AMIREINEREA,
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Q.

AnyConnect Premium &Ry b Xy b NI 7 47 T4 2L BEOREHN—X T 4
Y RET VT 4 TITTEET D

T, —EICHEATE ORFHAN—R T A A E TEEICSE 1 S TT,

TEEORKMN—X S48 2% X2y 7] L, FBEEREIIND & BEIMICKRO T A&
VAMEHEIND L HIZTEEITh,

W, 742 ARE—DOEEIL, HEROKBN—2 S4B AE A A M—1T 5 L,
RFETHI R SRS & S vE T, 74 B ANRE—TRWEAE (1000 £~ 2= & AnyConnect
Premium 7 A B 2 & 2500 By v ay T4 A7), ASA IZF ORI L THiH X
NIEKDEMAN—Z S A AEZHBICT 77 4 7ICL £,

TIT 4T REMN—2 T AV ZAZHELRNS, FTLWKET AL A% A A b —
JLTEET D,

TV, K7 A 22T 77 47l TH, KENR—2X T 4B ZZIFEEL $HA,

TNV A—R—=DT T A< VEBLLTELETA B A =%, BH U FVEFELL
THEET AV AN I T v b= RNEFHTE T,

Wz, B VEEIL, ST AVEEERIUET I A RAEEHLET, £EHT
A AP —NIZEF, =N T A B ABYETT, Ny 7T v 7 —NZiF, BT
AV ANRMETT, X7 v 7 =X, 2200y 7T o7 —R"DR &2 DT = —
NG — N RTICEE T E £,

T2 )VF == RT7OHh XA VEERIC, AU IA B 22BATILERDH D F
ﬁ‘ﬁ)o

VDWW Z, RN=T g 83() D, MFOEEIZFR DT A A% A AN —T BT
R0 FE L, RIS, TABVRIT TS~ VEETHATA-OICEASNET,
THUF VB, TIT 47D ETTA~Y T4 AEMALET, B F VU
BIZHDOT A2 A>T DBHEAIEL (RexiE, 83 X0 baioY 7 by =T Ic—%T
574 AEEALTIZSRE)., A RIEFT T 2=V F—NR— I F 2K F 4L AT
WEESNET, L. EFAOHIBRNREREICR Y £9,

AnyConnect Premium (3£4) 7 4 &2 A2 A T, FEf~_— R £7213K#HED AnyConnect
Premium 7 1 & A& TE £9 7,

W, B—H VA AR =L ENTET A A (BEN—2 T4 AF 2T KEET A
TUR) Oy va v BEENRELEER, T AR EAShET, B EET
A2 A P —,3Tid, K#HE AnyConnect Premium 7 A > A3 SN FHA, 72720,
EHET AR A Y= T A RLFARFICHFHN—RA T AT L3 TE
F9, ZOHE, KEX—X 4/ A0y a L, v—H/LD AnyConnect Premium
o a iR TEET, AT AU R T —ILIZEML TEMY AT A THEAT
HZ EIFTEERA,
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AVFEAM E—FDHAES A

o YNTF AUTHFAPN E—RTUVATLAETARN—ARNIZT /T 4 _X—T a3y T—%iEH
=t

o MHETABLRAT, vATF ITHRAN FT-RFTEYR—-—F IR TWEEA,

T7ATF 94— ILE—FDHAES1Y
N—TFT v R T—=KEFTUV AT LU T=RFRDOWGFT, _XTCDITA VA X AT 2R
TExFT,

TJx—ILF—N—DOHLAESA>

o EETAVLVRIL, TITATIT VT 47 TE—RTIEYPFR—FEINTWERA, FEMICD
WTIE, (72— F—R_R—CdefFT v 2| (P4-25) ML T &0,

o [T x— LA —N—F=ITASA VT AHX T4t A] (P4-27) ML T EE Y,

W

FYFTHTL—REZYUTL—FRKRDHARSAY

HFEDOIRAR—= g b= a Ty T — R LRSS, 7727 4 _"—Y a3y F—0

HEMEII AR L £, 72720, F 77 L — REBEDHER I IZRIENE T 2858086 0 £,

o N—VUgUBIUMIIK YTV —RTDHEE Ty 7T L —RKIZ, 82 LV bFAEAN
SNTEHEDT A AEZBMTT 77 47bd5E, UL 7L —RLESBATHIH
NR=2 g N T AT I T A= gy 2 —OHBEMEIIEREL £, 72770, 8.2 LIFET
BMASNFHET AL 227 7T 4 7L LEEEAIE. 77T 4_X—2 3> F—0O FHi A
BAER 7220 £, BEHMEDORWTI A BV 2 F—0BARAIE. WOTARITA L 25
L T 7E&Ew,

- A=V arTT T4 X—=Y a3y F—%2 ANLEEEIE. ZOF— ASA THAH &
NET R=V 3 82UBTT 7T 4 7ELTEFHLWVWT £ B ANRZRWES),

- HLWS AT AT, URIDOT 7T 4 _—2 3y =00, BA—2 30 L H
HMEOHAIHLWT VT 4 _XR—V gy F—ZERTHLERH D £97,

o N=UarB2URNIF VTV —=RT 56 "= a2 83 TR, L0 o/ 3X b7k
N=A2A F—DEHBLOT ==V A== T A ADEERRDO LBV EASNELT,

- BEOBBR—2ADT 7T 4 _X—ay =BT 0T 4T RIS, ¥ 7L —RE
WX —B&ET 77 4 AL SN —R $—DBNT 77 4 7 ET, fho
XX T RTCFHET I/ T s 7bENET, HEORKMAN—Z T 4B AN 83 THAZ
NIBERICKHE L TWAES, FOT AL ZFXANN— g 0 TOFEHIZTERLT
b, TIT 47 TABADEETT, Ktk — LT HERFHAN—2 F—2HA
JILTL &V,

- T2 F =R XTRER—HDTA B ARNBLEES. UL —RIZkY
T 2= V==L T 4 =T ET, ¥ HLBETH, AT
A AL, BEINTZTA B ATIERL 2D 7,

- 1 OOKMNR—RA T 4BV AZ AL AP —/L L TWDBNR, ZI 83 THEHAIN-IHKAE
WZHIEL TWAEA, X7 7L —ROETHR, TORMR—R F 48 R3IT 7
FT4TREETT, ZOBENRN—R S4B 22T 4 B—7 I T DI, Kigx—
EHANTOHLERS Y £,
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ZOMDH AR S A2 EHIBEER
o TUTF4R—T gy F—lF, ar T4 Xal—ary 7T ANMIMEEINEEA, BL
Tr7ANELTCT7 Ty a ARVIBREFESNET,

o TIUT4NR—vary F—F THRAAOVI TNAERSICEEMTONET, WET A
AE, THRA A TEHETEETAL R U = TEEORERLZR), "—FU =T
ENRELIIZDIZT NA AL T D0ERH Y 20 Z L2 Cisco TAC IZ &> TH
NR=ENTWVEBREIT, P AaDTF Ay XA F—AITHKL T, BHEOTF Ay ZEHL
WY T NABEFGICEET DL IEEL TESN, Y RXAaDT7 B R F—2anb, #i
B —DOBRES LHEOL VT AE S RO SN ET,

o WARZRIC, WEFIET v T 7L —RLIEZTABV ADIZDIZT A B AZIRATE A,

e 1ODzx2=y N LT, FUHEIED 2 SOBIMEDO T Ay AZNETHZ LIXTTEERA,
ez 2532 SSLVPN 74 B AZWALLEHZ TSSOy ay T4 A%
WBEALTH, 150y a vy Z2EHATE2DIFTEALS, FHTEDFEK 50 H#O
tyTarTtd, (Ty 77U —FRKZ, BEHESCLET ARV AZBATELZL0NHY
FT, FExE 2S5 By varns 5ty ary~OEMTT, TOXATOT T T
L—RIE, 29005 4By 2AOMELIZHDOE DO TT),

o TRTDIABUARAZAT T 7T 4 7L TEETN, WIEBICK - TUE, HreE 5> L oM
HEDENTERNLONRH Y £9, AnyConnect Essentials 7 A £ ADFE, DT A
T A LT EBENRSH Y ¥ A, AnyConnect Premium 7 &2 A, AnyConnect Premium
(HfH) 714 A, BEO Advanced Endpoint Assessment 7 1 &2 A, 7 7 4/ K TiX,
AnyConnect Essentials 7 A £ 2% A A M=V L7eGE (BEHPOETFT LV THHTE S
WA ZOTA B ANFIBRO T A 20V IEHINET, 2EHT S
[Configuration] > [Remote Access VPN] > [Network (Client) Access] > [Advanced] > [AnyConnect
Essentials] 1 > Z i3 % Z & T, AnyConnect Essentials 7 A > A% a7 4 ¥ 2L —
varycCTrak—TniCL, thoT A RAEFEHTE ET,

SAtEUADETE

o [TUF 4 _— g F—0HWE] (P4-33)
o [F—DT7 VT 4B IOIT 7T 4 71k] (P4-34)
o HEFF AL ADFZTE] (P4-35)

TIO9T4R—= 3y F—0OEE

TIT4_—vay F—FRETHIZE, YATOREENLEATE /NGRS — 03
T9, WHET A A2 LIEBOBAGRGEX —Z AT H2LERH Y 7, =& 21X, EAR
T A ANH HYE X, Advanced Endpoint Assessment [ & iE/10> AnyConnect Premium & v
Ta Tl OF —EEATOIMLERDH D £,

AR — 2 BE L7256, ROTFNEEFESTL T Cisco.com IZZNHDF—% B KL £7°,

FIRD

ATFvF1 ASA O U T )VFE5 %, [Configuration] > [Device Management] > [Licensing] > [Activation Key]
ZBINL T, (A F ar7HF AN F—RFNTiE, VAT AFETHEE TV T ALEFERRA) I
HLET,

ATwF 2 Ciscocom I[Z&GRT D UEMNE > TWRWIEEIX, TH U b &ERL £9,
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Tur T ERERENTEH, ROEREATL T,

o BEFEEEX — (XF—HEHLLEIT. ET 152 ANLES, F—JLIEOT nE
AELTANTHUENRDY £7)

e ASADTIUTNES

o B ANV TRLRA

TIT4N=vary F=PHBNICAERSH, HELLZEF AL TRLVRCEESNET,

ZOF—ITIE, KRBT A B ARCENE TIORG LN T R TE T TV ET, K

NR=2 FTA RV ADHEEE, TARV AT LIEMNOT 7T 4 _—Ya v T—=RbY 7,

BRI — S B ICh DAL, WAMEX —Z LICAT v 7 4 2@ VELET, TT0

WMGRREF —Z AN LTef, RBISHESNDT 7T 4 X— g F—2id, BEkL 7oKtk

REAT N TEENLTVETS,

X—DTF7IVT14TUELVETIT14T 4L

A& H

HIBRE1A

COETIEH, HLWT VT 4 R_R =gy F—DANE, BER—2 F—DT7 75 4 T{kB &
VT 77 4 7LD HIEIZOWTHIAL £7°,

o TTIZVLTF avTFHFAL BF—FRIZASTWAEAIT., VAT LAFETAR—RIZZDOT 7
FA4R_R— gy F—E AN ET,

o —HDKKEET A ATIE, 77T 4 7ILKICASAZ Y o — R T AL ERH Y £,
F 41502, Va—FKRNERIT AL AR FT,

#4-15 RS EXDY O—FEH

ETIL YA—FAREBELRSA VAT
TRTOETF L et Ay ADX T T 1L —FR
ASAv vCPU A4 ZADX T 7L —FK

HFEDOIRAR= g b= a Ty T — R LRSS, 7725 4 _—Y a3y F—0

HHMEIIFERLET, 2770, U7 L — FEBREOHER IIIRENE L 25608 H Y £,

o N—T g v SIURINIE YL L —RFTAEE T T L —R#BIZ. 82 LV FATEAN
ENTFHEDT AL AZBINTT 7T 47 fbT25L, ¥ 7L—RLESHAETHIH
N g KT BT I T4 _— gy 2—ORBMEITEFRE L ET. =770, 82 LIFFET
BASNTHET AV ZAZT 7T 4T LEEEIE. 777 =Y a3y F—O T A
N2 <20 9, BHHEORWT A2 2 X —RNHIBH1T. ROTAR T %5
LT 7E&Ew,

- BR=V g TT I T4 X~ a3y F—EANLEEAIE. TOF—0 ASA THAX
NET (R=Var82URTT 7T 47 LTEHLWVT £ ANRRWIER),

- BLWIRATF AT, UBIOT 757 4 _X— a2 F—RNR0EESIE, HR—Y a2 L E
WD BALIFHLWT 7T 4 _"— a3y 2 —FBERTALERH Y 4,
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o N=UalrB2UNIF VTV —=RTLH5E6 "= a2 83 TiE, LD a3 b7k

NR—AF—DFHBI N T 2N A== T A ADEERROLEBVEAINEL T,

- BEOWMAR—ADT /T 4 R_R—=2ay X—NT 7T 4T RGHE, ¥ 7L —RE
WIT—FEET 77 4 TALENTZRERIR— 2 X —DBNT 75 4 I ET, o
F—IITRTCHETIZT 4TI ET,

- T xRN RTIUIR—HDOT AL AR IS, XU 7L —RI2kb
T 2= V=N T 4 =T ET, ¥R HLEBETH, AT
AR RL, EAEINTZT AR ATEHRLS 2D 7,

FIRD

AFw7 1 [Configuration]> [Device Management] % 3R L, €7 /VIiZJ& L T, [Licensing]> [Activation Key]
F 721% [Licensing Activation Key] XA > Z3#IR L F7°,

AFwT 2 KEEELIZIRRENR—2OBH L WT 7T 4 _X—2 3 F—% AJS1F5I21%, [New Activation Key]
TA4—IRTHLWT 7T 4= a3 F—% AL ET,
X—lI, SODERETHRIND 16 AN T T, FEEIL 1 DOAX—ATRY LT
F9, O Ox FREFITEETT, T _XTOMEMN 16 #E L e snET, RITHEZRL £7,

ASAOxd11b3d48 0Oxa80ad4clOa 0x48e0fdlc 0xb0443480 0x843fc490

1 DOXGEF—B L OEHOERR—A F—%2 AV A=V TEET, FLOLKKEF—Z AL
Ha. TTICA VA= NMFEHROF =N EHEEZSNET, FLOKHAN—X F—2 A LI
G, T7HNVNTT 7T 47127 Y, [Time-based License Keys Installed] 7 — 7 /M IZRK R SN E
T, FFEDOHERRIZH L CTREICT 77 4 TAL LRI — A =BT 77 4 712720 £7,

ATFYT3 ALV AR—NEHLDERR—R X —%2T 77 4 7L EIIET 77 4 7T DI, FDOF—
% [Time-based License Keys Installed] 7 —7 /L Ci#&I L | [Activate] F721% [Deactivate] &= 7 U v
7L ET,

EHERETT 7T 4 7T TE DR AR— A =13 1 DOARTY, FFHICO VT, TR ~— 2
TA A (P4-20) 2L TLEE W,

AFv 74 [Update Activation Key] 7 U v 7 L £7°,

KT A B A>T, BHILWT 7T 4 _—2 a3 F—DANKIZCASAZ I n—F35%
VERHDFET, Ve—RBUELT AL A0 —EIZOWTIEL, # 4-15 (P4-34) 5L
TLEEW, BBERGAEIZ, Ve—RT3L9KkDLNLFET,

HESAE ADEE

ZOETE, AT A A Y —=REBM AT LERET 2 HECHOVTHAL =3, LA
T A ADFEMIZOWTIEL, TAnyConnect Premium (M:4f5) 7 At A (P4-23) Z5ML
TLIZE W,

o [HEFET AL A P —ROFE] (P4-36)
o [HEFTF MU 2BMa=y v, BIOT TS aroRNy 77 v $—_0O#%RTE] (P4-36)

CiscoASA L) —ZXASDM a7 4 ¥alb—>a v H4FK (—BHREGEE B



BA4E BESAEUX

B S it znEE

HESAEV R H—/I\DETE

ARSH

FIRD

ATYF1
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ATv74
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ROEE

CDHETIE, ASAZHEXEFE T AL A P — "L L TRETDHEZODWTHAL £,

=P HET A AP =N F =2 TV DRENRD Y 7,

[Configuration] > [Device Management] > [Licenses] > [Shared SSL VPN Licenses] < > D JIH|Zi%
WL F7,

[Shared Secret] 7 4 —/V N IZ, LHEWEE 4 ~ 128 ASCII XFDOAM VU TASIL £9,
ZOMEBEREOTRTCOSN2=y PR TA B A F—R"EHHTEET,

(7> av) [TCPIPPort] 7 4 —/LRIZ, =B M=y b5 D SSL #2312
A—bk (1 ~65535) # AL £,

F 7 4V hix, TCP AR— b 50554 T,
(A7 3 ) [Refreshinterval] 7 4 —/L' K T, 10 ~ 300 DO FTHEIEE AL 9,

ZOEIE, YA EETLIHEARET DD M=y MRt EhET, T 7B
1330 BT,

HTEZ A AEENE RIS A X —T = A AT, [Shares Licenses] = v ViR v 7 A%
AL ET, RN=T 4 RN DLV NAOBEICIE, ZOF =y IRy 7 AIHIET D
A2 =T oA ANEHINET,

(AT av) Ny 2T v T $—nEEET BT, A7 a0y 27 v 744 SSL VPN
S 4ty A P— N EE TR O FIEE T £,

a. [Backup server IP address] 7 4 —/VRIZNNy 77 v 7 —ROIP TRV A% ASL ET,

b. [Primary backup server serial number] 7 4 — /L NIZ Ny 77 v 7 = O Y T LESTE A
HLET,

c. NI T T =N T 2= F— = XT O OAE 1L, [Secondary backup server
serial number] 7 4 —/VR TAX LR A 2=y FOV I TNLVEFEREL £7,

1 OOy VT T H—=REeFDF T g DAB N, 2=y NOZREIRETEXET,
[Applyl 7 U v 7 L £7,

HEHES A 2B Ma=y b, BEXOT T a0y 77 v F —_o#RE] (P4-36) %
ZHL TLEEW,

HESAEVRAEMaA=y b, BEUX T a DNy 7T H—nOEE

COHETEH, TETAB AV —RLEBEETLHILIOICHET AL ABNM2=y NERET D
FIEIZOWTHHLEY, 7Y arTENa=my v 2Ry 7T v 7 =L L TCHRET D
EIZOWTHFHIAL £97,
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ATv74

ATYvSH
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BN AT LBREH T A ABMNF—%FFo TVWDLRENRDH Y £7,

[Configuration] > [Device Management] > [Licenses] > [Shared SSL VPN Licenses] ~~-f > D JIH|Zi%&
WL £,

[Shared Secret] 7 4 —/V N {Z, LHEWMEE 4 ~ 128 ASCITI XFDARNV T TASIILET,

(A7 a) [TCPIPPort] 7 4 —/LFIZ, SSLEZEHL TH—L@fEd+sr8—F (1~
65535) AL £,

7 4L &, TCP A— bk 50554 T,

(FFvay) sha=y &y 77 v 7 H—"EL THET HITIEL, [Select backup role of
participant] = U 7 C, WO FNEZFEITL 7,

a. [Backup Server| A7 v ar R¥ U E 7V 7 LET,

b. [Shares Licenses] = v 7R v 7 A& A4 L IZLET, N—=TFT 4 XU IO I T v
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ETHEESNL =D &4% A E%éhi# —EMMEER SN o= R U
AALTTRLET, =M IUNRELLARNE (%kz‘\%mwm?hVX@NMCTI
VX%E%%%R%%&&L~I/F)i%ﬁéhém IHALTURLET,

NG ART LN 77 AT 04—V, ASA OO NTT7 40y (BT T 4007
E) I, ARPT—TNVDXAFIv 7 ARPZ UMY ZEHL 9,

[Configuration] > [Device Management] > [Advanced] > [ARP] > [ARP Static Table] - > Z IR L
Ex AN

(AFFvayv) 49732 ARPZ M UVICARP X A LT U M ERET HITIE. [ARP
Timeout] 7 4 —/V K IZfEZ AL £9,
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B rSURRFLUF I7LT7I4—LADARP A ZRY S 3V OBRE

& 2

AFvT 4

ATYvSH

ATv76

AFvFS1

AFvT8

ATvS9

ROVEE

D7 4—/VRTIL, ASA S ARP 7 —7 V% B4 3 5 £ COREZ . 60 ~ 4294967 B D
PHCRREL £9, 77 4/L ML 14400 BT, ARP 7— 7 /L2 FIEES 5 L. BHEIICH L\
RANERPEH I, HOARRX MERDPHIBRINET, FAMEFRITHABICERTEIND -
O, AALT T REELSTHIENULBIZRDLIEBERH D 7,

(EE. 84 (5) &) FEEHY 7 v h&MHHT 5121%. [Allow non-connected subnets] 7 = v
IRy 7 AEF NI L ET, ASAARP ¥ v v =2id. B#EERINEY 7T 2y FhbDxT
CRUBPRTFT I LN TEENTOET, ARPF ¥ v a% A 3—7 L T, Bl S
NEYV 7290 b 2E052 b TEET, ¥X2U T4 VRAZZBHL TOARWVWEARIZ. 20
MBEZ A X — T NI THZ LIIHEEL FH A, ZOHEEIZ. ASA I+ 5 —b RS
(DoS) WEDOFTEZ L TCEEL, FEDA LV —T 2 A ADZ—FNKED ARP I %
EELT, A= MY TASAARP 7 —7 MIZRHSNDAREMENRDH D 97,

WOMEEZFE T 2581, ZOMELZHEHTLILEND D ATREENRH Y F97,

o HUHY YT Ry,

o NTT 4w JHAEDOBEEEL— D7 m¥ T ARP,

[Add] 227 VU v 27 LET,

[Add ARP Static Configuration] % 4 7 =7 R v 7 ANRERINET,

[Interface] Fu v 77X URARDEL, RAN Ry MU —JIZERINDA L H—T = A%
WEINL £97,

[IP Address] 7 4 —/LRIZ, RAFDIPTRLZ2Z AL ET,

[MAC Address] 7 4 —/VRIZ, RAFDODMAC 7T RL 2AH2 AN L ET, 72 &20E.
[00e0.1e4e.3d8b] D L HIC AL F1,

ZOT7RUVATTrFY ARP #EITT 51T, [Proxy ARP] F = v VR y 7 A& AT L £7,

ASA X, BESNIZIP T RL AD ARP BXR%E%{ET 5 &, BEINT MAC 7 R L ATIRE
LE7,

[OK]. #\ T [Applyl 27 U v 7 L %7,

[ARP A vV AT arDAF—T ] (P5-12) 2> T, ARP ALV AT v a %A F—
T L FET,

ARP f VAR 3D AR—T Ik

FIEDOEFH
ATy F1

ATFvF2

ZDHETIH, ARPA VAT v a A X —TNWITBHECHOWTHHAL £,

[Configuration] > [Device Management] > [Advanced] > [ARP] > [ARP Inspection] "< > Z SR L
F7,

ARP AV AT a v A X —TNICTHA L Z—T = A A{THBIRL. [Bdit)] 227V v 7L
\i TO

[Edit ARP Inspection] & A 7 2 7R v 7 ANERENET,

Bl CiscoASALYU—ZXASDM a7 4F¥alb—> 3y HAF (—ENGEE)
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AFvT3

ATv74

AFvTH

FSURRFLUL 2747 94—LADOMACFFLR F—I LD HR4<4X A

ARP A >V AR v a v & A Fx—7 /LT 5HI21E, [Enable ARP Inspection] = v 7R v 7 A%
Azl 9,

(A7 ar) —HELRWARP X7y b %77 v K3 5121, [Flood ARP Packets] I = v 7
Ry 7 2%F L FET,

FIANETIE, A2 T 4 v 7 ARPZ U N UDEDOERFICH —FHL 27y h2S, HETO
A EBE =T 2 A AEFRLTRTOA L Z—T A AN 7Ty REaNET, MACTRL &, IP
TRUVA, £E3A 0 —T7 2 A A TR—EDRH DE5GE. ASA TNy bE2RFuy 7 LET,
IDF v IRy I AL T7ICTHE, —BLAWSR Ty MITR_RTCRreyYEnEd, I
Wk, 2457 47 = b VIZHD ARP 21T ASA Z21iBT 5 L9 ICHIRE N7,

~

(3Z)  Management 0/0 £72/L 0/l A F =T 2 A ABLNEIV T AL F =T A 2D D DY
AL INBLDA A =T 2 AR L, ZONRTA—=ENRT Ty RIZEESNTNTH S
Ty 77y RLEYA,

[OK]., #EWT [Applyl 27 U v 7 LET,

RSUARTZLIUMN 2747047 —ILHEOMAC 7 F L
AT—TILDHAREIAX

TITIE.MACTRL A TF—TNEHAZARTHFEICHONTHAL £1,
o [2XZF v 7 MACTRLZADEM| (P5-13)
e 'MACTRVA T—=u70DOF 4—7114 (P5-14)

AAF v MACT KL ADEM

ATvF1
ATFvF2

&2 ]

HWE . MACTRL I, BTEOMACT RLANSLD T T 4w INA B —T A AICAD
72 &I, MACT R L A T—7VZEIMICBMENET, AXT 427 MAC 7 K L AL,

MEZIGUTMACT RV A T—TNMZBINTEET, AT v 7 =2 b U EBINT5H 8
D12, MAC AT —7 4V TIZHATEDZ RV ET, A¥T v 7 =Y ERIT
MAC 7RV AZES I TAT VI N, TORAEZT (v T W JI—FLANA L A —T =
AR T T 4w 7 5BEFELEI ELESA, ASAIZN T 7 sy 7% Ry L, VAT A

A=V EERLET, AXT 47 ARPZ N EZBMTDHEEIZ (I R2AXF ¢ 27 ARP
> h U oM (P5-11) #&R), A¥7T v 27 MACTRLV AT FUXIMAC 7 RL A

T IVICHBEIWIZBMES I ET,

MAC 7 RL R F—TNNZAZT 47 MAC T KL ZREEBMNTAI120%. ROFIEEETL T,

[Configuration] > [Device Setup] > [Bridging] > [MAC Address Table] <1 > & #R L F7°,

(ﬁfya/)MM??FVXIVLUﬁ&%b??%#éi?hbMC?va%—fwm%
DM & E T 5 1Z1%. [Dynamic Entry Timeout] 7 4 —/V R IZfEEZ AL £7°,

ZOfEIE. 5~ 720 % (12 F§[#]) OFEFATRHEL £, 50087 74/ K TT,
[Add] 27 U > 7 L £7,
[Add MAC Address Entry] # A 7 R 7Ry 7 ANFRINET,
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XFwF 4 [Interface Name] Ry 7F&Z 7 U A M, MAC 7 R L RIZEHEEMIT LN TWARET AV
H—T x4 AEERL 7,

Z2FwF 5 [MAC Address] 7 4 —/VRiZ, MACT KL ZZ AL E£7,
AF976 [OK]. #\WT[Applyl 27 U v 7 L %7,

MAC7RLRS—=245DF14t—TILiE

FITHNVETIE, HEAVH =T 2 A RINT 7 4 v 7IZAD MAC 7 R L 2% HEIICHEY
AMAHﬁmﬁéiVFU%NMCTFVX?~7W;EMLE?O%%KﬁUTNMC?%V
A TG TR T 4= NI TEETHE, ZOHEES, MACT RV AET —T7)VICAH
TAYZITBMLRNE, FT77 4w 78 ASA ZHIB TER <0 £9°,

MAC TRV A S—=u 7 %F 48— T 5101, ROFINELXFETL £,

AFvF1 [Configuration] > [Device Setup] > [Bridging] > [MAC Learning] A1 > Z %R L £,

AFvF2 MAC T7—=270%T 48— TDIT0E, A1 F—7 = A A{T%FIRL T, [Disable] % 7
Vo7 LET,

ARFYTF3 MAC T —=VZ2HEARX—T/MIZT5HIZiE, [Enable] 27 Y v 7 L £7,
AFv74 [Applyl 27 U w7 L ET,

F27AT724—IL E—FDH

ZIZTEH. FT T 4y 7N ASA i@l OEFOBERL £,
e L—FT YR I77AT7 T +—/LE—RFRTASA ZHBTHF—%] (P5-14)
o [NTGUART VLU N 77 AT Ud—/VEi@md 557 —4DHE %] (P5-20)

W—TYE T7A4724+—JL E—F TASA %iﬁi@?’év"—@
ZITIENA—T YR T7A4T7 T4 — /L E—RTT—FNASAZLED L) ITEBTL200%
ML £,
o [THNER=Z—W 2 Web — 27 78235 (P5-15)
o Iz —4 723 DMZ E®D Web Y— 27 7 &A% (P5-16)
o [N —H M DMZ LD Web H— 27 72 A3 5| (P5-17)
o A —FRNHBAARNIT 7EAL LS 55 (P5-18)
o IDMZ 2 —HRNEHAAMIT 7EALLS 55 (P5-19)
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77 479+—L =—Fos A
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Source Addr Translatio